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C h a p t e r1

Introduction

WRQ makes PC software that connects personal computer users to enterprise computers and 
information networks. WRQ offers Reflection products for connections to IBM, UNIX, Digital, 
Unisys, and HP host systems. WRQ is also a leader in network security, communications, and 
utilities applications, products for the X Window System, and software management. 

Reflection Product Overview 
Reflection connectivity software products, described next, can establish and maintain communi-
cations to an HP, UNIX, Unisys, or Digital host from a PC running Microsoft Windows 95, 
Windows 98, or Windows NT version 4.0 or higher (Windows NT version 3.51 is supported 
using Reflection version 5.21, included on the Reflection product CD):

· Reflection for HP with NS/VT allows you to communicate with an HP 1000, 3000, 9000, 
or UNIX system. Your PC can emulate an HP 2392A, 700/92, 700/94, 700/96, or 700/98 
terminal. Reflection for HP with NS/VT also provides VT52, VT102, and VT220 emulation.

· Reflection for UNIX and Digital allows you to communicate with a Digital, UNIX, or Unisys 
host. Your PC can emulate the Digital Equipment Corporation VT420, VT320, VT220, 
VT102, VT101, VT100, and VT52 text terminals. It can also emulate ANSI, ADDS, WYSE, 
DG, and Unisys T27 terminals.

· Reflection for ReGIS Graphics allows you to communicate with a Digital, UNIX, or Unisys 
host. Your PC can emulate the same terminals as Reflection for UNIX and Digital, and 
adds the ReGIS (Remote Graphics Instruction Set), Tektronix 4010/4014, and sixel graphics 
features of Digital’s VT340, VT330, VT241, and VT240 graphics terminals. You can use 
either a bus or serial mouse in ReGIS as a locator device. 
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4 Introduction
About This Manual
This manual is designed to aid system administrators whose job is to set up and maintain groups 
of Reflection users in diverse computing environments. You’ll find topics that explain how to: 

· Maintain multi-user license versions of Reflection 

· Ensure security 

· Interpret Reflection’s error messages 

· Use advanced features, such as the Profiler, in Reflection 

Because this manual may be the only on-site reference for these important topics, you should 
keep it in a safe place for quick reference should a problem arise. It is also prudent to keep some 
areas of information undistributed as this information can be used to change the user’s working 
environment—unintentionally or otherwise. 

The Complete Reflection Documentation Set
The complete Reflection documentation set consists of: 

· This System Administrator Guide 

· The Reflection User Guide 

· The Reflection Terminal Reference Manuals

· The Programming with Reflection: Visual Basic User Guide

· The Reflection Method and Properties Reference Manual

The above manuals are available as PDF (Portable Document Format) files on the Reflection 
product CD (explained in the Reflection User Guide). Adobe Acrobat, the application used to 
view and print PDF manuals, is also included on the Reflection product CD, and can be installed 
by running Setup and choosing the Adobe Acrobat Reader option.    
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Conventions
The following conventions are used in this manual: 

· PC refers to an IBM-compatible personal computer. 

· The term “login” is used generically for all host platforms (HP users may be accustomed to 
the term “logon”). 

· This typeface   indicates text you should type, host responses, and samples of 
programming language. 

· Reflection property names are shown using initial capital letters for logical words contained 
within the property name (such as PrinterTimeout ). Case is not important, however, 
when entering these commands on the Reflection command line. 

· When the manual gives an example of entering a Reflection command on the Reflection 
command line, the optional object prefix is omitted, for example:

PrinterTimeout = 3600 

However, if you are using Reflection Basic, enter the command with the addition of 
Application, for example:

Application.PrinterTimeout = 3600 

· Keys are displayed like this: s. Keys that should be pressed simultaneously are shown 
joined by a plus sign, as in a+Ì. Don’t type the plus sign. 

· This is how the Enter key on the main keyboard is shown: n. On some keyboards, it is 
called the Return key. 



6 Introduction
· If you’re using Reflection for HP with NS/VT, some HP block mode applications require 
that you press the Enter key on the numeric keypad; this key is shown as r. 

· Parameters enclosed in angle brackets (< >) indicate that something must be added to 
complete the command, such as a password. 

· The ASCII control character is represented by a caret (^). For example, c+M (carriage 
return) is shown as ^M. 

·
ESC indicates an escape control code, 

CSI  indicates a control sequence introduction 
character, and 

DCS indicates a device control string. The three-letter mnemonic represen-
tation is used in the documentation to make the sequences easier to recognize. Control 
codes are case sensitive and must be typed exactly as shown. 



P

C h a p t e r2

Installing and Upgrading Reflection

The Reflection User Guide provides instructions on how to run the Reflection Setup program. 
However, the online help file Setup.hlp is your most complete resource for using Reflection 
Setup to install Reflection. This chapter provides information on upgrading to this new version 
of Reflection and gives an overview of installation features you can use to install Reflection in a 
multi-user environment.

Upgrading from Earlier Versions of Reflection 
This section describes items you should be aware of if you are upgrading from an earlier version 
of Reflection to version 7.0.

Overwriting an Installed Copy of Reflection
When you are upgrading an installed copy of Reflection, it is strongly recommended that you let 
Setup install the new version of Reflection in the same folder as the existing, older version. Doing 
this ensures that registry values and other PC-specific configuration values are properly set. 

Converting Earlier Version Settings Files
When you start Reflection for the first time after installation, the Reflection Conversion wizard 
asks if you would like to convert your pre-6.0 settings files to work with the 7.0 version of 
Reflection. When you do this, converted files are created and stored in the \User folder, and a 
\Restore folder is created for the purpose of storing the original settings files. This is described in 
detail in the Reflection User Guide. 
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8 Installing and Upgrading Reflection
Installing a Single-User vs. a Multi-User Version of Reflection 
Which installation option you choose during Setup depends on whether you are installing a 
single-user or multi-user version of Reflection:

· Reflection (using single user Setup): Installs a single-user version of Reflection. You can 
also use this option to install a multi-user version of Reflection, although the Deployment 
Manager is a better option in this case. 

· Reflection (using Deployment Manager): Deploys Reflection to multiple users with the 
Deployment Manager, a new utility for system administrators that also offers several 
maintenance and customization options. 

If you use Reflection Setup to install a multi-user version of Reflection see “Other Multi-User 
Installation Options” on page 9 for ways to automate installation. The Deployment Manager, 
described below, performs these tasks automatically.

Deployment Manager
The Deployment Manager organizes and centralizes the various tasks an administrator must 
perform in the course of installing, maintaining, and updating Reflection software. 

Installing Software
When you first run the Deployment Manager, an Installation Wizard helps you install Reflection 
software. Deployment Manager actually runs the Reflection Setup program for you during this 
phase, as many as three separate times. 

Besides placing Reflection software on a server for users, the Deployment Manager installs 
Reflection on the administrator’s local machine. This provides a secure site from which you can 
run utilities such as profilers. Administrators need not always run the Deployment Manager 
from the same “administrative installation.” Since no information necessary for administration 
is stored on the local machine, administrators can carry the Reflection CD with them and create 
an administrative installation at any computer on the network. 

When you run Deployment Manager from a new computer it detects that there is no adminis-
trative installation and then creates one. But it won’t create a new server installation if you specify 
a server directory where one already exists. Modifications you have made to the server instal-
lation (profiles, web pages, shortcuts) are detected by Deployment Manager and can be accessed 
and modified from the new computer.
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Web Page Generation
The Deployment Manager can create web pages that administrators can offer to their users as a 
way of running Reflection products. This option greatly simplifies the administrator’s task in 
maintaining and customizing Reflection software. See the Deployment Manager’s online help, 
Rdeploy.hlp, for more information.

Running Profilers
With the Deployment Manager, profilers (for example, the VT and HP Profiler) are all in one 
place. In the main Deployment Manager dialog box, choose Profilers to open the Profile 
Reflection dialog box. You’ll see none, some, or all of the profilers listed, depending on what 
software you’ve installed on the server. See the Deployment Manager’s online help, Rdeploy.hlp, 
for more information.

Other Features
The Deployment Manager lets you add files to your base installation on the server and create and 
include shortcuts.

Other Multi-User Installation Options
If you use Reflection Setup to install a multi-user version of Reflection, you may want to use the 
following options:

· Automatic Installation—Allows you to record your Setup options on a workstation in a file 
called Silent.inf, and use the Silent.inf configuration when running Setup on other worksta-
tions. See page 10 for more information.

· Microsoft Systems Management Server (SMS) Support—Provides a product-specific 
Package Definition File (PDF) for use with SMS, and includes the automatic installation 
option (Silent.inf) that conforms to unattended installation guidelines. See page 12 for 
more information.
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Automating Installation of Reflection 
Reflection’s Setup program lets you automate the installation of Reflection products from a 
network or a CD (a multiple disk installation is not defined as an unattended installation). This 
is useful, for example, at sites where a system administrator must install Reflection products 
on multiple PCs. You can record and save the choices you make while running Setup, and then 
run Setup again using the same choices on another PC.

Note: Using the /F or /Q switch means you will not see the WRQ End User License Agreement 
(EULA) on screen prior to installation. By opening the CD case and installing the software, you 
are agreeing to its terms and conditions. Be sure to read and keep the printed version of the 
EULA which comes with the software. à

These switches control different ways to automate installation:

To automate the installation of this Reflection product on multiple PCs:

1. In the Windows Run dialog box, start Setup from the CD or network with the /R! switch and 
specify a location for the Silent.inf file. The location should either be a place on the network 
that is accessible from each user’s PC or, if you’re installing Reflection from a CD, a disk.

For example:

<drive>:\Setup.exe /R! W:\Public\Reflection\Setup\Silent.inf

or,

<drive>:\Setup.exe /R! A:\Silent.inf

Switch Description

/R or /R! Use the /R switch during installation to “capture” all responses during Setup to a 
file called Silent.inf. Use /R! to create Silent.inf without installing the product. You 
can also specify a path where you want Silent.inf to be created; if you don’t specify 
a path, Silent.inf will be created in a folder under the product’s Setup folder.

/F Use with all subsequent installations; the information from Silent.inf is used by 
Setup so you’re never prompted.

/Q Use with any installation to make Setup perform a default installation in a 
minimized state without showing the Welcome to Reflection Setup dialog box, 
or use before the /F switch to “point” Setup to the Silent.inf file.
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2. Follow the prompts to install Reflection. Setup creates a file called Silent.inf in the location 
you specified.

3. To install Reflection with the recorded Setup configuration, start Setup from the CD or a 
shared network using the /F switch, followed by the complete path information to Silent.inf. 
If you’re starting Setup from a shared network drive:

<drive>:\Setup.exe /F <path>\Silent.inf

If you’re starting Setup from the CD, use Setup.exe, which is in the \Disk1 folder of the 
product you are installing (do not use Install.exe, which is at the CD root):

<drive>:\<Program files>\Disk1\Setup.exe /F <path>\Silent.inf

Or, use the /Q switch to run Setup in a minimized state using Silent.inf. If you’re starting 
Setup from a shared network drive:

<drive>:\Setup.exe /Q /F <path>\Silent.inf

If you’re starting Setup from the product CD: 

<drive>:\<Program files>\Disk1\Setup.exe /Q /F <path>\Silent.inf

For example, if you copied Silent.inf to a network location called \Public\Refauto on drive G 
and you’re installing Reflection from a CD-ROM on drive D:

D:\<Program files>\Disk1\Setup.exe /F G:\Public\Refauto\Silent.inf

If your shared network drive supports long file names, enclose the path name in quotes. For 
example:

D:\<Program files>\Disk1\Setup.exe /F "H:\Public Location\Ref Auto 

Install\Silent.inf"

4. You won’t be prompted with any dialog boxes using the /F switch. Instead, the information 
from Silent.inf is used. 

When Setup completes, Reflection is installed onto your PC.
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Using Microsoft Systems Management Server with Reflection 
The Reflection Setup program supports Microsoft Systems Management Server (SMS) 
by providing:

· An unattended installation option 

· A product-specific Package Definition File for use on the Microsoft Systems Management 
Server Administrator program

Following are general instructions for installing this Reflection product using SMS; refer to the 
Microsoft Systems Management Server publication for more detailed information:

1. Create source folders for SMS on the network by copying the folders on the 
product CD. 

2. Create and then add the Silent.inf file to the \Disk1 folder that you created in step 1.

3. Start the Systems Management Server Administrator program.

4. In the Package Preparation dialog box, click the Import button to browse to the PDF file 
provided with this Reflection product. The PDF file contains all of the information SMS 
needs to create the package to install this Reflection product, and is unique for each 
Reflection product.

5. Click the Workstations button to open the Setup Package for Workstations dialog box. 
Type the path to the source directory in the Source Directory box.

6. Schedule and run the job.

The procedure for installing a multi-user license version of Reflection is the same as that 
explained in the Reflection User Guide for a single-user version, except that you must use the 
network path for the Setup program when you click Run on the Start menu. For example, enter 
the following command in the Command Line box and then click OK to start Setup from the F 
drive on the network. Note the use of quotes if the path includes spaces (they are required In 
Windows 95 and Windows NT, but not Windows 98): 

"F:\Reflection Disks\Disk1\Setup.exe" 
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Other Installation Topics
Reflection provides Windows NT 3.51 support and the ability to create 3.5-inch installation 
disks.

Windows NT 3.51 Support
Your Reflection product CD includes version 5.21 of Reflection for Windows NT 3.51 environ-
ments. To install this version, put the Reflection product CD in the CD-ROM drive and click 
Run on the Program Manager File menu. In the Command Line text box, type your CD-ROM 
drive letter (for example, D: ) followed by \Nt351\Disk1\Setup . 

Follow the prompts to install Reflection. Because this is an earlier version of Reflection, the 
information in the User Guide does not entirely apply—see the Reflection online help for more 
information.

Creating 3.5-Inch Disks from the Product CD
Version 7.0 of Reflection is available on CD-ROM only. If you need to install Reflection to a PC 
that does not have a CD-ROM drive, use the 3.5" Disk Utility option, available when you run 
Setup from the original product CD (or from installed disk images on a shared network drive), 
or contact WRQ to request 3.5-inch installation disks.
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C h a p t e r3

Setting Up Your Connectivity Environment

Reflection provides you with a variety of methods to connect users to hosts when they start 
Reflection. Each option is suited for a different type of host environment. 

Following are some guidelines for how to take advantage of these options, ranging from the 
simplest to the most complex. 

Using Reflection’s Connection Wizard
The Connection Wizard takes the guesswork out of establishing a session with a host computer. 
The wizard guides users through the process by asking a series of questions. Your users don’t 
need to be computer experts to answer these questions—just a little knowledge of your PC and 
host computer will do. 

To establish a host connection using the Reflection Connection Wizard:

1. On the File menu, click New Session.

2. Select the Connection Wizard option, then click OK.

3. Use this wizard by answering the questions on each of the wizard’s panels, clicking Next 
to advance to the next panel. To go back to an earlier panel to change an answer, click Back. 
To exit the wizard before finishing, click Cancel. For help with any of the Connection 
Wizard’s panels, click the Help button.

Note: You can also start the wizard by clicking the Connection Wizard shortcut in the Wizards 
folder (which is contained in the Reflection folder). à
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Connecting to Any Host Using the Best Network Option
The method presented here requires the least amount of configuration and support. 

If you have any of the following protocols, you can let your users to connect using Reflection’s 
Best Network option without any further configuration on your part: 

· Telnet 

· LAT 

· VT-MGR 

The Best Network option automatically finds the appropriate protocol for the product and host 
you are using. Once users start Reflection they simply press n —Reflection prompts for the 
name of the host before connecting using the best transport. 

Using this method depends on the number of users you must support and how secure your 
environment is. Connecting using the Best Network option requires that each user knows the 
name of the particular host. 

Connecting to a Host Using the Default Settings File
If your users need to connect to only one host, you can create one default settings file 
(Settings.r<n>w) for all users (by default, Reflection will always search for and automatically 
load a settings file using this name). By placing this file on a shared network drive and making it 
read-only, you protect it from inadvertent changes or corruption, and ensure that all users will 
standardize on this file. Doing so also allows you to control the configurations for multiple users 
from one location. See “Maintaining Common Settings Files on the Network” on page 43. 

Note: You can also specify a site default settings file using Reflection Profiler; see page 18 for 
more information. à



 

  Setting Up Your Connectivity Environment 17
Connecting to Multiple Hosts Using Unique Settings Files
If your users need to connect to more than one host (such as an HP 3000 and a UNIX host), 
you should create a unique settings file for each host connection. Further, you can configure a 
shortcut to automatically start Reflection, load a settings file, and connect to a specified host. 
Although this requires more configuration (on both the shared network drive and each user’s 
workstation), it is a practical connection method for multi-host environments. The advantages 
to using this method are: 

· You use the operating system shortcuts to manage access to hosts. 

· Each destination can have completely different settings. 

Following is an example of creating a settings file to connect to a UNIX host using Reflection 
for UNIX and Digital: 

1. Start Reflection and change the necessary parameters for connecting to a UNIX host, 
such as: 

· Select a UNIX preset configuration (on the Protocol tab in the File Transfer Setup 
dialog box). 

· Open a UNIX-specific toolbar settings file.

· Change the VT backspace sends option to Backspace (on the Keyboard tab in the 
Terminal Setup dialog box). 

2. Click Save As on the File menu to open the Save Settings dialog box. 

3. Enter a unique name for the file in the File name box, such as Unixhost.r2w. 

4. Click the Shortcut button to open the Shortcut dialog box.

5. Select the Create a shortcut when saving settings files check box, then specify where the 
shortcut will be located. 

6. Click OK.

7. In the Save Settings dialog box, click Save. 
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Creating a Site Default Settings File to Control Connections
If you administer Reflection in a multi-user environment and you want a standardized set of 
Reflection connectivity functions for your group of users, use Reflection’s site default settings file 
feature. Doing this lets a user group use exactly the same Reflection settings while you administer 
Reflection from a single settings file for easy maintenance, and ensures that each user is restricted 
to the same host, commands, and features. See page 85 for details on site default settings files. 

Attaching a Connect Macro to a Settings File
You can attach a connect macro to a settings file in Reflection. When you start Reflection and load 
the settings, the connect macro automates the process of logging in to a host and starting a host 
application. The advantages to using connect macros are: 

· You can include the user’s login name. 

· You can completely automate the login by including a user’s password. 

· Connect macros don’t have to stop at connecting; you can write a macro that connects and 
launches a particular host application. 

· Connect macros can be tailored to individual users’ needs (for instance, connect one user to 
a financial application and another to a database). 

To link a connect macro to a host connection, use one of these two methods: 

– When you record a login macro, select Make this the connect macro in the Stop 
Recording dialog box.

– In Reflection, click Connection Setup on the Connection menu, and click the Connect 
Macro button. This opens the Connect Macro dialog box. Enter the macro name in the 
Macro name box (or use Browse to select a macro).

For more information on using macros in connections, see the Vbrwin.hlp online help file.
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C h a p t e r 4

Information About Connections

As a system administrator, you probably need to maintain Reflection in a large variety of 
environments. The topics in this chapter: 

· Explain the difference between file services and network protocols 

· Describe how to set up network connections and establish a connection 

· Describe Reflection’s Windows Sockets support 

· Discuss network communications services 

File Services vs. Network Protocols
To establish a network host connection using Reflection it helps to understand the difference 
between file services and network protocols: 

· A file service is what you use to access a network drive. You run a file service protocol (such 
as Ipx.com), and then log into the network and access the server. At this point, you would 
start Reflection. This is only one half of the process in establishing host communications. 

· A network protocol is what you use to communicate with the host. The software to load 
a network protocol (such as TCP/IP) is unrelated to the software you load and use for 
accessing your file service. 
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Network Connection Setup
Before you can use Reflection to connect to a host over a network, the appropriate networking 
software must be installed on your PC. Following is a list of 32-bit networking software products 
you can use with Reflection to make a LAT, Telnet, or NS/VT connection to a host. For a list that 
includes 16-bit networking software products, search for Supported networks in the online help.

LAT For Windows 95 and Windows 98, one of the following:

· WRQ’s LAT protocol for Windows 95, which is provided in:

– Reflection LAT Connection for Windows 95 and Windows NT 
(version 6.2)

– Reflection Network Series 3000 Connection for Windows 95 
(version 6.1)

– Reflection Network Series TCP/NFS Connection for Windows 95 
(version 6.1)

· PATHWORKS 32 for Windows 95 (version 6.0 or higher), SuperLAT for 
Windows 95, or TES32 (version 3.0 or higher)

Note: To connect with LAT under Windows 95 or Windows 98, you will need to 
take some additional steps. See page 24 for more information. à

For Windows NT 4.0, one of the following:

· WRQ’s LAT protocol for Windows NT 4.0, which is provided in:

– Reflection LAT Connection for Windows 95 and Windows NT 
(version 6.2)

– Reflection Network Series LAT Connection for Windows NT 4.0 
(version 6.01)

· PATHWORKS 32 for Windows NT (version 7.0 or higher) or SuperLAT for 
Windows NT
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Establishing a Host Network Connection
To create and save a host connection: 

1. Make sure you are not already connected to a host (click Disconnect on the Connection 
menu, or click New Session on the File menu). 

2. Click Connection Setup on the Connection menu to open the Connection Setup dialog box. 

3. Select Network in the Connect using box, and select how you’ll be connecting from the list 
of network connections.  

TELNET One of the following:

· Microsoft’s TCP/IP software for Windows 95, Windows 98, or Windows NT

· Other Windows Sockets-compatible TCP/IP software

· WRQ’s TCP/IP software for Windows 95, formerly available in:

– Reflection Network Series 3000 Connection for Windows 95 
(version 6.1)

– Reflection Network Series TCP/NFS Connection for Windows 95 
(version 6.1)

Both of these products include TCP/IP software for Windows 95, but not 
for Windows 98 or Windows NT

VT-MGR Reflection for HP with NS/VT or Reflection Suite for HP and one of the following:

· Microsoft’s TCP/IP software for Windows 95, Windows 98, or Windows NT

· Other Windows Sockets-compatible TCP/IP software

· WRQ’s TCP/IP software for Windows 95, formerly available in:

– Reflection Network Series 3000 Connection for Windows 95 
(version 6.1)

– Reflection Network Series TCP/NFS Connection for Windows 95 
(version 6.1)

Both of these products include TCP/IP software for Windows 95, but not 
for Windows 98 or Windows NT
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4. Enter the information needed by the protocol you selected, such as a host name. 

5. Click the Connect button to establish a host connection. 

6. Click Save As on the File menu to open the Save Settings dialog box. 

7. Reflection proposes a settings file name for your saved connection based on the host name 
and connection type you specified in the Connection Setup dialog box. 

If you do not want to accept the proposed name, type another name in the File name box. 

8. From the Save as type list, select Connection (*.rco) to save your connection as a connection 
settings file.

A connection saved as a connection settings file does not contain other Reflection attributes, 
such as file transfer, terminal, keyboard, toolbar, or color settings.   

9. To establish this connection again at a later time, click Open on the File menu, and select 
your connection from the list of connection settings files.

Connecting over LAT
To run Reflection using the Local Area Transport (LAT) protocol, you must install your Ethernet 
hardware and have one of the networking software products described on page 22. 

In addition, if you are running Windows 95 or Windows 98, you must enable the LAT protocol: 

1.  On the Setup menu, click View Settings. 

2. In the Reflection settings list, select Allow Legacy Communications. 

Tip: To quickly select this setting, type legacy  in the Search text box. à

3. Select As Needed in the Setting details text box. 

4. Click OK. 

Note: The above procedure also applies if you want to establish a connection with the BAPI, 
HP-NSVT, HP-Telnet, IBM-ACS, INT-14, U.B., CTERM, NASI, EICON, or NLAT network 
connection types. à

After starting Reflection, select LAT in the Connection Setup dialog box.
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Connecting over Telnet
Windows Sockets Telnet support is included with Reflection using a Windows Sockets-
compatible TCP/IP stack. This lets you: 

· Use your PC as a virtual terminal over your TCP/IP connection. 

· Manage sessions in a way that is seamlessly integrated with Reflection. Reflection gives you 
the flexibility to manage one or more terminal sessions to one or more hosts on the network. 

· Establish an FTP (TCP/IP File Transfer Protocol) session. 

After starting Reflection, select Telnet in the Connection Setup dialog box. 

Connecting over NS/VT
Reflection for HP with NS/VT for Windows 95, Windows 98, and Windows NT is a product 
from WRQ that lets you connect to a host over Network Services/Virtual Terminal (NS/VT) 
using a Windows Sockets-compatible TCP/IP stack. Network Services is a proprietary protocol 
from Hewlett-Packard; NS/VT uses the TCP/IP protocol stack. 

After starting Reflection, select VT-MGR in the Connection Setup dialog box. 

Creating a Connect Macro
Using Reflection’s Macro Recorder, it’s easy to create a login macro that will run each time you 
start Reflection:

1. If you’re already connected, click Disconnect on the Connection menu. 

2. Click Start Recording on the Macro menu. 

A small recording toolbar will appear in the lower right-hand corner of the terminal window. 

3. Establish a host connection (typically you just need to press n). 

4. When prompted by the host, enter your login name and password as you usually do. 

5. Click Stop Recording on the Macro menu, or click the left button on the Recording toolbar.  

The Stop Recording dialog box appears. 

6. Under Macro name, enter a name for the macro, such as Login. 
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7. Select the Make this the connect macro check box.

Tip: Selecting the Create a button check box will create a toolbar button that performs the 
same function. à

8. Click OK. 

9. Click Save on the File menu to save your settings file. 

Making Multiple Connections
Hint: See the online help to make multiple connections in one copy of Reflection (search for 
Multiple sessions, running in one window). à

Reflection lets you establish multiple host connections that function independently. The 
New Session command lets you create a new host session in a new Reflection window while 
maintaining your other active connections in their own windows. 

To make multiple host connections: 

1. Establish your first host connection. 

2. Click New Session on the File menu: 

· This command opens the New Session dialog box. The options shown depend on which 
Reflection products are installed. Select the Reflection product you want to use to start 
the new session, then click OK. 

3. In the new terminal window, establish another host connection. 

Note: Some Unisys hosts require a unique Station ID for each instance of Reflection. à 

New Session starts Reflection in its default state and does not use any settings files. You may need 
to change some settings to connect to a host (for example, Reflection for HP with NS/VT is 
configured for an HP host by default and requires different settings to connect to a UNIX host), 
or click Open on the File menu to load an existing settings file. 

Your active sessions are shown at the bottom of the Window menu (the current session is 
dimmed). You can toggle between active connections by: 

· Clicking the session name on the Window menu 

· Pressing the Windows a+t keystroke 
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Imposing Session Limits
You can specify the maximum number of sessions for Telnet, LAT, and NS/VT using the View 
Settings dialog box.

To set a session limit for one of these connection types:

1. Click View Settings on the Setup menu to open the View Settings dialog box.

2. Select an option for your connection type from the list of Reflection settings:

· Session Limits LAT

· Session Limits NS/VT

· Session Limits Telnet

3. In the Setting details box, specify the maximum number of sessions (the range is 0-255). 

4. Click OK.

Specifying a Hosts File
The TCP/IP Hosts file is a simple list that maps recognizable names to Internet addresses, similar 
to a domain name system. This file controls what names appear when the user opens the Host/
Service Name dialog box. If you have LAT installed, the list also includes names broadcast from 
LAT service multi-casts. 

You can use a TCP/IP Hosts file if there is no Domain Name Server on your network (or even if 
there is). It is also convenient to place frequently used name-to-address mappings in this file. A 
TCP/IP Hosts file can reside on your PC, or on a PC server. 

To specify a hosts file in Reflection: 

1. Click View Settings on the Setup menu to open the View Settings dialog box. 

2. Select Hosts File from the list of  Reflection settings.
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3. In the Setting details box, enter the full path of the TCP/IP hosts file (you can enter up to 
128 characters). 

For example: 

C:\Program Files\Reflection\User\Hosts 

Reflection uses the names (not the aliases) from the file you specify here. If you don’t know 
the path to your Hosts file, click the Browse button to locate it from the Hosts File Browse 
dialog box. 

4. Click OK. 

5. Click Save on the File menu to save the settings file. 

Windows Sockets Support
The Windows Sockets specification describes a set of common APIs (application programming 
interfaces), and was developed to increase the interoperability of TCP/IP applications and 
protocol stacks. This specification defines a standard interface between a Windows application 
and a TCP/IP protocol implementation. Other products that match this specification should also 
work together. 

Use the proper Windows Sockets DLL file (Wsock32.dll) provided by your vendor. Reflection for 
Windows is a Windows Sockets-compatible application. A file named Rntelnx.dll allows access 
to the TCP/IP software for host communications if you have the TCP/IP software provided with 
one of the following products: 

· The Microsoft Windows 95, Windows 98, or Windows NT TCP/IP stack 

· Another Windows Sockets-compatible stack 

· WRQ’s Reflection Network Series version 6.1 for Windows 95 

See page 35 for Windows Sockets troubleshooting information. 
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Connecting to the Host over a TCP/IP Stack
To connect to a host computer over one of the TCP/IP networking software products 
described above: 

1. Start Reflection. 

2. Click Connection Setup on the Connection menu to open the Connection Setup dialog box. 

3. Select Network from the Connect using box. 

4. Select TELNET as the network connection. 

5. Click Connect. 

Network Communications Services
Networks typically provide the following services: print services and communications services. 
Reflection focuses on the communications services aspect of network use. There are three types 
of communications services: virtual terminal services, asynchronous (RS-232) servers, and 
X.25 servers. 

Virtual Terminal Services
Virtual terminals provide a local area network (LAN) connection to the host. There are three 
virtual terminal connections available to a host: 

· NS/VT (HP 3000 only) 

· Telnet 

· LAT 

The host must support the virtual terminal protocol. 

Asynchronous (RS-232) Servers
An asynchronous communications service usually consists of a LAN connection between your 
PC and the communications server, and an RS-232 connection between the communications 
server and the host. 
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X.25 Servers
X.25 servers provide an X.25 connection to the host. 

To connect to an HP 3000, you should have an Intelligent Network Processor (INP). An INP 
is either a communications input/output board used with HP data communications products, 
or a Packet Assembly and Disassembly (PAD), a functional unit that allows Data-Terminal 
Equipment (DTEs) not equipped for packet switching to access a packet-switched network. 
The PAD does not work as well as an INP board. 

Configuring Network Servers
Use the following information to configure your network’s asynchronous communications 
server (terminal server). Page 21 describes the difference between file services and network 
protocols. 

Data communication between a PC and a host over a network requires the following: 

· A hardware interface between the PC and the network 

· A hardware interface between the host and the network 

· Software that lets Reflection communicate with the PC hardware interface 

It is best to configure an asynchronous communications server to do flow control with the host. 
Reflection can maintain flow control with the network and the host, but it is often a good idea to 
have the server do flow control, as well. 

Some servers allow transmit pacing and receive pacing to be configured independently: 

· Flow control from an asynchronous server to the host is transmit pacing—the host sends an 
XOFF to the server when the host is not ready to receive data. 

· Flow control from the host to an asynchronous server is receive pacing—the server sends an 
XOFF to the host when the server is not ready to receive data. 

For a VMS or UNIX host, the server should be configured to do XON/XOFF pacing in both 
directions (receive and transmit). 
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Classic HP 3000
Some asynchronous servers (for example, Ungermann-Bass) support Enq/Ack: 

· Configure the server to do Enq/Ack flow control. 

· You can also configure the server to do XON/XOFF receive pacing (the server sends an 
XOFF to the HP 3000 when the server’s buffer is full), but this is usually not necessary. The 
HP only sends 80 characters at a time, then sends an ENQ, and waits for an ACK.  

· Keep the Enq/Ack check box selected in the Advanced HP Options dialog box (the default). 
Either the network server or the PC must have Enq/Ack pacing for communication with an 
HP 3000—it’s not a problem if they both do. Termtype 10 is assumed. 

If the asynchronous server does not do Enq/Ack: 

· Confirm that the Enq/Ack check box is selected in the Advanced HP Options dialog box 
(the default). This slows communications since each ENQ from the host has to be sent across 
the network to Reflection. 

· Transmit pacing on the server should be set to none. The server should not do XON/XOFF 
transmit pacing (the host sends an XOFF to the server when the host buffer is full): the XON 
character is 

DC1, and this is also the HP 3000 read trigger (host prompt). If the asynchronous 
server interprets the 

DC1 as an XON, it is handled as a flow control character and the server 
does not pass it on to Reflection. 

· If the server does not allow independent configuration of transmit and receive pacing, set its 
pacing to none. 
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MPE/iX HP 3000
MPE/iX hosts do not use Enq/Ack pacing. If the server supports independent configuration of 
transmit and receive pacing: 

· Configure the server to do XON/XOFF receive pacing. 

· Configure the server not to do transmit pacing. 

If the server does not allow independent configuration of transmit and receive pacing, the read 
trigger (host prompt) must be reconfigured in both Reflection and on the host. The read trigger 
is a 

DC1 by default; changing it to DC4  is recommended. Use the following procedure: 

· To reconfigure the host prompt in Reflection, select D4 from the Host prompt list in the 
Advanced HP Options dialog box. 

· To reconfigure the read trigger on the host, run the TRIGGER program on the HP 3000. 
This program is available via the WRQ bulletin board (see page 221 for the telephone 
number). 

X.25 Software with HP 3000s
When signing on to the host over an X.25 network, use; TERM=24. Additional configuration 
items depend on the type of HP 3000 and whether you have HP INP or PADSUP. 

X.25 Software with HP INP
If you are connecting to a Classic HP 3000 using TYMNET/Telnet and have an HP INP with X.25 
software, configure Reflection as follows: 

More Settings—Serial Port dialog box Value 

Receive pacing list Xon/Xoff (default) 

Transmit pacing list Xon/Xoff 
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If you are not using a host prompt, the settings for Inhibit handshake and Inhibit DC2 are 
disregarded, but it is safest to change these values anyway. If you find you are experiencing data 
errors during file transfer, try increasing the Line transmit delay (in the Connection Setup—
More Settings dialog box). If this does not solve the problem, change the value in the Transfer 
link list, on the WRQ tab in the File Transfer Setup dialog box, to 7-Bit. The selection of 7-Bit 
may slow down transfers considerably, but files transfer successfully. 

X.25 Software without HP INP or PADSUP
If you don’t have an HP INP or PADSUP running X.25 software, you must also disable echo at 
the local PAD and use the local echo feature of Reflection. To disable echo at the PAD, consult 
the documentation for your particular network. In Reflection, select the Local echo check box 
on the Keyboard tab in the Terminal Setup dialog box. 

Check to see if
 D C1 (^Q) characters pass from the host computer to the PC. (This is determined 

by host PAD configuration and the terminal type setting of the host port.) If
 D C1 characters are 

being passed to the host, you should be able to produce them in Reflection. 

Advanced HP Options dialog box Value 

Inhibit handshake check box Selected 

Inhibit DC2 check box Selected 

Use host prompt check box Cleared 

Keyboard tab, Terminal Setup dialog box  

Typeahead check box Cleared (default) 
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From the modes keys (selected from the Function key set list on the Function Keys tab in the 
Terminal Setup dialog box), press Ï to turn on display functions, and type carriage returns at the 
host prompt. If a

DC1 exists, the following sequence appears: 
L

F:
DC1CR 

L
F:

DC1CR 

L
F:

DC1 

If you see this sequence, no special configuration changes (other than local echo) must be made; 
use the defaults. 

If
 D C1 characters do not appear, configure Reflection as noted above for X.25 software on your 

network. 

X.25 with MPE/iX and PADSUP/DTC
Newer DTCs for MPE/iX machines include a PADSUP module that includes read trigger 
character support for remote X.25/PAD connections. This allows the DC1 character to be sent to 
the terminal over X.25. Typeahead is also supported in this environment. 

When using this module, fewer Reflection settings need to be changed from their defaults in the 
Connection Setup—More Settings dialog box: 

· Select Xon/Xoff from the Transmit pacing list. 

· If you’re experiencing datacomm errors during file transfer, increase the Line transmit delay. 
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Technical Tips
Try the following tips to improve or troubleshoot your network connections. 

Windows Sockets Error Messages
Following are error messages you may receive when connecting over Windows Sockets 
compliant TCP/IP software; a solution to each is provided. 

Cannot Find Wsock32.dll
When you select the VT-MGR, Telnet, or Best Network connection type, Reflection does the 
following in an attempt to establish a connection: 

1. Reflection loads Rnnsvtx.dll or Rntelnx.dll, depending on the Best Network loading order 
in the Connection Setup dialog box or whether the modules are found. 

2. As Rnnsvtx.dll loads, the Wsock32.dll file provided with Windows 95, Windows 98, or 
Windows NT also loads. Rnnsvtx.dll searches for Wsock32.dll in the following folders: 

· The Reflection folder 

· The Windows folder 

· The Windows \System folder 

If Reflection cannot locate any of the files in the above locations, then the “Cannot find 
Wsock32.dll—Cannot load connection-specific library” error message displays. 

Required Communication Software Not Installed
This message appears if Wsock32.dll or the appropriate Dynamic Link Library (DLL) could not 
be located. In addition to the guidelines in “Cannot Find Wsock32.dll” above, make sure the 
DLL you need is located in your Reflection folder. 
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Unable to Connect to Host
If you receive this message when you’re trying to connect to your host: 

1. Verify that the name and IP address of the host you are trying to connect to is in the Hosts 
file. In the View Settings dialog box, select Hosts File from the Reflection settings list, and 
check to see where Reflection is looking for the Hosts file. 

2. Try connecting using the IP address of the host rather than the host name. 

3. If you cannot connect using the IP address, check your vendor’s documentation on trouble-
shooting your network software. 

Cannot Load Connection Specific Library for Your Connection
This message may indicate that one or more of the following files are not in your path and cannot 
be found by Reflection. 

· Wsock32.dll (must be in the Windows System folder) 

· Msvcrt.dll (must be in the Windows System folder)

· Rntelnx.dll (must be in the Reflection folder) 

· Rnnsvtx.dll (must be in the Reflection folder) 

· Rnlatx.dll (must be in the Reflection folder) 

This message may otherwise indicate that Reflection could not find a 32-bit TCP/IP software on 
your PC, that it is not installed properly, or that you have extra copies of Wsock32.dll that should 
be deleted or renamed. 

Click Network in Windows Control Panel to verify or change your TCP/IP software 
configuration. 

Could Not Resolve Host Name
This message appears when Reflection cannot find the host name you indicated. See the guide-
lines described under “Unable to Connect to Host” above. 



C h a p t e r5

Reflection As an ActiveX Control

New for version 7.0 of Reflection is the ability to use Reflection as an ActiveX control. Reflection 
can now be used inside a web page like any other Active X control, or within an application that 
supports ActiveX controls, such as a Visual Basic application. This enables an application to 
launch Reflection, to send commands to Reflection, and to respond to events that occur in the 
Reflection session.

This chapter provides a complete overview of using Reflection as an ActiveX control. This chapter 
details the tags, methods, and properties used to embed Reflection and invoke its features, and 
shows an example of HTML source code created to control Reflection in a web page.

What Is the Reflection ActiveX Control? 
Reflection 7.0 includes a new file, R<n>axctrl.ocx, (<n> is 1, 2, or 4, depending on what product 
you installed, see the table on page 47). This .ocx file is the Reflection ActiveX control. It’s purpose 
is to pass information between a web browser or a Visual Basic application and Reflection. This 
control calls and passes commands to Reflection from your application, and can also return 
messages to the application indicating an event has occurred in the Reflection session. This 
control also lets you access almost all Reflection methods and properties. 

Defining and Referencing Reflection As an ActiveX Control
To include Reflection in a web page requires HTML source code similar to the source used to 
include any other object in a web page. This HTML source code references the object and 
specifies parameters that should be used when the object is loaded. 

As an example:

<OBJECT ID="R2winCtrl" width="550" height="370" CLASSID="CLSID: 

15B168B2-AD3C-11d1-A8D8-00A0C9200E61">

<PARAM NAME="StartUpSettingsFile" VALUE="hostname.r2w">

<PARAM NAME="StartupMacro" VALUE="login">

<PARAM NAME="ControlID" VALUE="r2session">

</OBJECT>
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<PARAM NAME=”InWebBrowser” VALUE=”True”>

<PARAM NAME=”SilentInstall” VALUE=”True”>

</OBJECT>

The Object  tag is used to specify the ID of the ActiveX control, its placement in the web page, 
and the Class ID of the control. The Object ID (R2winCtrl) is used to reference the 
object elsewhere in the HTML source code. This Class ID is registered during installation of 
Reflection, or when the control is downloaded by a user from a web page (see “Downloading a 
Reflection ActiveX Control” on page 41 for more information).

Three different Class IDs are used, one for each of the three Reflection products:

· Reflection for HP with NS/VT: 
15B168AD-AD3C-11d1-A8D8-00A0C9200E61

· Reflection for UNIX and Digital: 
15B168B2-AD3C-11d1-A8D8-00A0C9200E61

· Reflection for ReGIS Graphics: 
15B168B7-AD3C-11d1-A8D8-00A0C9200E61

The parameters following the Object tag are unique to the Reflection ActiveX control. They 
can be used to specify desired actions when Reflection is started in a web page. Use of these 
parameters is optional, and each parameter has a different function:

Parameter Name Description

StartUpSettingsFile Specifies what settings file to load at startup: if no settings file is 
specified, or the file that is specified doesn’t exist, Reflection starts with 
default values

StartupMacro Specifies the macro in the settings file that should be run when 
Reflection starts

ControlID Specifies a unique session ID for Reflection: if you have more than one 
Reflection session running on a web page, specifying this parameter 
ensures that the position of each session is remembered when users 
return to this page in their browsers

InWebBrowser Specifies whether the control is being used within a browser. The value 
determines if Reflection will display exiting dialogs or no. Values are 
True or False.
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Defining and Referencing Reflection As an ActiveX Control in an Application
Using Visual Basic, the Reflection ActiveX control is available as soon as Reflection is installed. 
To access the control, add the Reflection ActiveX control to your VB toolbox. Dragging the 
Reflection icon from the VB toolbox to your form drops the control right into the application. 
The properties of the control, such as the height and width, and the parameters, such as 
StartUpSettingsFile , is defined in the Properties window of the Visual Basic environment. 

Controlling Reflection Within a Web Page or Application
The HTML example on page 37 shows an excerpt from a web page that contains Reflection. 
There are actually two ways to communicate to Reflection once the control has started the 
session: the distinction between the two forms of communication is important to note. The 
Reflection ActiveX control has its own interface, containing methods that let a user control 
Reflection through the ActiveX control. In contrast, a method exists for a user to bypass the 
Reflection ActiveX control and communicate directly with Reflection. The two methods are 
explained below.

The Reflection ActiveX contains the following methods: 

· RunMacro: Runs a specific Reflection macro (contained in a settings file), for example: 
R2winCtrl.RunMacro "DoTransfer", "Myfile.doc"

The DoTransfer parameter is the name of the macro to be executed. The Myfile.doc  
parameter is the macro data passed into the macro. In the example above, Myfile.doc  is 
the file to be transferred.

· Command: Runs a specific Visual Basic command in Reflection, for example:
R2winCtrl.Command ".WRQSendFile,""Myfile.doc"","", rcBinary, rcDelete"

In the above example, the .Command file is used to pass the Reflection method 
WRQSendFile  to the Reflection session. In this case, Myfile.doc is transferred to 
the host as a binary file.

Silent Install Specifies whether to launch a silent installation of Reflection or to 
launch Setup as the system administrator requests. This can be inter-
active or silent as well, as the system administrator has specified.) 
Values are True or False.

Parameter Name Description
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· SetFocus: Sets focus to the Reflection session, for example:
R2winCtrl.SetFocus

This method brings focus to Reflection’s terminal window from the web page or application.

· GetActiveSession: Returns the instance of  the Reflection session object directly to the 
calling application so that this application can communicate directly to the Reflection 
session. The way to use this method differs when using it from within a browser and using it 
in an application. 

The following example is correct syntax when run inside a browser:
R2winCtrl.GetActiveSession.WRQSendFile "Myfile.doc","",rcBinary, 

rcDelete

The following example is correct syntax for a Visual Basic application: 
Dim Reflection2 As Reflection2.Application

Set Reflection2 = R2winCtrl.GetActiveSession

Reflection2.WRQSendFile "Myfile.doc","",rcBinary,rcDelete

This code sets Reflection2 as the Reflection session object.

Receiving Information from Reflection Through Events
Perhaps as important as passing commands to Reflection, is the ability to respond to events 
that occur in a Reflection session. An application or web page can receive information from 
Reflection by using the event provided in the ActiveX control. 

There are two separate actions required to use this event, one in the Reflection session itself, 
and one in the application or web page:

· In the Reflection session: Define an internal Reflection event, or mapping, which executes 
the Visual Basic command, .RaiseControlEvent.

To define the internal Reflection event, use any of the mapping dialog boxes (Keyboard 
Mapping, Mouse Mapping, Event Setup, etc.), and map an action in Reflection to the 
Visual Basic command .RaiseControlEvent . This command can specify two optional 
parameters, an integer and a string. These two values are passed back to your application or 
web page.

· In the application or web page: Handle the event in your application or web page using the 
event handler,  OnReflectionEvent (integer, string). The (integer, string) is optional.
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As an example:

Map the Reflection Event, When a connection is made to .RaiseControlEvent 0, 

"connected" . Now, in the web page, insert code to perform some action based on 
.RaiseControlEvent , such as:

<VBScript>

Sub R2winctrl_OnReflectionEvent(eventnumber, eventdata)

If  (eventnumber = 0) then

MsgBox "Connection Established", ,"Reflection"

Else 

if(eventnumber =1) then

MsgBox "Disconnected", ,"Reflection"

End if

End if

End Sub

</VBScript>

In this example, when the Reflection session has established a connection, the .RaiseCon-

trolEvent  is sent to your web page. Your web page then displays a message box with the text 
“Connection Established.”

Downloading the Reflection ActiveX Control 
One useful feature of an ActiveX Control is its web-based availability. The Reflection ActiveX 
Control is downloadable from the Web, but it is important to note the distinction that this 
control is not Reflection itself, but a control that calls Reflection. As a result, downloading the 
control by itself would not enable a user to run Reflection if Reflection were not installed. 
However, this control is capable of installing Reflection to any PC that has a web browser.

When creating a web page that will contain Reflection, a system administrator can use optional 
parameters to specify what should happen if the user who loads this web page does not have 
Reflection installed, or does not have the latest version of Reflection. This functionality is also 
available when including the Reflection ActiveX control in a Visual Basic application. 
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All of the parameters shown in the example below are available via the Customized Property 
sheet for the Reflection ActiveX control, in the Visual Basic environment:

<OBJECT ID="R2winCtrl" 

CLASSID="CLSID:15B168B2-AD3C-11d1-A8D8-00A0C9200E61" 

codebase="r2axctrl.ocx" >

<PARAM NAME="InstallerPath"VALUE=" 

\\server\share\Reflection7.0\Setup\R2win32\setup.exe>

<PARAM NAME="InstallType" VALUE=1>

<PARAM NAME="ReflectionVersion" VALUE="7.0.0"> 

</OBJECT>

This HTML source code specifies several parameters. The Object ID (R2winCtrl)  is used to 
reference the object elsewhere in your HTML code. The CLASSID parameter contains the CLSID 
value stored in the registry, which tells the operating system what ActiveX control to load. If 
this CLSID is not found in the registry, then the codebase tag tells the browser where and 
what ActiveX control to download. In the example above, the codebase tag points to the 
r2axctrl.ocx file, which is in the same directory as the web page. 

Tip: You should fully qualify the path to the control. à

The control is now automatically downloaded, installed, and registered. Next, the control 
starts, checking to see if Reflection is installed. If so, the control uses the value specified by the 
ReflectionVersion  parameter to see if an upgrade of the Reflection product is required. 
If the parameter value is higher than the installed version, the product is upgraded. To force 
an upgrade in all cases, specify a value of -1.-1.-1.

The HTML parameter InstallType  can be specified with three different values:

· 0 – Do not install Reflection

· 1 – Local Configuration only

· 2 – Full Installation only

Currently only two of these values are used, but for forward compatability, each has been 
defined. For Version 7.0 values 1 and 2 will always perform the same type of installation. The 
Reflection Setup components that are installed depend on what the system administrator 
installed to the server (see the Setup online help for more information).

The InstallerPath parameter specifies the path to the Reflection Setup program. Once 
Reflection is installed the ActiveX control will launch Reflection in the web page.
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Settings and Other Reflection Files

This chapter explains how to maintain common settings files that are shared by network users 
and ensure the files remain secure (that is, protected from overwriting or accidental erasure). 
It also describes how to create shortcuts that let users start Reflection and automatically load 
settings files.

Maintaining Common Settings Files on the Network
To provide users with a secure Reflection configuration, you should maintain common settings 
files on the network. Doing so allows you to control the configurations for multiple users in one 
location. 

Depending on the site being administered, you can decide to maintain one settings file for the 
entire user group, or maintain multiple settings files that are based on the host connection type. 
Either way, you have a choice between using standard Windows tools to restrict access to one or 
more settings files, or, if only one settings file will be used, configuring the user group for this 
file using options on the Reflection Profiler’s Files tab. For more information on using the 
Profiler to specify a site default settings file, see “Controlling Access to Reflection Features” on 
page 81.

Configuring a Workstation for Reflection
After installing Reflection on a shared network drive, you must run the Setup program (whether 
web- or server-based) for each user from their workstation (see the Reflection User Guide). It 
is recommended that the Reflection User folder be created on the workstation’s local drive. 
However, you can specify that user files, such as macro, script, and settings files, default to a 
shared User folder for all users. Doing this lets you maintain one or more settings files for 
your user group from the same folder on the shared network drive. For additional security, 
you can then designate the common files as read-only. 
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Configuring a Workstation to Share Network-Based Settings Files
The following steps summarize how to point a newly configured workstation to settings files on 
the shared network drive. If you will be specifying a single site default settings file on the network, 
use the Reflection Profiler, as described on page 85.

To configure a workstation for shared settings files on the network: 

1. Start Reflection. 

2. Save whatever settings your users require to a settings file. Make sure the settings file is saved 
to a shared network drive (preferably to a location where users have read-only privileges). 

3. Start Windows from a user’s workstation. 

4. From the Start button, click Run.

5. Type the following command, where <n> is the Reflection product (described in the table 
on page 47) in the Open box, then click OK. 

<network drive>\<Reflection folder>\Setup\R<n>win32\Setup.exe 

If a folder name contains spaces, then you must enclose the above command in quotation 
marks. 

6. Follow the prompts to configure the workstation. 

7. When the Setup program displays the User Folder dialog box, enter the network path where 
the common settings files are located.

8. Complete the Setup program on the user’s workstation. 

9. If users have write privileges in the network directory where settings files are located, 
designate the settings file as read-only. See “Protecting Files from Accidental File Erasure” 
on page 51. 
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Creating Shortcuts to Load Common Settings Files
Once you have created a common settings file, you can create shortcuts that start Reflection and 
load the settings files. The following procedure must be performed on the workstation of each 
user who will be running Reflection with a common settings file. 

To create a Reflection shortcut that loads a settings file:

1. In Windows Explorer, click the Reflection program, such as R2win.exe, that you want to 
create a shortcut to. 

2. On the File menu, click Create Shortcut. 

3. Use the right mouse button to click the new Reflection shortcut, then click Properties. 

4. In the Shortcut Properties dialog box, click the Shortcut tab. 

The Target box shows the path of the Reflection program. If the path includes spaces, it 
must be enclosed in quotes. 

5. Add the path for the settings file in the Target box after the Reflection program path, 
separated by a space. Again, if the path includes spaces, it must be enclosed in quotes. 
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For example, the properties for a Reflection for UNIX and Digital settings file could look 
like this: 

Reflection for UNIX and Digital Shortcut Properties

6. Click OK. 

7. Drag the shortcut onto the desktop or onto the Start button. 

Now when the user clicks the Reflection shortcut, Reflection starts and loads the common 
settings file. 

File Extensions Used by Reflection Products
Complete settings files are product-specific, meaning they belong only to the Reflection product 
that created them. For example, if you open a complete settings file in Reflection for UNIX and 
Digital that was created in Reflection for HP with NS/VT, this will start a session of Reflection for 
HP with NS/VT using those settings (provided you have both products installed). 

Note: Windows Explorer does not display file extensions by default. à
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You identify a complete settings file and the product it belongs to by its file name extension: 

Unlike a complete settings file, a partial settings file does not belong to a specific Reflection 
for Windows product. You can use a partial settings file created in one product to change the 
settings for another Reflection product. For example, a color settings file created in Reflection 
for ReGIS Graphics can be used by Reflection for HP with NS/VT. 

You can identify a partial settings file by its file name extension:

Note: If you’re accustomed to starting Reflection by clicking on a settings file name in Windows 
Explorer, note that Windows Explorer does not display file extensions by default. à

Reflection Product Name File Extension

Reflection for HP with NS/VT .r1w 

Reflection for UNIX and Digital .r2w 

Reflection for ReGIS Graphics .r4w

Reflection FTP Client .rfw

Reflection for IBM .rsf 

Reflection X .rxc

Type of Partial Settings File Extension

Keyboard map .rkm

Mouse map .rkm 

Toolbar .rtb

Colors .rcr 

Menus .rmu

Hotspots .rhs 

Connection .rco 
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Linking Settings Files
Note: This is equivalent to using Connection Directory entries in earlier versions of Reflection. à

Reflection gives you expanded control over partial settings files with an advanced feature that lets 
you link partial settings files to complete settings files. This is useful if you want to: 

· Share a partial settings file, such as a toolbar, among users of a variety of complete settings 
files. This way when you update the toolbar, the changes are automatically distributed to the 
linked complete settings files. 

· Distribute some special settings, such as a customized colors or mouse mappings, to a group 
of users. 

· Keep partial settings files on a shared network drive so that users can link to them from their 
complete settings files stored on their local drives. Again, changes made to the partial 
settings file are automatically updated and distributed via the link. 

Caution:  â If you distribute linked settings files over a shared networked environment, changing file 
locations or names, or deleting files, will disrupt those links. à

As an example, if your users connect to a variety of UNIX hosts, they could use one complete 
settings file that contains the information about their UNIX terminal emulation, file transfer, 
and keyboard mapping settings. Then, to connect to the various UNIX hosts, they could simply 
open connection partial settings files representing each of those host connections. 

Showing the Link to file Check Box
Since linking is an option typically reserved for advanced users, the Link to file check box is 
hidden for convenience. To show this option, in the View Settings dialog box, select the setting 
Show Link to File Check Box and change the value in the Setting details box to Yes. Now, 
when you use the Open Settings dialog box to load a partial settings file, you’ll see the Link to 
file check box. 

To link a partial settings file to a complete settings file: 

1. On the File menu, click Open. 

2. In the Open Settings dialog box, click a complete settings file, then click Open. All of 
Reflection’s settings are now governed by that complete settings file.

3. Now, click Open on the File menu again. 
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4. In the Open Settings dialog box, use the Files of type list to select the type of partial settings 
file you want to use, then click the name of the partial settings file.

5. Select the Link to file check box. 

6. Click Open. 

The partial settings file you selected is now linked to the complete settings file currently loaded. 
This link is only temporary; save your complete settings file to make the link permanent. 

Breaking a Link Between Settings Files
If you want to unlink a partial settings file from a complete settings file, you can open the partial 
settings file and clear the Link to file check box: this will break the link between the files. Or, 
you can make a change to the partial settings file.

When you make a change to a partial settings file, Reflection asks if this change also means 
you want to remove the linked relation between the files. The following example shows how a 
change can unlink a color partial settings file from a complete settings file: 

1. Load the complete settings file: the linked color partial settings file automatically opens. 

2. On the Setup menu, click Display, then click the Colors tab. 

3. Make a change to the color settings, then click OK. 

Reflection displays a dialog box similar to this: 

4. Click Remove link to <file name>, then click OK. 
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Storing Reflection Settings Files Locally
You may want to store Reflection settings files on a user’s local drive (a “local” drive might be a 
network user folder) to prevent one user from accidentally using or over-writing a settings 
file that belongs to another. Then when the user clicks the Reflection shortcut on the desktop, 
Reflection loads the local settings file. 

You can do this from Windows or from Reflection: 

Follow these steps from Windows Explorer: 

1. Click the Reflection shortcut. 

2. Use the right mouse button to click the Reflection program or shortcut, then click 
Properties. 

3. In the Shortcut Properties dialog box, click the Shortcut tab. The Target box shows the path 
for the Reflection program. 

4. Add the local path for the settings file in the Target box after the Reflection path, separated 
by a space.

Follow these steps from Reflection: 

1. On the File menu, click Save As to open the Save Settings dialog box. 

2. Explicitly select the local drive. 

3. Click the Shortcut button.

4. Select the Create a shortcut when saving settings file check box, and choose a shortcut 
option in the Place the shortcut box.

5. Click OK (twice).
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Protecting Files from Accidental File Erasure
It is recommended that you either set the read-only attribute on all Reflection’s program files, or 
assign users read-only privileges for the server drive where Reflection is installed. This prevents 
accidental erasure or overwriting of program files. 

To specify files as read-only in Windows:

1. Start Windows Explorer and highlight the files you want to set the read-only attribute on. 

2. Use the right mouse button to click the files, then click Properties. 

3. On the General tab, select the Read-only check box. 

4. Click OK. 

Settings Conversion Wizard Advanced Options
The Reflection Settings Conversion Wizard allows you to convert your pre-6.0 settings files 
to the new format. Using the wizard is explained in the Reflection User Guide; selecting the 
default option (Let the wizard decide) is recommended for most users. 

You need to use the advanced wizard conversion options if any of the following apply: 

· You store settings files in a location other than the Reflection folder, the User folder, or if 
your settings files have a non-default file extension. 

By default, the wizard only converts those settings files found in the original Reflection 
folder or the User folder. (The default path for 16-bit versions of Reflection is C:\RWIN.) In 
addition, it only converts settings files with the .r<n>w file extension. (For an explanation 
of the <n> value, see page 47.) 

· You have saved connections not linked to settings files, and you want them converted 
to complete settings files (by default, the wizard will convert these into connection 
settings files). 
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· You want to convert unmodified settings installed by earlier versions of Reflection. 

By default, the wizard does not convert unmodified settings.* This includes both settings 
files (such as Vms.r2w and Unix.r2w) and supplied connection settings icons (such as HP 
3000 Host) from earlier versions. 

· You want to convert existing color schemes into color partial settings files.

· The wizard did not provide the results that you expected in a converted setting. 

To start the wizard again and specify advanced wizard options: 

1. Restore the converted settings as explained on page 55. 

2. When the restoration completes, click Restart.

3. For the Conversion Method, select the Let me make the decisions option. Then click Next. 

4. In the next dialog box, tell the wizard what types of files you want to convert.

If you don’t want to convert a particular group of settings, clear the associated check box—
doing so causes some of the wizard dialog boxes later in this procedure not to appear. 

5. If you told the wizard to convert old settings files in the previous step and it finds old 
settings files, you’ll see an Old Settings File Locations dialog box. If you have settings files 
in locations other than that detected by the Wizard, click Add, then click Browse to find 
the location. 

To remove a detected settings file location, click the path name, then click Remove. 

Click Next to continue the conversion process. 

* This is controlled by a file called Convert.inf. If this file is missing from the Reflection folder, then all settings 
(unmodified or otherwise) are converted. 
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6. If the wizard does not detect any old settings files, you’ll see the Could Not Find Any Settings 
Files dialog box.

The wizard detects old settings file locations by looking for earlier versions of Reflection, or 
reading the path information from a file called Wrq.ini in the Windows folder. If earlier 
versions of Reflection are not detected, or the Wrq.ini file is missing, the wizard cannot 
detect earlier settings. 

Note: Reflection versions prior to 5.0 did not use Wrq.ini, so if you install version 7.0 into a 
new directory, the wizard may not find pre-5.0 settings. à

7. Now the wizard needs to know which settings files it should convert in the locations 
specified in step 5. All settings files shown will be converted. If you do not want to convert 
a specific file, select it and click the Do Not Convert button. If you change your mind, you 
must click Back to go back to the Location dialog box, and then click Next to have the 
wizard find all the settings files again. 

Click Next to continue the conversion process. 

8. If you told the wizard to convert old saved connections or templates (by selecting the corre-
sponding check box in step 7), you’ll see the Select Saved Connections and Templates for 
Conversion dialog box.

If you do not want to convert a specific saved connection, select it and click the Do Not 
Convert button. If you change your mind, you must click Back and then click Next to have 
the wizard find all the saved connections again. 

Click Next to continue the conversion process. 
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9. If the wizard detects that you have saved connections that are not linked to settings files, 
you’ll see the Connection Found with No Link to Settings File dialog box.

Version 7.0 of Reflection requires that your saved connections be converted to either a 
complete or partial settings file. By default, the wizard creates a connection partial settings 
file. If you want to create a complete settings file, or perform no conversion at all, make the 
appropriate selection here. 

If you have multiple, unlinked, saved connections, and want them all converted using the 
same selection you make here, clear the Ask me this question for every unlinked saved 
connection check box. Click Next to continue the conversion process. 

10. If you chose the option Create a full settings file in the previous step you’ll see the Create a 
Complete Settings File from a Saved Connection dialog box.

Since you are about to create a complete settings file for this connection, the wizard needs to 
know where to get the non-connection information. You have two choices: 

· You can specify a specific settings file (click the Browse button if necessary). 

· You can use Reflection’s default factory values for all items that are not connection-
related. 

After making your selection, click Next to continue the conversion process. 

11. The wizard suggests that it copy the converted settings files to the 7.0 User folder. 

New settings files replace old settings files with the same names. However, backup copies of 
the old files are automatically created and can later be restored (see page 55). 

If your earlier settings files were in a folder other than the 7.0 User folder, you can have the 
wizard place the converted files in their original location. You would want to do this, for 
example, if you already had desktop shortcuts configured to this location. Backup copies of 
the original files will be copied to the Restore folder.

Click Next after selecting where your converted settings will be saved. 
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12. In the next dialog box, click Finish to start the conversion. 

13. When the conversion completes successfully, click OK to exit the wizard and return to 
Reflection. 

14. To access converted settings: 

· To open converted settings files, use the Open command on the File menu as you 
normally would. 

· To access connection information that used to be in the Connection Directory, Phone 
Directory, or a connection template, use the Open command on the File menu and 
change Files of type to Connection (*.rco).

· To access color information, change Files of type to Colors.

Restoring Converted Settings
Before the wizard converts earlier settings files, it copies only the files it is replacing into a folder 
beneath the User folder called Restore (if you don’t have a User folder, the Restore folder is 
created beneath the Reflection folder). Each file placed in this Restore folder is renamed with the 
prefix “Old_.”

For example, the contents of \Program Files\Reflection\User\Restore might look like this: 

Old_Favorite Settings.r2w 

Old_Compuserve Account.r2w 

Old_Unix Connection.r2w 

To restore converted settings, you must first restore the Script menu: 

1. On the Setup menu, click Menu to open the Menu Setup dialog box.

2. Click Macro under Defined menu to select this item.

3. In the Available options box, open Additional items, open Items from Version 6.x, then 
select Script.

4. Click Add After. This adds the Script menu to the right of the Macro menu.

5. Click OK to close the dialog box. 

If you want to save this change, on the File menu, click Save.
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Now, to restore the converted settings, start the wizard again:

1. On the Script menu, click Run Script. 

2. Locate the script file Convert.rbs in the Reflection folder, then click Run; the Settings 
Conversion Wizard starts.

3. Click Next on the wizard opening screen to see the Restore Old Settings dialog box.

This dialog box will always appear when the wizard detects the log file Conv<n>log.txt 
described below. 

To restore the earlier settings, click Finish. 

4. After the earlier settings are restored, you’ll see the Restoration Complete message box.

Click Exit to return to Reflection—if you want to try the conversion again, you’ll need to run 
the wizard at another time. 

If you want to rerun the wizard and try the conversion again (using the advanced conversion 
options), click Restart. 

Conversion Log
The wizard records all of its conversion information to a log file (for example, Conv2log.txt). The 
log file is located with the original (old) settings in the \User\Restore folder, and contains infor-
mation such as the time and date of the conversion, and all files that were copied, created, or 
deleted during the conversion. 

If the wizard fails in any way, it also records the problem information to the log for trouble-
shooting purposes. If you have trouble with converted settings, open the log in a text editor and 
see if the problem is documented there. 
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Customizing the Menu Bar

Reflection allows you to customize its menu bar; you can add your own menus and menu 
commands or edit existing Reflection menus. Use the Menu Setup dialog box for:

· Adding your own custom menus to the menu bar, including support for keyboard access 
key assignment, menu command separators, and status line help text.

· Adding commands to a menu.

· Changing the properties of menus and menu commands, for example, the menu or 
command name, status line help text, or action associated with a menu command.

· Rearranging menus on the menu bar, or rearranging the commands that appear on the 
menus. 

· Deleting selected menus from the menu bar or menu commands from a menu.

After configuring the menu bar, you can save your changes to a partial settings file that contains 
only the menu bar configuration. Other users can load this partial settings file and use the same 
customized menu bar when working in Reflection.

To show or hide the Reflection menu bar:

1. Click the Reflection icon in the upper-left corner of the title bar on the Reflection window.

2. Click Show Menu Bar to display the menu bar, or click Hide Menu Bar to toggle the menu 
bar out of view.
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Opening the Menu Setup Dialog Box
To change the Reflection menus:

· Click Menu on the Setup menu to open the Menu Setup dialog box.

To clarify the terminology for menu setup:

· A user-defined item is a command on a Reflection menu that you define.

· A user-defined popup is a drop-down menu that contains one or more commands.

The Defined menu area on the left side of the Menu Setup dialog box represents your current 
menu bar configuration. You can customize either the Reflection terminal window menu bar 
or the items appearing on the pop-up context menu that opens when you right-click on the 
terminal window—make your selection from the Defined menu list.

On the right side of the dialog box, the Available options are a list of default menu items 
available as predefined items for customizing the menu. These items allow you to:

· Create your own menu

· Reposition menus

· Add a separator to divide commands on a menu

· Change the keyboard shortcut associated with a menu or a menu command

· Change the status line text that appears when a menu or menu command is highlighted

· Remove menus
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Adding a New Menu to the Menu Bar
You can add your own menu to Reflection’s menu bar. There are two ways you can configure a 
menu to behave:

· Configure a menu with multiple commands so that when you click it, it drops down. Then, 
to this menu, you can add commands to provide access to any combination of Reflection 
commands or terminal keys, as an example.

· Configure the menu with only one command so that when you click it, it automatically 
performs an action. For example, create a menu called “View Help.” Click once on the menu 
to start help.

Adding a New Menu Containing Two or More Commands to the Menu Bar
If there is more than one command that you want to associate with a menu, you should create a 
drop-down menu. A drop-down menu contains menu commands arranged in a column. For an 
example of a typical drop-down menu, click any command on your default Reflection menu bar 
in the terminal window. 

To create a user-defined menu that will contain one or more commands:

1. In the Defined menu list in the Menu Setup dialog box, decide where you want to position 
the menu on the current menu bar and highlight a menu name. For example, if you want the 
new menu to appear before or after the File menu, select File in the Defined menu list.

2. In the Available options list, select User defined popup.

3. Click Add After or Add Before, depending on the relation of the new menu to the menu 
selected. Using the same example as in step 1, click Add Before if you want the new menu to 
appear before the File menu. This means your custom menu will appear to the left of the File 
menu on the actual menu bar.
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4. In the Menu Popup Properties dialog box, enter a name for the menu up to 30 characters 
long in the Name box.

5. Enter the status line help text, up to 150 characters, in the Description box. (If you leave this 
item blank, Reflection uses the descriptive name for the status line text.)

6. Click OK.

Now that you’ve added the new drop-down menu, you need to populate it with commands. To 
add commands to a menu:

1. In the Defined menu list, highlight the new menu you just added.

2. In the Available options list, select User defined item.

3. Click Add After. This opens the Menu Item Properties dialog box.

4. Enter a name for the menu command, up to 30 characters, in the Name box.

5. Enter the status line help text, up to 150 characters, in the Description box. (If you leave this 
item blank, Reflection uses the descriptive name for the status line text.)

6. Associate the menu command with an action by selecting one of the following: 

· Send text to transmit text to the host. Use the Insert a special character list or the 
Insert special characters using the keyboard check box to enter the characters you 
want to transmit.

· Macro to run a Visual Basic macro or Reflection Basic script. The dialog box will change 
according to what you select from the Type list. Provide either a Macro name (Visual 
Basic) or Script file name (Reflection Basic). 

· Commands to perform a terminal command (such as transmitting a host keystroke) 
or menu command (such as toggling the state of the k key), or to execute a Visual 
Basic command. If you chose Terminal Command or Menu Command, use the 
Categories and Commands boxes to complete your selection.
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7. Click OK to close the Menu Item Properties dialog box. You’ll see the new command in the 
Defined menu area under the new menu.

8. You can continue to add new commands to this menu by repeating steps 3 through 7. The 
only variation is where you want to place the new commands on the menu; highlight the 
appropriate location and use Add After or Add Before.

9. As an option, you can add separators to divide menu commands visually by function and 
define keyboard access keys.

10. Click OK to update the menu bar with your changes.

Adding a New Menu Containing One Command to the Menu Bar
If you want the menu command to open when you click it (this is analogous to creating a toolbar 
button; the menu does not drop down like typical Windows menus), then follow this procedure:

1. In the Defined menu list, decide where you want to position the menu command on the 
current menu bar and highlight a menu name. For example, if you want the new menu 
command to appear before or after the File menu, select File in the Defined menu list.

Caution: â Do not double-click a menu name to highlight it, since this causes the menu to expand and 
display its commands. If you do so, the remaining steps in this procedure will add the new 
command to the highlighted menu that you expanded (instead of adding the command directly 
to the menu bar). à

2. In the Available options list, select User defined item.

3. Click Add After or Add Before, depending on the relation of the new menu to the menu 
selected. Using the same example as in step 1, click Add Before if you want the new menu to 
appear before the File menu. This means your custom menu command will appear to the 
left of the File menu on the actual menu bar.
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4. In the Menu Item Properties dialog box, enter a name for the menu command, up to 30 
characters, in the Name box. If you want to add a keyboard shortcut key (accelerator), type 
an ampersand (&) before the character that will activate the command.

5. Enter the status line help text, up to 150 characters, in the Description box. (If you leave this 
item blank, Reflection uses the descriptive name for the status line text.) To prevent display 
of status line help, press the spacebar once.

6. Associate the menu command with an action by selecting one of the following: 

· Send text to transmit text to the host. Use the Insert a special character list or the 
Insert special characters using the keyboard check box to enter the characters you 
want to transmit.

· Macro to run a Visual Basic macro or Reflection Basic script. The dialog box will change 
according to what you select from the Type list. Provide either a Macro name (Visual 
Basic) or Script file name (Reflection Basic). 

· Commands to perform a terminal command (such as transmitting a host keystroke) 
or menu command (such as toggling the state of the k key), or to execute a Visual 
Basic command. If you chose Terminal Command or Menu Command, use the 
Categories and Commands boxes to complete your selection.

7. Click OK. You’ll see the new command in the Defined menu area.

8. Click OK to update the menu bar with your changes.

Adding a New Item to the Terminal Window Shortcut Menu
When you right-click on the terminal window, this displays the shortcut menu. To add an item 
to this shortcut menu:

1. In the Menu Setup dialog box, select Terminal window context menu from the Defined 
menu list. The left side of the dialog box changes to show the commands available on the 
current menu.

2. Decide where you want the item to appear and highlight a shortcut menu name.
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3. In the Available options list, select User defined item.

Note: If you want to create a cascading menu on the context menu that contains its own 
subset of commands, select User defined popup instead. The steps are the same for creating 
new menus and then adding commands to them. à

4. Click Add After. This opens the Menu Item Properties dialog box.

5. Enter a name for the menu command, up to 30 characters, in the Name box. If you want to 
add a keyboard shortcut key (accelerator), type an ampersand (&) before the character that 
will activate the command.

6. Enter the status line help text, up to 150 characters, in the Description box. (If you leave this 
item blank, Reflection uses the descriptive name for the status line text.) To prevent display 
of status line help, press the spacebar once.

7. Associate the menu command with an action by selecting one of the following: 

· Send text to transmit text to the host. Use the Insert a special character list or the 
Insert special characters using the keyboard check box to enter the characters you 
want to transmit.

· Macro to run a Visual Basic macro or Reflection Basic script. The dialog box will 
change according to what you select from the Type list. Provide either a Macro name 
(Visual Basic) or Script file name (Reflection Basic). 

· Commands to perform a terminal command (such as transmitting a host keystroke) 
or menu command (such as toggling the state of the k key), or to execute a Visual 
Basic command. If you chose Terminal Command or Menu Command, use the 
Categories and Commands boxes to complete your selection.

8. Click OK. You’ll see the new item in the Defined menu area.

9. Click OK to update the shortcut menu with your changes.
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Changing Menu Popup or Item Properties
You can access the properties of each defined menu and change its unique characteristics, 
including the menu title and description (status line help text).

To edit menu popup or command properties:

1. In the Defined menu list of the Menu Setup dialog box, navigate to the location of the menu 
you want to edit, then select it.

2. Click the Properties button.

3. Change the menu name and description.

4. Click OK to save your changes and close the Menu Popup or Menu Item Properties 
dialog box.

5. Click OK to update the menu bar with your changes.

Adding Separators to a Menu
Whenever a menu contains a set of related menu commands, you can divide those sets with a line 
called a separator that spans the width of the menu. Separators are not allowed as the first or the 
last item in a menu, and you cannot have two separators in a row.

To add a separator to a menu:

1. In the Defined menu area of the Menu Setup dialog box, double-click on the name of the 
menu containing the command you wish to add a separator to. Then, click once on the 
command name to select it.

2. In the Available options area, select Separator. 

3. Click Add After or Add Before, depending on where you want to insert the separator.

4. Click OK to update the menu bar with your changes.

Although separators appear in the Defined menu area like menu commands, there are no 
properties associated with a separator.
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Defining a Keyboard Access Key for a Menu or Menu Item
When creating a custom menu, you should also assign a keyboard access key to the menu title or 
menu command title. All default menus and menu commands provide a keyboard access key; 
some also provide shortcut keys (also referred to as accelerator keys). 

To access the menu or menu command with the keyboard access key, press a + key on the 
keyboard, where key is the underlined character.

You can change the keyboard access key for a defined menu or menu command by editing its 
properties, or assign one when you add either the User defined popup or the User defined item 
option to a menu.

To define a keyboard access key:

1. Open the Menu Item Properties or Menu Popup Properties dialog box. 

2. Define a title for the menu or menu command if you haven’t done so.

3. In the Name box, type an ampersand (&) before the character in the title you’ve designated 
as the keyboard access key.

4. Click OK to save your changes and close the Menu Item Properties or Menu Popup 
Properties dialog box.

5. Click OK to update the menu bar with your changes.

Rearranging the Menu Bar
One of the ways you can configure your Reflection menu bar is to rearrange menus on the menu 
bar or menu commands that appear on menus: 

1. Move items in the Menu Setup dialog box to achieve your custom design:

· To move an entire menu (including its associated menu commands), select it in the 
Defined menu list, then click the Up or Down button. 

· To move a menu command, expand the associated menu tree by clicking the plus sign, 
select the menu command, then click the Up or Down button. 

2. Every time you click the Up or Down button, the menu or menu command will move up or 
down by one in the tree.
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Deleting a Menu or Menu Command Item
One of the benefits of running and maintaining a multi-user version of Reflection on a server 
is the ability to control and manage the configuration of Reflection for multiple users with the 
Profiler. Profiled versions of Reflection may disable certain features by making menus or menu 
commands inactive.

If you frequently profile Reflection, you may also want to remove inaccessible menus from the 
menu bar or delete disabled menu commands from menus. Even if you don’t use a profiled 
version of Reflection, you can remove menus and menu commands as needed for a more stream-
lined menu bar, leaving only those commands that you frequently use.

To delete a menu or menu command:

1. In the Defined menu list of the Menu Setup dialog box, select the menu or menu command 
that you want to remove. To expand a menu tree to display the associated menu commands, 
click the adjacent plus sign. When a tree is expanded, the plus sign changes to a minus sign. 
To collapse the tree, click the minus sign.

Caution: â If you delete a user-defined menu, you cannot restore it. You can only restore the default menus 
and menu commands. Also, keep in mind that if you change the properties of a default menu or 
menu command it automatically becomes a user-defined popup or command, respectively. à

2. Click Remove to delete the command from the Defined menu list.

3. Click OK to update the menu bar with your changes.

You can restore a single default menu or menu command if it is not a user-defined popup or 
command by selecting it from the Available options list on the right side of the dialog box and 
clicking the Add After or Add Before buttons. To restore the menu bar to the factory-installed 
configuration, click Defaults.
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Restoring Version 6.x or 5.x Menu Items 
If you want to restore menus and menu commands that have been removed from version 7.0 of 
Reflection, you can use the Additional items options in the Available options list. When you 
expand the Additional items option, you will find:

· Items from version 6.x: Includes the Script menu and its commands, replaced by the Macro 
menu in version 7.0 of Reflection.

· Items from version 5.x: Includes the Connection menu, including the Connection 
Directory and the Phone Directory commands, as well as the DDE menu and its associated 
commands.

Use the example shown next to restore a Reflection earlier version menu to the menu bar. 

Example: Restoring the Script Menu
This example restores the Script menu to a position directly to the right of the Macro menu:

1. On the Setup menu, click Menu to open the Menu Setup dialog box.

2. Click Macro under Defined menu to select this item.

3. In the Available options box, open Additional items, open Items from version 6.x, then 
select Script.

4. Click Add After. This adds the Script menu to the right of the Macro menu.

5. Click OK to close the dialog box. 

6. On the File menu, click Save to save this change.
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Guidelines for Adding and Editing Menus and Menu Items
· Design your menu carefully. By default, Reflection provides a menu bar that meets 

Windows standards for ease of use and compatibility with other Windows applications. 
When designing a custom menu for other users, keep these concepts in mind when creating 
a custom menu, changing default menus, and rearranging commands on the menu bar. Use 
Reflection and other Windows applications as examples.

· Manage the number of menus you add to the menu bar. The maximum number of menus 
you can add to the menu bar is 32. To a menu, you can add up to 32 menu commands. The 
Reflection menu bar supports a combination of up to 256 menus and menu commands.

· Test your menu before distributing it as a menu map-only settings file to other users. Ensure 
you can execute the commands on the menu.

· Add separators to drop-down menus where appropriate. Separators visually group similar 
menu commands for users.

· Define a keyboard shortcut key for menus and associated command so you can use the 
keyboard as well as the mouse to access a drop-down menu or execute a command, terminal 
key, or script associated with a menu command.
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Configuring a Generic Printer for All Users

The printer you select in Reflection’s Print Setup dialog box is saved with other values when 
you save your settings file. Changing printers in the Print Setup dialog box has no effect on the 
default printer used by other Windows applications. 

You can, however, force Reflection to always use the default printer specified under Windows:

1. Click View Settings on the Setup menu.

2. Highlight Default Printer from the Reflection settings list.

Your default printer displays in the Setting details box.

3. Delete (clear) the printer listed in the Setting details box.

4. Click OK to exit the View Settings dialog box.

5. Click Save on the File menu to save this change to your settings file. 

The Reflection Default Printer setting is useful, for example, if you’re creating one generic 
settings file to distribute to many users, each of whom probably has a unique default printer 
assigned to his or her Windows environment. 

The following caution has to be taken into account when you use this setting. The setting will 
be changed from a null string to a specific printer when the following events occur: 

1. The user clicks Print Setup on the File menu. 

The Print Setup dialog box opens, with the Windows default printer highlighted. 

2. The user clicks OK. 

Now, the value of the Default Printer setting will be the name of the printer that was 
highlighted when the user clicked OK in the Print Setup dialog box. 

If you want to ensure that the settings file you give your users has a null string for the printer, 
configure the Default Printer setting before you distribute the settings file. Alternatively, you 
can map a Reflection event or record a macro that uses the DefaultPrinter property. 
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Creating Custom Help

A customized Windows help file can be added to Reflection’s Help menu to supplement 
the standard help that is included with the product. For system administrators or help desk 
personnel, customized help is a convenient way to present site-specific information and guidance 
to users: the login procedure for different systems, host names, who to call for help, and 
so on. All you need to do is write and compile a Windows help file. 

Creating Online Help
The compiler you need to create a Microsoft Windows help file is part of the Windows 
Software Developers Kit (SDK), Microsoft Visual Basic, and a number of other commercially 
available products. 

Once you’ve written your help document, you need to test the file before you incorporate it into 
Reflection. To do this: 

1. Click Run on the Start menu.

2. In the Open box, locate the name of your custom help file, then click OK. 

See how the help you created looks. Do the jumps to other topics work? Is the formatting correct? 
Does the Index tab contain a complete list of items you want your users to be able to find? 
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Creating a Command on Reflection’s Help Menu
Once you are satisfied with the help file, you need to incorporate it into Reflection’s Help menu:

1. Click View Settings on the Setup menu to open the View Settings dialog box.

2. Select Custom Help File from the Reflection settings list. 

3. In the Setting details box, enter the full path of the Windows help file you created. Do not 
include quotes around the path name.

4. Select Custom Help Menu Name from the Reflection settings list.

5. In the Setting details box, enter the menu command for the help file as you want it to 
appear on the Help menu.

6. Click OK to close the View Settings dialog box.

7. Restart Reflection for the changes to take effect in the Windows registry.

The Context String for Your Contents Page
When you click the Custom Help command, the topic that appears in the Help window depends 
on what you have defined for the Contents option in the [OPTIONS] section of your help file’s 
project (.hpj) file. For example: 

[OPTIONS] 

CONTENTS=_MAIN_HELP_INDEX_HELPDESK 

Note: When you click Contents on the Help menu, you may not see the Contents tab of the Help 
Topics dialog box, because Windows always displays the last tab you used. à
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Adding Custom Help Using Menu Map
You can use the menu mapping feature in Reflection to add your own menu command that calls 
a unique help file. However, if you do add your own menu for custom help and then for some 
reason another user adds a menu for it, too, from the View Settings dialog box, the user’s custom 
help file takes precedence. This is because the View Settings method records the information to 
the Windows registry, where the Menu Map method stores the information in a Reflection 
settings file. Registry settings take precedence over a Reflection settings file.

Note: If you already have a custom help file defined in the registry and you create a new menu 
item mapped to the built-in function HelpCustom, you cannot change the menu item’s name 
in the Menu Setup dialog box (it is dimmed in the Menu Item Properties dialog box). You can, 
however, change the name in the View Settings dialog box or by editing the registry. à
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Security Options with Reflection

This chapter provides an overview of security features that are either available with Reflection 
or that become available when Reflection is used with Reflection Signature, a security product 
from WRQ. 

For more information about Reflection Signature, contact WRQ (see page iii).

Reflection Security Features
The security features described below are available with Reflection, no other WRQ product 
is required.

Authentication with SOCKS hosts
You can configure Reflection to make a Telnet connection through a SOCKS proxy server or a 
passthrough server (firewall). SOCKS authentication options are in the Security Properties dialog 
box. To open this dialog box:

1. Click Connection Setup on the Connection menu.

2. Select Network as the Connect using option.

3. Select TELNET as the protocol.

4. Click the Security button. The Security Properties dialog box opens.

For information about how to configure your connection, click Help in the Security Properties 
dialog box.
Project Name • Chapter 10 • Security Options with Reflection • TEMPLATE: docs_v3 • D:\working\rwin\sag\Online\Secintro.fm • 8.25.98 • 07:10pm

77



78 Security Options with Reflection
Security-Related Reflection Settings
The Reflection settings Save Passwords, FTP Password, and Web Security provide various types 
of security and are available from the View Settings dialog box. To open this dialog box, click 
View Settings on the Setup menu. 

Save Passwords is described on page 93. FTP Password and Web Security are described in the 
View Settings dialog box help: in the View Settings dialog box, highlight the setting’s name in the 
Reflection settings list, then click the Setting Help button.

VT and HP Profiler
The VT and HP Profiler, described starting on page 81, is installed as a Custom installation 
option during Setup. While the Profiler is not a security utility, it does allow system adminis-
trators to limit the availability of certain commands and features, including some that are 
security-related:

· Unsecured Connections protection: When Reflection is profiled with Unsecured Connec-
tions disabled, users cannot connect to hosts with protocols that are not secure. 

· Password protection: The options on the Profiler’s Password tab protect access to the 
Reflection Profiler, Reflection, or both. See page 87 for more information.

Secure Macro Recording Features
Reflection prevents passwords from being recorded and saved to macros—unless the Save 
Passwords setting (described on page 93) is enabled. Reflection macro recording can interact 
with Admit One (a component of Reflection Signature) without interrupting the user, resulting 
in silent updates to the Admit One database.
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Reflection Signature Security Features
The security features described below are available when Reflection is used with Reflection 
Signature.

Encryption and Authentication with Kerberos Hosts
Reflection is a kerberized client application which can be configured to use Kerberos authenti-
cation for access to services that require it. You can choose the principal name and realm you 
want to use for authentication, and indicate whether you want to require mutual authentication 
or encrypt the data stream. 

Kerberos authentication options are in the Security Properties dialog box. To open this 
dialog box:

1. Click Connection Setup on the Connection menu.

2. Select Network as the Connect using option.

3. Select TELNET as the protocol.

4. Click the Security button. The Security Properties dialog box opens.

For information about how to configure your connection, click Help in the Security Properties 
dialog box.

Single Sign-On Enabled
Reflection is designed to work with Admit One, a component of Reflection Signature that 
allows users to enter a single “key” to access a database of encrypted passwords. Once accessed, 
Admit One authenticates the user for a variety of hosts. 

The setting Admit One, available in the View Settings dialog box, allows system administrators 
to enable or disable the installed Admit One utility. 
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Secure FTP Sessions
When you use Reflection with Reflection Signature, you can make secure, encrypted connections 
to FTP servers with the FTP Client or with WRQ’s FTP. 

The FTP Client is available in your Reflection folder. WRQ’s FTP is available in Reflection for 
Windows: click File Transfer in the Setup menu, then click the FTP tab. WRQ’s FTP is one of the 
Transfer with options.
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Controlling Access to Reflection Features

Use the Reflection Profiler to limit the availability of particular features and commands in 
Reflection. Typically, the Profiler is used on multi-user license versions of Reflection or to specify 
default settings appropriate for your site.

Before Profiling a Multi-User License Version of Reflection
If you’re profiling a multi-user license version of Reflection installed on a shared network drive, 
the following requirements must be met before you can run the Profiler: 

· Confirm that you have network rights to modify, update, and write to the Reflection shared 
network drive. 

· Confirm that the Reflection executable file is not assigned the “read-only” attribute (you 
cannot profile read-only files). 

· Confirm that no one is running the multi-user license version of Reflection before starting 
the Profiler. 

Starting the Profiler
To start the Reflection Profiler: 

1. After completing a Custom installation of Reflection with the Profiler check box selected, 
you start the Profiler by clicking its icon in the Reflection Utilities folder.

2. In the Profile Reflection dialog box, if necessary, change to the folder where you installed 
Reflection. Select the Reflection executable name you want to run the Profiler on, then click 
OK. The Reflection Profiler dialog box opens. 
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Using the Commands Tab to Limit Access to Commands
To limit access to Reflection commands, follow these steps: 

1. Start the Profiler, select the Reflection executable name you want to run the Profiler on, then 
click OK. 

2. In the Reflection Profiler dialog box, click the Commands tab. This is where you enable 
and disable Reflection menu commands and host-specific commands (to disable or enable 
product features, such as the Reflection Macros feature, click the Features tab). 

3. To display a different set of commands, choose a different name from the Categories group. 
Doing so changes the list of command names shown to the right. The first seven categories 
are the names of Reflection’s menus. The remaining categories are for individual host and 
terminal commands. 

Choose All  to see the cumulative list of names from all categories. 

4. The Commands list shows all of the command names in the selected category. If a command 
is enabled, you’ll see a green dot next to it. If it’s disabled, you’ll see a red X. Select or clear 
one or more command names from the Commands list. To see what a command does, 
single-click on its name and read the text in the Command description box. 

To select more than one command name, click the name, hold down c, and then click 
additional names. To select a block of commands, click one name, hold down s, and 
then click another name: both command names, plus all commands in between them, 
are selected. To select all commands in a category, double-click the name shown in the 
Categories list.

5. Select or clear the Enabled check box to control the availability of the selected commands. 
The state of this check box changes depending on which command is selected. When 
this check box is cleared, it means that the highlighted command is disabled. You can also 
double-click a command name to toggle its availability. 

6. When you have multiple commands selected and they are of varying states (for example, one 
is disabled and the all the others are enabled), the center of the Enabled check box turns 
gray. You must first select the check box to enable all commands; if your intention is to 
disable all the highlighted commands, select the check box again to clear the X. 

When you’re through enabling and disabling commands, click OK. 
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Disabling the Enter Key for Reflection’s Reconnect Feature
When a user disconnects from the host, n is the default keystroke mapped to display the 
Connect to Host/Service dialog box. As a system administrator, you may want to disable this 
feature to prevent users from accidentally reconnecting to the last established connection using 
this dialog box. To do this:

1. Click the Commands tab in the Reflection Profiler.

2. Click Connection in the Categories list.

3. Scroll down to highlight ConnectionConnect in the Commands list.

4. Clear the Enabled check box.

Using the Settings Tab to Limit Access to Reflection Settings
To limit access to options (that is, settings) found on Reflection dialog boxes, follow these steps:

1. Start the Profiler, select the Reflection executable name you want to run the Profiler on, then 
click OK. 

2. In the Reflection Profiler dialog box, click the Settings tab. This is where you enable and 
disable Reflection settings shown as options on Reflection dialog boxes. 

3. The Reflection settings list shows all of the settings names. If a setting is enabled, you’ll see a 
green dot next to it. If it’s disabled, you’ll see a red X. To see what a setting does, single-click 
its name and read the text in the Setting details box. 

4. Select or clear the Modification enabled check box to control the availability of the selected 
setting. The state of this check box changes depending on which setting is selected. When 
this check box is cleared, it means that the highlighted setting is disabled. You can also 
double-click a setting name to toggle its availability. 

When you have multiple settings selected and they are of varying states (for example, one 
is disabled and the all the others are enabled), the center of the Modification enabled check 
box turns gray. You must first select the check box to enable all settings; if your intention is 
to disable all the highlighted settings, select the check box again to clear the X. 

When you’re through enabling and disabling settings, click OK. 
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Note that the changes can be overridden under certain circumstances, for example:

· By settings that, when modified, will now change the state of the disabled setting

· By changing the disabled setting via an escape sequence

· By the same setting in a settings file

Using the Features Tab to Disable Reflection Features
The Profiler can be used to disable common features in Reflection, such as using Reflection 
macros, or file transfers either to or from a host. In the example below, the ability to launch 
more than one copy of Reflection is disabled using the More Than One Instance option in the 
Reflection features list:

1. Start the Profiler, select the Reflection executable name you want to run the Profiler on, then 
click OK. 

2. In the Reflection Profiler dialog box, click the Features tab.

3. Select the More Than One Instance option. The Reflection features list shows all of the 
features you can disable (use the Feature description box to understand what the feature 
name means). If a feature is enabled, you’ll see a green dot next to it. If it’s disabled, you’ll 
see a red X.  

4. Clear the Feature enabled check box to disable the feature. You can also double-click the 
feature name to toggle its availability. 

5. Click OK to exit the Reflection Profiler dialog box.

Now, start the Reflection product you just profiled and, on the File menu, click New Session. 
Notice that the product you profiled is not available. 
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General Profiler Settings
The General tab lets you capture the information you set in the Profiler to a text file. The top of 
this dialog box provides information on the product you are profiling; it also shows the Profiler’s 
version number and copyright information. To do this, select the Create Report button on the 
General tab in the Reflection Profiler dialog box and give the file a name. 

For example, if you are running the Profiler on Reflection for UNIX and Digital, the base outline 
of the report looks like this: 

Product Name: Reflection for UNIX and Digital 
Product Version: 7.00.101 
Product Path: C:\Program Files\Reflection\R2win.exe 
Disabled Commands: 
<listed here> 

Disabled Settings: 
<listed here> 

Disabled Features: 
<listed here> 

Importing Information and Creating Site Defaults
The Files tab in the Reflection Profiler lets you specify a settings file as the site default settings file 
for one or more users. This is useful in a multi-user environment whenever a system adminis-
trator wants to present an identical interface to the user group, complete with selected hosts 
connections, color schemes, and toolbars. In addition, all Default buttons will reset to the site 
default settings file settings instead of factory defaults.

You can also apply the profiled configuration of a copy of Reflection to another copy of 
Reflection using the Import button.

Creating a Site Defaults Setting File
If you administer Reflection in a multi-user environment and you want a standardized set of 
Reflection settings for your group of users, use Reflection’s site default settings file feature. As an 
example, a system administrator could author and maintain a profiled copy of Reflection as a 
settings file in a single location for easy maintenance. Now, whenever the shared network drive 
copy of Reflection is started, the site default settings file is loaded automatically, and each user 
sees the same configuration. 
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Caution:  â Once you specify a site default settings file, all Defaults buttons will reset Reflection to the 
settings in the settings file, not to factory defaults. à

Note: A site default settings file cannot retain either the host connection or window and position 
size settings. However, you can link these settings using a partial settings file. See “Linking 
Settings Files” on page 48 for more information. à

To specify a site default settings file:

1. Start the Reflection Profiler and click the Files tab.

2. Click Browse to open the Settings File dialog box. Use this dialog box to specify the settings 
file (use the Clear button to remove the path to the currently specified settings file if there 
is one).

3. Click OK to exit the Settings File dialog box. The path to the settings file now appears on the 
Settings file name box on the Files tab.

4. Click OK to exit the Reflection Profiler.

The settings file you specified in the Files tab will now be the site default settings file for the 
shared network drive copy of Reflection.

Importing Information Already Profiled in Another Copy of Reflection
If you’ve already profiled one version of a Reflection product, and you are installing a newer 
version, you can save time by importing the profiled information from one Reflection product 
to another. This is often the case when Setup does not detect a profiled copy of Reflection, and 
therefore does not display the Save Profiled Settings dialog box (or if you choose not to import 
these settings during Setup). Setup will also not detect these copies if they reside on another PC 
or a shared network drive and you are installing to your local PC.

Note: You can import settings from Reflection for Windows version 5.0 and higher executables 
only. (That is, you cannot import versions prior to 5.0, or other Reflection for Windows 
products, such as Reflection for IBM.) à

Click the Import button on the Files tab to open the Import Profile dialog box and select a copy 
of Reflection that you’ve already configured using the Profiler. The settings you defined in that 
copy of Reflection are applied to the copy of Reflection you are currently profiling. 
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For example, you might be upgrading Reflection for UNIX and Digital, and you want to restrict 
the same commands, or you are importing Reflection for UNIX and Digital settings to the 
Reflection for ReGIS Graphics product.

1. Start the Profiler, and in the Profile Reflection dialog box, select R2win.exe (Reflection for 
UNIX and Digital) and click OK. 

2. Make any necessary adjustments on the Commands, Settings, and Features tabs, then 
click OK. 

3. Start the Profiler, and in the Profile Reflection dialog box, select R2win.exe (Reflection for 
UNIX and Digital) and click OK. 

4. Click the Import button on the Files tab. 

5. In the Import Profile dialog box, browse to the product that you already profiled, for 
example the R2win.exe file based on a server, or the R4win.exe file based locally or on 
a server.

6. Click OK. A message box informs you that all profile information was successfully imported 
into the target Reflection product. 

Protecting Profiled Settings with a Password
Select the Password tab in the Reflection Profiler dialog box to assign a password to protect the 
information you’re currently changing in a Reflection executable file. There are two areas you 
can protect with a password:

· The Profiler itself, using the options described below in the Profiler group box

· The Reflection product, using the options described below in the Users group box

Select the Enable password protection check box to assign a password needed for future modifi-
cations to the currently loaded Reflection executable. After doing so, the following two boxes 
become available: 
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Password
Type your password, up to 32 characters, in the Password box. To preserve security while you 
type, each character displays as an asterisk. 

Confirm Password
After entering a name in the Password box, type the same name in the Confirm password box. If 
you click OK without doing so, Reflection prompts you that you must first enter the same name 
here to enable the password. 

Warning:  â If you forget your password and in the future want to make changes, you must re-install 
Reflection from the original program disks and run the Profiler again: there is no way to 
circumvent the entry of a required password. à

After you click OK, the file is password protected. When you use the Profiler for that copy of 
Reflection to make modifications later, you will be prompted for your password as shown here: 

Verifying a Profiled Copy of Reflection
To confirm that a copy of Reflection has been modified by the Profiler: 

1. Start the copy of Reflection you ran the Profiler on. 

2. On the Help menu, click About Reflection. 

3. Select System in the Information list. 

4. The top line of information will read: “Permanent Customizations: Reflection was 
customized by your system administrator.” 
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Restricting Access to Online Help

You can remove, or restrict access to, the Reflection online help system. For example, you may 
want users to have access to only a customized help file (explained on page 71). 

You have three options for setting restrictions: 

· You can delete or rename the help files that are installed during a Typical or Custom instal-
lation of Reflection

· You can disable access to the commands on Reflection’s Help menu using the Profiler (the 
Profiler is explained starting on page 81)

· You can use menu mapping to remove commands from the Help menu

These procedures are explained next.

Removing or Renaming Online Help Files
If you want to completely restrict user access to a specific help file, just delete it (the file can 
always be restored by rerunning the Setup program from the distribution disks), or rename it. 
The following online help files are included with Reflection:

Help File Name Description

R<n>win.hlp Emulator help file for Reflection for Windows (<n> is 1, 2, or 4, 
depending on what product you installed, see the table on page 47)

R<n>winsys.hlp System administrator help file for Reflection for Windows

Cnectwiz.hlp Connection Wizard help file

Convert.hlp Settings Conversion Wizard help file

Condirv5.hlp Help file used by the pre-6.0 Connection Directory and Phone Directory

Oldmodem.hlp Help file used by the pre-6.0 modem dialer
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Rbrwin.hlp Reflection Basic help file used by the Reflection Basic Editor

Rcl.hlp Reflection command language help (used by the Reflection command 
window)

Rdeploy.hlp Reflection Deployment Manager help file

Readme.hlp Reflection Readme help file

Rnlog.hlp Help file used by Reflection Event Viewer

Rnsocks.hlp Help file for Reflection SOCKS client support

Profil32.hlp Help file used by the Reflection Profiler 

Rftpcom.hlp,
Rftpext.hlp
Rftpllib.hlp 
Rftpc.hlp

Help files used by Reflection FTP Client 

Rwinprog.hlp Reflection Basic methods and properties

Setup.hlp Setup help file (used by the Reflection Setup program) 

Tstoolbr.hlp Help file used by the troubleshooting toolbar 

 Vbrwin.hlp Help file that provides introductory Visual Basic topics and tutorials

Viewset.hlp Help file used by the View Settings dialog box

Help File Name Description
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Disabling Access to Online Help
An alternative to deleting or renaming help files is to use the Profiler (explained on page 81) to 
disable Reflection commands that open the Help window. For example: 

1. Start the Reflection Profiler. 

2. In the Profile Reflection dialog box, select the Reflection executable name that will have its 
Help commands disabled, then click OK. 

3. In the Reflection Profiler dialog box, click the Commands tab. 

4. Double-click Help in the Categories group. This causes all the names in the Commands list 
to be selected. 

5. Clear the Enabled check box. 

6. Click OK. 

Now, neither the Help menu nor the commands you would find under it appear. Instead, they 
are removed from the Reflection menu bar completely. You will see the Help menu in the 
Menu Setup dialog box, however, but it is unavailable for modification. 

Removing Menu Commands Using Menu Setup
To remove commands from the Help menu:

1. Click Menu on the Setup menu.

2. In the Defined menu area on the left side of the dialog box, double click &Help to see the 
Help commands.

3. Highlight the name of the command you want to remove.

4. Click Remove.

5. Click OK.

You can save this change to a complete settings file, or use the Save As command on the File 
menu to save a menu partial settings file (*.rmu).
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Password Protection

Before you create a connect macro or a host connection that requires a user to enter a password, 
you must decide, for security reasons, whether you want the password recorded. Recording a 
password makes it easier for a user to log in to a host, but could also provide access to unautho-
rized users. 

The Save Passwords setting in the View Settings dialog box controls whether Reflection saves 
a password or prompts a user for the password. By default, recording a connect macro or 
saving a host connection to a settings file does not record the password associated with the host 
connection.

Note: Saved passwords  in settings files and other files are encrypted. à

Requiring Login Passwords
To require a password for a host connection: 

1. On the Setup menu, click View Settings to open the View Settings dialog box. 

2. From the Reflection settings list, select Save Passwords. 

Tip: You can also type the first few characters of this setting in the Search text box to automati-
cally highlight it. à

3. Select No in the Setting details box to force Reflection to prompt for a password.

4. Click OK. 

From this point forward, passwords will not be saved with a host connection or connect macro. 
This affects the LAT and NLAT connections, and any passwords that are saved in a connect 
macro (connect macros can be saved with settings files). 

Now when a user establishes a host connection that requires a password, Reflection displays a 
dialog box prompting for a password. 
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Reversing the Value of the Save Passwords Setting
If the Save Passwords value is changed at any point, all connect macros and settings files that 
were saved with the original value will act as they had before, and will not change to reflect the 
new value of the setting. 

Saving the new value to a settings file containing the old value only requires that you resave 
the settings file (click Save on the File menu to do this). However, to save the new value in a 
Reflection macro, you must re-record the macro with the new value: there is no other way to 
incorporate the new value into an existing macro.

Caution: â Manually editing a macro to include your password means that the password is not encrypted. à



S E C T I O N4

File Transfers
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Introduction to File Transfers

With Reflection, you can transfer any type of file—not only text files—to and from a host 
computer. If you’re running multiple host sessions, you can transfer files in one session and 
continue to work in other sessions. You can even transfer files simultaneously in different 
sessions. 

Use Reflection to transfer files between your PC and an HP 3000, VMS, ULTRIX, Unisys, or 
UNIX system, or any host or electronic service that supports the Zmodem, Xmodem, Kermit, 
SuperKermit, or FTP protocols. 

About File Transfer Protocols
The file transfer protocol is the set of rules that two computers follow when transferring files 
between them. Files can be transferred only when both computers use the same protocol, and 
therefore follow the same rules. Protocols can also specify error-checking and correction rules 
to ensure that the information being transferred is sent and received accurately. 

Reflection comes with the WRQ/Reflection protocol, which supports transfers to the hosts 
listed above. 
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Host Transfer Program Version Numbers
Before you can transfer files between your PC and a host system, a host version of the file transfer 
program should be available to work with Reflection. 

The host software should be at the following version levels: 

Before you upload a copy of the host program, you should check if a copy already exists. You can 
also check an existing host program’s version number. The remainder of this chapter explains 
how to do this. 

Checking for PCLINK2
To see if PCLINK2 is already on the host (and if it is, to see its version number), go to the account 
on the HP where you or someone else may have uploaded the program. If you think PCLINK2 
was uploaded to the default account, type one of the following commands at the host prompt. 

RUN PCLINK2.PUB.SYS;INFO="VERSION"   (Native mode for MPE/iX systems) 
RUN PCLINK2.PUB.SYS,VERSION          (Classic HP 3000) 

If the host program is detected, its version number is displayed. For example, the native mode 
message is: 

Native Mode PCLINK2 (Privileged) Version:  3.52.00 

The version number required by the compatibility mode is 2.69. 

If you receive the message “Failed to load program PCLINK2.PUB.SYS” or “File is not a valid 
program file,” then you must upload the host program following the steps on page 102. 

Host Program Name Version Number 

PCLINK2 2.69 (HP compatibility mode, 
Pclink2.pub)

PCLINK2 3.52 (HP native mode, Nmpcl2.pub)

VAXLINK2 2.61 (Vaxlink2.exe and Alphalk2.exe)

UNXLINK2 3.03 (Unxlink2.c and Unxxfer2.c)
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Checking for VAXLINK2
VAXLINK2 may already be defined as a logical name or foreign command. If so, you don’t need 
to upload another copy. If VAXLINK2 is defined as a foreign command, you can also determine 
its version number, explained below. 

If you do not find VAXLINK2 as a logical name or foreign command, you need to upload a copy 
of the host program yourself. 

Checking for VAXLINK2 As a Logical Name
To check whether VAXLINK2 is defined as a logical name: 

· At the DCL prompt, type SHOW LOGICAL VAXLINK2 . 

If VAXLINK2 has been defined as a logical name, a line that looks similar to the following 
appears: 

"VAXLINK2" = "SYS$SYSTEM:VAXLINK2.EXE" (LNM$PROCESS_TABLE) 

If VMS reports that there is no translation for the logical name, either VAXLINK2 has not been 
defined as a logical name or it has been defined using a different name. 

If VAXLINK2 has not been defined as a logical name—or even if it has—it’s possible that 
it has been defined as a foreign command so that you can specify additional VAXLINK2 param-
eters and check the version number. Checking for VAXLINK2 as a foreign command is 
explained next. 

Checking for VAXLINK2 As a Foreign Command
To check whether VAXLINK2 has been defined as a foreign command (described on page 137): 

· At the DCL prompt, type VAXLINK2 V . 

If VAXLINK2 is defined, its version number is displayed. To use the WRQ/Reflection protocol, 
the version number of VAXLINK2 required is 2.61. If an error message is reported when you 
issue the above command, either VAXLINK2 is not installed, it’s not defined as a foreign 
command, or it has been given a different name. 
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Checking for UNXLINK2
If UNXLINK2 is not in your current UNIX directory, here’s how to determine if a copy is 
available in your search path and to see its version number: 

· At the UNIX host prompt, type unxlink2 -v . 

(The command must be typed in all lowercase letters.) 

If UNXLINK2 is available in your search path, the version number is displayed. To use the WRQ/
Reflection protocol, you must have version 3.03 of UNXLINK2. If an error message is reported 
when you issue the above command, either UNXLINK2 is not installed, it’s not in a directory in 
your search path for commands, or it has been given a different name on the host. 
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Uploading the File Transfer Host Program

Before Reflection users can transfer files between their PCs and a host, a host version of the file 
transfer program must be available to work with Reflection. Typically this file is uploaded by the 
system administrator. Reflection includes host programs used by the WRQ/Reflection protocol 
for transferring files to MPE (HP 3000), VMS, and UNIX systems. 

Locating the Upload Scripts
There are three Reflection Basic scripts included with Reflection which upload host programs 
to HP, VMS, and UNIX hosts: 

Uploadhp.rbs 
Uploadvx.rbs 
Uploadux.rbs 

These scripts are not copied by Setup when you perform a Typical installation; they are only 
installed during a Custom installation when you have the Host transfer files check box selected. 
To continue with the procedures that follow and upload the host file transfer programs, first 
check to see if the upload scripts are available—Setup copies them to the Reflection Host 
subfolder. If they are not in this location: 

1. Start the Setup program from the product CD.

2. Select Custom installation as the installation method.

3. In the Custom Installation dialog box, clear all check boxes except Host transfer files. 

4. Click the Install button, and follow the prompts to complete Setup and install the necessary 
host program files. 
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Restoring the Script Menu from Reflection Version 6.0
Before you can upload a host program, you need to restore the Script menu from Reflection 
version 6.0:

1. Click Menu on the Setup menu to open the Menu Setup dialog box.

2. Click Macro under Defined menu to select this item.

3. In the Available options box, open Additional items, open Items from version 6.x, and 
then select Script.

4. Click Add After. This adds the Script menu to the right of the Macro menu.

5. Click OK to close the dialog box. 

6. Click Save on the File menu to save this change.

Basic Steps for Uploading the Host Program
To upload a host program (you must first restore the Script menu using the procedure above):

1. Start Reflection and establish a host connection. 

2. Click Run Script on the Script menu to open the Run Script dialog box. 

3. Change to the Reflection Host folder. 

4. Select the upload script name that matches your environment: 

5. Click the Run button. After a moment, you’ll see the Upload Script dialog box. It is recom-
mended that you first choose the Default Upload button; this successfully uploads the host 
program in almost all situations. 

Script name Host type Host program name (to be copied)

Uploadhp.rbs HP 3000 PCLINK2

Uploadvx.rbs VMS VAXLINK2

Uploadux.rbs UNIX UNXLINK2
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6. When you see the Completed Successfully dialog box, this indicates that the host program 
has been uploaded. Now your users can transfer files using the WRQ/Reflection protocol. 

If you had a problem or received an error when using the Default Upload button to upload the 
host program, use the Custom Upload button: 

· For more information on uploading PCLINK2, see below. 

· For more information on uploading VAXLINK2, see page 107. 

· For more information on uploading UNXLINK2, see page 109. 

Specifics on Uploading the HP Host Program
This section provides detailed instructions for uploading the HP 3000 host program. PCLINK2 is 
the host program that lets you transfer files to and from an HP 3000 system; it must be copied to 
the host before you can transfer files using the WRQ/Reflection protocol. All users of Reflection 
can share the same host copy of PCLINK2; as a system administrator, you can place a copy in a 
common group and account on the host. 

Important: WRQ does not supply a host program for the HP 1000. You must obtain a Kermit or 
Xmodem file transfer program for the HP 1000 and use those transfer methods in Reflection. à

Two versions of PCLINK2 are distributed with Reflection: 

· PCLINK2 for classic HP 3000 machines. (This program can also run on an MPE/iX system 
in compatibility mode.) 

· PCLINK2 for MPE/iX systems. This version of PCLINK2 runs in native mode on an MPE/iX 
machine, and provides the best performance in this environment. POSIX support is only 
available in the native mode version of PCLINK2. 

During the upload of the HP host file transfer program, the upload program detects what type 
of system you have, and automatically uploads the appropriate version of PCLINK2. Since the 
native mode version of PCLINK2 is almost 10 times larger than the classic mode version, it takes 
longer to upload. If you have a slow data line, you may prefer to upload the smaller classic 
version of PCLINK2 and run it in compatibility mode on an MPE/iX system. To do this, use the 
Custom Upload option and select the Compatibility Mode (MPE/V or Classic) option explained 
on page 106. 

PCLINK2 needs to be uploaded only once for each HP 3000, but should be updated with a newer 
version when one is available. 
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To upload PCLINK2, you need the following files in the Reflection\Host folder: 

· Uploadhp.rbs is a script file automating the upload procedure. 

· Pclink2.pub is the host program for classic HP 3000s and compatibility mode. Nmpcl2.pub 
is the native mode version of PCLINK2 for MPE/iX HP 3000s. 

· WRQUPLOA is an auxiliary file required for the upload. 

· VERIFYPH is a program that checks the target group for PH (Processing Handling) capabil-
ities. This type of processing capability is required to perform wildcard transfers and to 
display host directory information. If the target group does not have this capability, a 
warning message is issued with options allowing you to cancel the upload or continue with 
the operation. 

· VERIFYPM is a program that checks the target group for PM (Privileged Mode) capabilities. 
This type of capability is required to perform faster host directory displays in the File 
Transfer dialog box. If the target group does not have this capability, then the older method 
of obtaining host directory information will be used. 

To upload PCLINK2 to an HP 3000 host: 

1. Start Reflection for HP with NS/VT and establish a connection to the HP 3000. You can 
upload PCLINK2 using a direct serial, modem, or network connection. 

2. Log on as Manager.sys, or to the account where PCLINK2 will reside. You must sign on with 
a term type equal to 10 (the normal value). You can force this by adding TERM=10 to your 
logon string, as follows: 

HELLO <logon>;TERM=10 

3. Click Run Script on the Script menu to open the Run Script dialog box (see page 102 for 
information about restoring the Script menu). 

4. From the Reflection\Host folder, select the file Uploadhp.rbs and click the Run button to 
open the Reflection HP 3000 Upload Script dialog box. 

5. Click Default Upload. 

6. When you see the Completed Successfully dialog box, this indicates that the host program 
has been uploaded. Now your users can transfer files using the WRQ/Reflection protocol. 

If you encounter any problems, perform a custom upload (explained next). 
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HP Custom Upload Options
If you need to specify custom options, click Custom Upload in the Reflection HP 3000 Upload 
Script dialog box. The custom options are explained next. 

Upload Method
These options determine what method, or methods, will be used to upload the host program: 

· Leave the Try WRQ/Reflection Protocol check box selected so the PCLINK2 host program 
will be uploaded using the WRQ/Reflection proprietary protocol. Using this protocol 
results in the fastest upload procedure. 

If the WRQ/Reflection protocol is not found by the upload script, then the next two options 
are tried (as long as you leave the Try Old-WRQ Protocol and Try Method Using Host 
FCOPY Utility check boxes selected). 

· Leave the Try Old-WRQ Protocol check box selected so the PCLINK2 host program 
will be uploaded using the Old-WRQ proprietary protocol. (This was the protocol used by 
Reflection in versions prior to version 4.0, which has since been replaced with the WRQ/
Reflection protocol.) 

If the Old-WRQ protocol is not found by the upload script, then the remaining option is 
tried (as long as you leave the Try Method Using Host FCOPY Utility check box selected). 

· Leave the Try Method Using Host FCOPY Utility check box selected so the PCLINK2 host 
program will be uploaded using the HP 3000’s FCOPY utility. 

Reflection uses the FCOPY utility to upload PCLINK2 by issuing the command RUN 
FCOPY.PUB.SYS. If for some reason the HP 3000 was not able to run FCOPY, the message 
“Could not invoke FCOPY utility” displays. Make sure that another program is not running 
by pressing c+x, and then typing ABORT at the colon prompt and pressing n. 

If you see the message “Received unexpected data from FCOPY,” normally this is a result of 
having a term type other than 10. Log on to the host with ;TERM=10 at the end of your 
logon string (see page 104), and try the upload again. This error may also be related to noise 
on the line, or possibly an intermediary device such as a data switch. 

When FCOPY is used, no error checking is performed. If you have problems, the Serial 
Connection Statistics dialog box described on page 204 can indicate the possible sources of 
the problem. 
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PCLINK2 Mode
This option determines what program to upload based on the operating system: 

· Leave the Script Determines Best Mode option set so the script automatically detects 
which MPE operating system you have, and uploads the appropriate software for your 
environment. If you have an MPE/XL or MPE/iX host, then the script uploads the native 
mode version of PCLINK2. For MPE/V or Classic hosts, the compatibility mode of 
PCLINK2 is uploaded. 

· If you want to transfer files using the faster native mode on your MPE/iX system, select the 
Native Mode (MPE/XL and MPE/iX) option. This results in the best system performance. 
If you do not need to run your MPE/iX system in compatibility mode, this is the recom-
mended option. 

· The Compatibility Mode (MPE/V or Classic) option is intended for use on the older HP 
3000 classic machines. Select this option if you have this type of host. 

If you select this option and your host is an MPE/XL, or if you start a file transfer from 
Reflection and notice slow performance on your MPE/iX system, you can do one of 
two things: 

– Your host may be running the compatibility mode of the PCLINK2 software (because 
you selected this option); to take advantage of optimum system performance, you need 
to upload the Reflection file transfer host software that runs in native mode by forcing 
that selection here. 

– If you must run PCLINK2 in compatibility mode, you can change the system priority by 
reassigning PCLINK2’s queue priority level to either D or E. To do this, modify the 
Startup command on the WRQ tab in the File Transfer Setup dialog box. For example: 

RUN PCLINK2.PUB.SYS;PRI=DS 

PCLINK2 Capabilities
Leave this option set to Script Determines Capabilities so that the script automatically detects 
what capabilities the host software will have. The script detects either Privileged Mode or Process 
Handling. 

Choose the PCLINK2 Will Have the Following Capabilities option if you want to force 
PCLINK2’s capabilities: you can select PM or PH capabilities. 
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Host Program Will Be Called
If you want to call the host program something other than the default proposed name of 
PCLINK2.PUB.SYS, type the name here. 

Caution: â Don’t confuse the name that you enter here (which is the name you want the program called 
once it is uploaded to the host) with the host Startup command that you specify on the WRQ 
tab in Reflection’s File Transfer Setup dialog box. In other words, do not enter the Startup 
command here. à

Creating a Troubleshooting Log
Select this check box if you’re running the upload script again because the first time you ran it, 
the upload was unsuccessful. If you request assistance, WRQ technical support will ask for a 
copy of the log created by selecting this check box. The log will be located in the Reflection\Host 
folder. 

Canceling an Upload
If you want to cancel the upload, press e or click Cancel. You may also need to abort the 
program on the host: 

1. Enter a break (by pressing c+x). 

2. Press e and then enter a colon (: ) to turn the HP 3000 echo facility back on. 

3. Type ABORT at the host prompt, and press n to abort the PCLINK2 program. 

Specifics on Uploading the VMS Host Program
This section provides detailed instructions for uploading the VMS host program. Vaxlink2.exe is 
the host program that lets you transfer files to and from VMS systems; it must be copied to the 
host before you can transfer files using the WRQ/Reflection protocol. 

To upload VAXLINK2, you need the following files in the Reflection\Host folder: 

· Uploadvx.rbs is a script file that automates the upload procedure. 

· Vaxlink2.exe is the VAX/VMS host file transfer program. 

· Alphalk2.exe is the AXP/VMS host file transfer program. 

· Wrquploa.mar is a receive-only Kermit program that assists in the upload. 
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Host programs are provided for both VAX and AXP machines running VMS. Clicking the 
Default Upload button after running the upload script causes the upload procedure to automati-
cally determine which program to upload to your host. If the AXP version is uploaded, it is 
renamed Vaxlink2.exe after the upload completes. 

VAXLINK2 may already be defined as a logical name or foreign command (see page 135). If so, 
you don’t need to upload another copy. 

To upload VAXLINK2 to a VMS host: 

1. Start Reflection and establish a connection to a VMS host. You can upload VAXLINK2 using 
a direct serial, modem, or network connection. 

Note: Connecting to one VMS host and performing a SET HOST DCL command to 
another VMS host may cause the upload script to fail. Be sure that you are connected to the 
host to which you want to upload VAXLINK2. à

2. Log in to the host as you usually do. 

3. Click Run Script on the Script menu to open the Run Script dialog box (see page 102 for 
information about restoring the Script menu). 

4. From the Reflection\Host folder, select the file Uploadvx.rbs and click Run to open the 
Reflection VMS Upload Script dialog box. 

5. Click Default Upload. 

6. When you see the Completed Successfully dialog box, this indicates that the host program 
has been uploaded. Now your users can transfer files using the WRQ/Reflection protocol. 

If you encounter any problems, perform a custom upload (explained next). 

VMS Custom Upload Options
If you need to specify custom options, click Custom Upload in the Upload Script dialog box. The 
custom options are explained next. 
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Upload Method
The check boxes in the Upload Method box allow you to specify up to three protocols the script 
should use when attempting to upload the host transfer program. By default, the script first tries 
to upload using the WRQ/Reflection protocol. If that is unsuccessful, the script tries the Old-
WRQ protocol, then the Kermit public domain transfer protocol. 

Upload VAXLINK2 to Which VMS System
By default, the upload script determines what VMS system you are uploading to: either a VAX 
system or an AXP system. If you want to force a specific system type, select that option here. 

Host Program Will Be Called
If you want to call the host program something other than the default proposed name of 
Vaxlink2.exe, type the name here. 

Caution: â Don’t confuse the name that you enter here (which is the name you want the program called 
once it is uploaded to the host) with the host Startup command that you specify on the WRQ 
tab in Reflection’s File Transfer Setup dialog box. In other words, do not enter the Startup 
command here. à

Creating a Troubleshooting Log
Select this check box if you’re running the upload script again because the first time you ran it, 
the upload was unsuccessful. If you request assistance, WRQ technical support will ask for a 
copy of the log created by selecting this check box. The log will be located in the Reflection\Host 
folder.

Specifics on Uploading the UNIX Host Program
This section provides detailed instructions for uploading the UNIX host program. UNXLINK2 
is the host program that lets you transfer files to and from a UNIX host, including Digital’s 
ULTRIX. It must be uploaded to the UNIX host before you can transfer files using the WRQ/
Reflection transfer protocol. 

To upload UNXLINK2, you need the following four files in the Reflection\Host folder: 

· Uploadux.rbs is a script file that automates the upload procedure. 
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· Unxlink2.c is part of the version 3.03 UNIX file transfer program. 

· Unxxfer2.c is part of the version 3.03 UNIX file transfer program. 

· Wrqkerm.c is the receive-only Kermit program that assists in the upload of UNXLINK2. 

To upload UNXLINK2 to a UNIX host: 

1. Start Reflection and establish a connection to a UNIX host. You can upload UNXLINK2 
using a direct serial, modem, or network connection. 

2. Log in to the host as you usually do. 

3. Click Run Script on the Script menu to open the Run Script dialog box (see page 102 for 
information about restoring the Script menu). 

4. From the Reflection\Host folder, select the file Uploadux.rbs and click Run to open the 
Reflection UNIX Upload Script dialog box. 

5. Click Default Upload. 

6. When you see the Completed Successfully dialog box, this indicates that the host program 
has been uploaded. Now your users can transfer files using the WRQ/Reflection protocol. 

UNIX Custom Upload Options
If you need to specify custom options, click Custom Upload in the Reflection Upload Script 
dialog box. The custom options are explained next. 

Upload Method
The check boxes in the Upload Method box allow you to specify up to three protocols the script 
should use when attempting to upload the host transfer program. By default, the script first tries 
to upload using the WRQ/Reflection protocol. If that is unsuccessful, the script tries the Old-
WRQ protocol, then the Kermit public domain transfer protocol. 

Compile UNXLINK2 Using
You can customize the compiling of the UNIX host program by using “switches.” If you’re 
uploading to an AT&T UNIX System 5 system, leave the first check box selected. Also, by default, 
Berkeley Software Distribution (BSD) switches are used. 
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Other detected systems are shown in the box below after you select the Other System Switches 
check box. For example, if you select Berkeley v4.2 UNIX from this box, this appends the 
following switch to the unxlink2 compiler: 

-BSD42 

You can append any additional switches to those that you see here. 

To compile unxlink2 on an AIX host: 

1. Select the Other System Switches check box. 

2. Select AIX (IBM RS6000) from the Other System Switches list. 

3. Clear these two check boxes: 

· AT&T and UNIX System V 

· Berkeley Software Distribution (BSD) Switches 

Host Program Will Be Called
If you want to call the host program something other than the default proposed name of ./
unxlink2 , type in the name here. 

Caution: â Don’t confuse the name that you enter here (which is the name you want the program called 
once it is uploaded to the host) with the host Startup command that you specify on the WRQ 
tab in Reflection’s File Transfer Setup dialog box. In other words, do not enter the Startup 
command here. à

Create a Troubleshooting Log
Select this check box if you’re running the upload script again because the first time you ran it, 
the upload was unsuccessful. If you request assistance, WRQ technical support will ask for a 
copy of the log created by selecting this check box. The log will be located in the Reflection\Host 
folder. 
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Advanced HP File Transfer Topics

Following are some advanced file transfer topics about using Reflection for HP with NS/VT to 
transfer files to an HP 3000 host. 

General Transfer Rules
The following rules apply when transferring files to an HP 3000. 

Sending New Files
Reflection checks the name you specify for the transferred file against existing file names. If the 
host file exists prior to the transfer, what happens depends on the value in the If file exists list. 

However, if the host file does not exist yet, it is created with an estimated file limit. A generous 
estimate for the file size is initially given, but when the transfer is complete, unused disk space 
is released. You can override the calculation by using MPE file equations. 

If a PC file contains many blank lines or short lines, the file created on the HP 3000 may not be 
large enough, which will cause the transfer to abort. If this occurs, purge the created file on the 
host at the MPE prompt. Then use a file equation at the MPE prompt to define a larger file. 
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File Creation Based on Transfer Type
If the Transfer type is ASCII, the host will default to an ASCII MPE file with fixed-length 
records. The record size specified in the Record size box (on the WRQ tab in the File Transfer 
Setup dialog box) is used as the actual record size. 

If the Transfer type is Binary, the host file is created as a binary MPE file with variable-length 
records. The specified record size is used as a maximum. 

If the Transfer type is Auto-Detect, Reflection automatically determines the file type and selects 
the transfer type for you.

All creation defaults may be overridden by MPE file equations, but this has no effect on the 
transfer type. 

Using Lockwords
A lockword is a password you can attach to a file on the HP. Once a lockword is assigned to a file, 
you cannot read or write from that file without supplying the lockword. 

When an HP file has a lockword, you must add it to the host file name before performing a 
transfer to the PC: 

<file name>/<lockword> 

If the PC file is sent back to the host using the original file name and the If file exists list is set to 
Delete, the lockword must be specified in the host file name. 

You can create a lockword file when transferring a PC file to the host by adding the lockword to 
the host file name as described above. 
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Using the POSIX Shell
Beginning with version 5.0 of the MPE/iX operating system, MPE is “POSIX compliant.” Some 
of the POSIX features included are: 

· Support for long file names and lowercase file names; case is preserved when you transfer 
the files from Reflection. 

· Fully hierarchical file names. 

· Native POSIX files have a new record format, “stream,” which is just a stream of bytes. 
POSIX support is only in the native mode version of PCLINK2 (Reflection’s file transfer 
host program). 

· A POSIX shell, replacing the MPE colon prompt with a UNIX-type interface. 

Reflection for HP with NS/VT is a POSIX-compliant application. When the MPE file names list 
(in the HP Advanced File Transfer Options dialog box) is set to POSIX, the host side of the File 
Transfer dialog box will show files created with lowercase file names in lowercase. The host 
directory shows multiple levels of the directory hierarchy. All the functionality included for 
the MPE host directory is supported with the POSIX file naming format (for example, drag-and-
drop file transfers). 

Both POSIX and UNIX sort file names by placing lowercase after uppercase. For example, three 
files named TEST1, test2, and TEST3 are sorted in the host directory listing as follows: 

TEST1 

TEST3 

test2 
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HP 3000 Host Directory Support
The following section discusses the host directory support specific to the HP 3000 and its 
operating system, MPE. Since the MPE file system is not hierarchical by nature, Reflection needs 
to make certain assumptions when displaying HP host directory information. 

MPE Groups and Accounts
The MPE file system is broken into groups and accounts. The highest level in the file system 
displays a full set of the accounts available on the system. Although one account (SYS) is typically 
designated for MPE system files, it has no particular precedence in the MPE file system. 

Each account consists of one or more groups. The PUB group is generally taken to be one where 
common files are kept (although this is not a mandatory requirement). 

Files are stored in a specific group. Therefore, to reference a file you must include: 

· The file’s name 

· The name of the file’s group 

· The name of the account containing the file’s group 

A fully qualified file name is concatenated with periods that separate these three elements, as in: 

PCLINK2.PUB.SYS 

 PCLINK2 is the file name, PUB is the group, and SYS is the account. 

Changing the Directory Display
The File Transfer dialog box supports a “change directory” command typed in the Host file 
names box to provide you with a view to other groups and accounts. 

Note: You are not changing your logon group or account by using these commands—what you 
are changing is the current group and account being viewed. As a system administrator, you can 
restrict the display view as explained on page 120. à
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Valid Options
The options described below are valid at any time (assuming you have the permissions): 

filespec.group.account
Make group.account the current directory, and set the current pattern to filespec. 

.group.account
Make group.account the current directory, and reset the pattern so that all files are 
displayed. 

..account
Make account the current directory, such that groups for that account are displayed as 
children of the account. 

..
Make the root the current directory, such that the list of all accounts is displayed below 
the root. 

Valid Options When the Current Directory Is the Root
account  

Change to the specified account and display its groups underneath the account. 

group.account 
Change to the specified group in the specified account and display the files in that group. 

Valid Options When the Current Directory Is an Account
group

Change to the specified group and display the files in the group. 

.account
Change to the specified account, and display its groups underneath the account. 
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Valid Options When the Current Directory Is a Group
filespec.group

Change to the specified group in the current account and set the current pattern to filespec. 

.group
Change to the specified group in the current account. 

The HELLO Command and the Logon Group
When you log onto the MPE system with the HELLO command, a certain group and account 
becomes your default directory: this is commonly referred to as your “logon group.account.”

Your logon group.account is related to the logon name. For example, the logon sequence HELLO 

MGR.TRACK logs you onto the TRACK account with a user name of MGR. The logon account can be 
directly determined from the HELLO command, but the logon group is determined by whatever 
the default is for the user (in this example, MGR). The group name is often not included when 
logging on. 

On MPE/iX machines, you can change your current group to another group in your account 
with the CHGROUP command, but you cannot change to a different account without logging 
on again. On Classic machines, you cannot change either the group or account. Since there is 
no nesting in the directory structure other than the group-within-account aspect, and it is not 
common to switch directories often, groups tend to have many files in them (users tend to store 
everything in their logon group.account). 

Adding Parameters to the PCLINK2 Startup Command
Some of the default values that govern the WRQ/Reflection protocol file transfers to an HP 3000 
can be altered by appending parameters to the Startup command or by changing the value in the 
Transfer link list. Both these items are set on the WRQ tab in the File Transfer Setup dialog box. 

When appending parameters, use the following format: 

RUN PCLINK2.<group>.<account>;PARM=<n> 
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The value of n is a 16-bit number, of which the three right-most bits indicate the type of file 
transfer (the 13 left-most bits indicate the PCLINK2 timeout). 

Optional parameters for the startup sequence include: 

· QEDIT
Files with label information similar to QEDIT’s are received as if they were QEDIT files. 
On a Classic HP 3000, add ,NQ to the Startup command if you do not want to retain 
this label information when receiving files. On an MPE/iX machine, use INFO=NQ. To 
maintain QEDIT information when a file is sent to the host, add ;Q to the host file name. 
See page 129 for more information. 

· Timeout
Use PARM=<value> at the end of the Startup command to change the default timeout 
value for PCLINK2 (30 seconds). Bits 0–12 (these bits are counted left to right) are used to 
indicate the timeout interval in seconds. Bits 13–15 are reserved. For the 13th bit, this is 
equivalent to multiplying the desired timeout by 8. For example, to set a timeout of 60 
seconds use PARM=480 (480 is equal to 8 * 60). If the parm value of these bits is zero, the 
default timeout is used. 

· PARM=1 
Enq/Ack flow control is automatically turned off with 8-Bit file transfer (the default for 
Transfer link). If you experience flow control problems during file transfer with Classic HP 
3000s, you can add PARM=1 to the Startup command. This preserves Enq/Ack flow control, 
and is faster than slowing down to 7-bit. 

· PARM=2
To create a file transfer log file that records file transfer activity, add PARM=2 to the Startup 
command. See page 152 for more information. 

· PARM=5 
If you receive the error message: 

File transfer failed, error in protocol, transfer aborted 

Try setting PARM=5. (5 is the mux parameter; this works in most situations.) 

· Combining PARM values 
If more than one of the PARM values apply, add the values. For example, to select a 
60-second timeout and create a file transfer log file, use PARM=482. 



120 Advanced HP File Transfer Topics
Configuring Host Directory Displays
The version of PCLINK2 (version 3.51, HP native mode) shipped with this copy of Reflection 
provides a means for system administrators to exercise greater control over the display of host 
directories and files presented to a user in the File Transfer dialog box. This control is distinct 
from MPE security and can be configured to be more or less restrictive than MPE security would 
allow for a specific user or group of users. 

The configurable display control does not, however, go beyond the bounds of MPE security to 
limit what can be transferred—it limits only what can be displayed. That is, if a user knows the 
fully qualified path name for a file and has read access allowed by MPE, the file can be downloaded 
even if the display control will not allow viewing of the directory that contains that file. The Host 
file names box in the File Transfer dialog box can always be used to enter specific file names and 
wildcards for file transfer. 

Configurable Display Levels
When you click the Show Host Files button in the File Transfer dialog box, this shows the 
user a list of all files in their current group and account. You can use the VT and HP Profiler to 
completely remove the Show Host Files button from the File Transfer dialog box. 

You can limit display privileges on a user-by-user basis. When a user attempts to access a 
restricted area, the following warning appears: 

No Display Privileges—Warning Message
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Setting Display Levels
There are several display levels available for both the MPE and POSIX namespaces. MPE and 
POSIX levels are set independently of one another. The table below describes the different 
display levels; a definition of the following terms will be useful in understanding the table. 

Display Privileges: 

· None—Indicates that the user cannot obtain a graphical display of any host directory data. 

· Current Group Only—Indicates that the user cannot change groups within an account. 

· Current Account Only—Indicates that the user cannot change accounts but can view all 
groups within the current account. 

· Full Display—Indicates that the user can display all accounts and groups available on a 
host machine. 

MPE User Capabilities: 

· Normal—User has no AM (Account Manager) or SM (System Manager) capabilities. 

· AM—User has AM capability but not SM. 

· SM—User has SM capabilities. 
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The MPE levels can affect the display of files differently based on how the directory display 
request was made: 

· If the user requests a display of a new directory by clicking on the account folder in the File 
Transfer display box, what appears depends on the user’s assigned display privileges—either 
a list of all groups for that account appears or, if the user has Current Account Only privi-
leges, the display doesn’t change at all. 

· If the user changes to that same directory using the appropriate commands in the Host 
File Names box, then the display of requested data may appear, depending on the restric-
tion level. 

For the POSIX namespace, a user’s box privileges and graphical privileges are always the same. 

Operating System Requirements
If the host is running MPE/iX 5.0 or higher, all display levels for both MPE and POSIX 
namespaces are available when using the PM version of the PCLINK2 program. With this config-
uration, PCLINK2 also takes advantage of HP’s Architected Interface Facility (AIF), which 
provides marked performance improvement when displaying the host directories. When using 
the non-PM version of PCLINK2, display levels 0–3 are available for both MPE and POSIX. 

If the host is running a version of MPE/iX earlier than 5.0, PCLINK2 cannot use the AIF to 
display the host directories. In addition, POSIX is not supported. 

Configuring User Displays 
These two functions of PCLINK2 allow you to configure a user’s display level: 

· CONFDISP configures user display level limits. 

· SHOWDISP prints the current display level settings to the screen. 
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Using the CONFDISP Function
There are two ways to specify a display level for a user or group of users: 

· Use the MPE command line to execute the command. 

· Use a data file containing the necessary information (user and account names and the 
desired display levels). Then, specify this data file as input to the command executed on 
the MPE command line. 

There are several advantages to this second option. One is you can use just one data file 
to apply changes to multiple systems. Further, the data file can be used again when new 
versions of PCLINK2 are made available. 

To execute the CONFDISP function: 

1. At the MPE colon prompt, enter this command: 

:RUN PCLINK2.PUB.SYS;INFO="CONFDISP" 

Your screen looks like this: 

Native Mode PCLINK2 Version 3.52 

Enter display configuration information  (Type ABORT to cancel.) 

(Press RETURN when done) > 

2. At the prompt, enter the display level information using this syntax: 

<user name>.<account name> <MPE level> <POSIX level> 

You can replace both the <user name> and the <account name>  with a single wildcard 
character (@). The wildcard character cannot be used with other characters; that is, pattern 
matching is not supported. For example, user or account names such as FOO@ and ABC@ 
are not supported. 

Here are some examples of valid CONFDISP command entries: 

MGR.FOO 0 1 

MGR.@ 1 3 

@.PLAY 5 0 

@.@ 2 2 
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3. To accept the entry and add another, press n. 

4. When you’re through making entries, press n twice. 

Using a Data File with CONFDISP
To use a data file as input to the RUN command, add <file name (where < is the redirection 
character that sends the information to the specified file name ) to the end of the RUN 
command shown in step 1 above. For example: 

:RUN PCLINK2.PUB.SYS;INFO="CONFDISP" <mycfg 

There is a 4K limit on the data contained in data file configuration strings. The minimum 
number of bytes required for a single record is eight. This equals a maximum of 500 entries. If the 
user and account names are longer than a single digit, as is often the case, the number of entries 
allowed is decreased. 

The output of CONFDISP is a new PCLINK2 program, named PCLINK2A, with the specified 
levels configured. In actual use, you should rename this back to PCLINK2. 

Using the SHOWDISP Function
Use the SHOWDISP function to see the configurations specified by CONFDISP for a particular 
system. To execute this function at the MPE colon prompt, enter this command: 

:RUN PCLINK2A;INFO="SHOWDISP" 

This function is being run against the new executable created above by CONFDISP 
(PCLINK2A); not the original PCLINK2. 

Using the earlier example for CONFDISP settings, your screen changes to look like this: 

Native Mode PCLINK2 Version 3.52 

DISPLAY LEVEL CONFIGURATIONS 

USER.ACCT                MPE / POSIX 

MGR.FOO                - 0 / 1 

MGR.@                  - 1 / 3 

@.PLAY                 - 5 / 0 

@.@                    - 2 / 2 
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POSIX supported:  YES,  PM: Yes,  Fast Directory:  YES 

For MGR.FOO:  MPE Level  = 0,  POSIX Level = 1 

End of Program 

To determine a user’s display level, the user and account names are compared with each configu-
ration string in PCLINK2A following this algorithm: 

· If the configuration value is an exact match (such as MGR.FOO), PCLINK2 uses the 
associated display levels. 

· If there is a configuration string that includes a wildcard in either the user or account name, 
PCLINK2 uses the display levels associated with this string. 

· If there are multiple strings matching this criteria, (such as MGR.@ and @.FOO) the first of 
these will be selected. 

· If there are no single wildcard matches and the record @.@ exists, the display values 
associated with this string will be used. 

· If none of the above is present, PCLINK2 defaults the display levels for this user to 3 for both 
MPE and POSIX namespaces. 

Advanced HP File Transfer Options
To configure advanced HP transfer options in Reflection: 

1. On the Setup menu, click File Transfer, then click the WRQ tab. 

2. Make sure the System type is set to HP 3000. 

3. Click the Advanced button to open the HP Advanced File Transfer Options dialog box. 

A description of each option follows; for more detailed information, see the online help. 
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MPE File Names
Select which naming format to use from the MPE file names list. This file name structure is 
used for host file names during file transfers, and it also determines how the file names display in 
the File Transfer dialog box after you click the Show Host Files button. When this list is left set to 
MPE, files beginning with a period or a forward slash (. or /) are interpreted as POSIX files. 

Reflection supports four name spaces for file names: 

· The traditional MPE file names. For example, the names must be all uppercase, each name a 
maximum of eight characters, in the format directory structure 
FILENAME.GROUP.ACCOUNT. 

· The MPE version 5.0 POSIX file names. For example, the names can be mixed case and of 
any length, using a fully hierarchical directory structure. 

The MPE file names are a subset of the POSIX names. All MPE file names are visible from 
within POSIX (for example, PCLINK2.PUB.SYS appears as /SYS/PUB/PCLINK2), but 
only POSIX files whose names are also valid as MPE file names are visible from MPE. 

· When you select Auto from the MPE file names list, the host will determine if it is running 
under the MPE Command Interpreter (CI) or the POSIX shell. If it is the MPE CI, the name 
space is set to MPE; if it is the shell, the name space is set to POSIX. 

Note: Even though the host determines the name space, the setting in the dialog box is not 
changed; it remains as Auto. à

· Selecting MPE-Only from the MPE file names list allows only valid MPE names to be 
accepted. 

This option is for those users who used the “.groupname” construct for the host file name. 
This allowed them to transfer files into a different account. For example, specifying .PUB, 
transferred files into the PUB group. With the introduction of POSIX, this behavior 
changed. PCLINK2 interprets the .PUB as a POSIX name and therefore attempts to transfer 
the files as a single file named .PUB.  If the name space is set to MPE-Only, the old behavior 
is performed. 

There is an alternative to setting the name space to MPE-Only. If the name space is left set to 
MPE, then the host name may be specified as @.groupname , as in @.PUB. This will result in 
the same behavior as described above for the MPE-Only name space. 
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Send as Stream
Native POSIX files under version 5.0 of the MPE operating system support a new record format 
known as “stream,” which is just a stream of bytes. Files created under the POSIX shell or by 
POSIX programs have this format by default. Files created from the MPE command interpreter 
or by MPE programs can optionally be stream files. 

Interoperability between stream files and other record formats is automatic. This means an MPE 
program can read from a stream file and it will appear to be a traditional variable-length record 
file, and a POSIX program will see all files as stream files. MPE does the translation automatically. 

If you want all files that you send to the host to have the stream format, select the Send as stream 
check box (when you receive files from the host, the WRQ/Reflection protocol automatically 
detects the record format of the host file and the correct translation is performed). When 
this check box is left cleared, PCLINK2 defaults to a fixed record format for ASCII files and a 
variable record format for binary files. 

QEDIT Format on Send
Select this check box to create a host file with the QEDIT format. See page 129 for more 
information. 

Send to Spooled Device
To send a spool file to a device on an MPE/iX machine, select this check box. This ensures 
correct handling and minimizes extra form feeds being issued on the printer. 

Remove File Extension on Send
Select this check box to automatically strip the file extension from the file or files you are sending 
to an HP 3000. 
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File Transfers from HP Desk
To perform file transfers from HP Desk, you must have MPE access. If you always work within 
HP Desk, place a colon before the Startup command (on the WRQ tab in the File Transfer Setup 
dialog box). For example, :RUN PCLINK2. Then, save the change to the default settings file. 

If you perform file transfers from within and outside HP Desk, it is best to set and then reset the 
Startup command. 

To simplify implementation, you can configure the two user-defined commands (UDCs) 
described below. Both can be called by the HP Desk UDC already set up on your system. The first 
UDC might be called SETLINK and contain the following lines: 

OPTION LIST 

COMMENT EC&oFSETHOST-STARTUP 

":" & VALUE(HOST-STARTUP)
C

R 

The LIST option directs the UDC to echo any subsequent lines to the terminal. (MPE normally 
does not echo.) The comment line changes the current host startup command so that a colon 
precedes it. Note that CR represents a carriage return. The EC&oF sequence is a Reflection escape 
sequence that invokes Reflection’s command interpreter, as explained in the HP Terminal 
Reference manual. 

To reset the startup command upon exiting HP Desk, a second UDC containing the following 
lines could be used: 

OPTIONLIST 

COMMENT EC&oFSETHOST-STARTUPMID 

(VALUE(HOST-STARTUP),2,-1)
C

R 

This UDC (call it RESETLINK) would return the startup command to its default setting. 

The center four lines of this version of the HP Desk UDC follow: 

SETLINK 

CONTINUE 

RUNHPMAIL.HPMAIL.SYS;LIB=g;PARM=:tray;INFO="!user" 

RESETLINK 

The CONTINUE ensures that if an error occurs while trying to run HP Desk, the rest of the 
UDC is executed. This ensures that the startup sequence will be reset by the RESETLINK UDC, 
regardless of whether HP Desk runs. 
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QEDIT
QEDIT is an HP 3000 text editor from Robelle Consulting, Ltd., that you can run from Reflection. 
When you start the program, it automatically adjusts the following Reflection settings: 

· Completion codes are enabled (see the Reflection Terminal Reference for HP Hosts for more 
information on completion codes). 

· To avoid minor problems with typeahead in block mode, typeahead is disabled while in 
VISUAL mode. 

Reflection’s variable V9 is used to save and reset typeahead. (That is, if typeahead was on 
before entering VISUAL mode, it will be on again when you exit this mode.) Because 
QEDIT uses the variable V9, it cannot be used in any of your Reflection command scripts 
that might be run while also running QEDIT. 

Transferring QEDIT Files from Reflection
Files with label information similar to QEDIT’s are received as if they were QEDIT files. PCLINK2 
sends host files in the QEDIT format to the PC as ASCII files. To override this on a Classic HP 
3000, append ,NQ to the Startup command (on the WRQ tab in the File Transfer Setup dialog 
box) if you do not want to retain this label information when receiving files. On an MPE/iX 
machine, use INFO=NQ. When sending QEDIT files back to the host, append ;Q  to the host file 
name (if the file already exists on the host in QEDIT format, this switch is not necessary). 

QEDIT files are received on the PC without sequence numbers, since they are seldom used by PC 
tools. When a PC file is uploaded into QEDIT, new sequence numbers are assigned to the lines. 
If you are receiving a QEDIT file that contains PC data (such as a Reflection command script or 
an Assembler program), use SET LANGUAGE JOB in QEDIT for PC files. A JOB file has 80-byte 
records and is saved without sequence numbers. When you download a QEDIT JOB file, 
Reflection does not add a label to it; JOB is the default. 
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Note: QEDIT has a :REFLECT command that allows you to execute any Reflection command. 
You can include Reflection commands in UDCs, as in: 

:REFLECT receive report.dta from reptdata delete 

:REFLECT chdir \winword 

:REFLECT shell winword 

Using a QEDIT UDC, you could do a :REPORT into a file, then download the file to a PC and 
update a PC database that monitors use of HP 3000 system resources. à

Retaining QEDIT Language Attributes
QEDIT files can have the following language attributes: 

For example, the following starts a QEDIT session for a new COBOL file: 

:RUN QEDIT.PUB.SYS 

SET LANGUAGE COBOL 

NEW COBFILE 

If you transfer a QEDIT file to your PC, Reflection writes a label to the PC file that describes the 
QEDIT file attributes, as in: 

RECSIZE=80; LANGUAGE=3 

Code Attribute Record Size 

1 SPL 72-byte records 

2 FORTRAN 72-byte records 

3 COBOL without comments 66-byte records 

4 RPG 80-byte records 

5 JOB 80-byte records, KEEP UNN 

6 Text SET LENGTH sets the record size up to 256 bytes 

7 Pascal 72-byte records 

8 COBOLX with comments 74-byte records 
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The LANGUAGE specifier tells QEDIT the record format and which compiler to use with the 
source file. For Transact or Powerhouse, you can use SPL or JOB, and then invoke the interpreter 
via a user-defined command (UDC). 

Stopping File Transfers
If you want to stop a transfer to an HP host, press e or click Cancel in the File Transfer in 
Progress window and wait for Reflection to stop the transfer. If PCLINK2 is still running on the 
host (colons marching across the screen are one indication of this situation), use the following 
steps to reestablish communications with an HP 3000: 

1. Press c+x. 

2. The next step differs according to whether you are on a Classic or MPE/iX system: 

– If you’re on a Classic HP 3000, press e then type a colon (:) to turn the HP 3000 
echo facility back on. (If your host system is MPE V (T-MIT), you must log off and 
back on.) 

– If you’re on an MPE/iX system, type SET ECHO=ON. 

3. Type ABORT at the host prompt and press n to abort PCLINK2. 

Setting Up Remote Transfers
You can force PCLINK2 to use a communications port other than the one assigned to your 
session. For instance, a host program running as part of a batch job could perform file transfers 
to and from PCs running Reflection. 

PCLINK2 opens the file HPPCPORT when it opens the communications port, enabling 
PCLINK2 to do file transfers to any other PC not opened by any process. For PCLINK2 to 
communicate with a PC designated via HPPCPORT, Reflection must be running and the baud 
rate must be configured to match that of the port’s default baud rate. 

PCLINK2 expects Reflection to tell it what files go in which direction. If the host is to control a 
file transfer, it must force Reflection to initiate the file transfer. 
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The following steps in a host program tell Reflection to send the PC file PCFILE.PC to the 
HP 3000: 

1. FOPEN the PC’s port with the following: 

foptions = %600      (Undefined length records) 
aoptions = %404      (Read/Write and NOBUF access) 

2. FWRITE 
ESC&oCSEND pcfile.pc TO hpfile ASCII 

C
R. 

3. FREAD the Startup Command, RUN PCLINK2.PUB.SYS. 

4. Create and activate PCLINK2. 

5. FREAD the completion code that Reflection sends indicating the success or failure of the 
host-initiated command. 

HP Host File Name Switches
The WRQ/Reflection protocol for HP hosts supports ASCII, binary, and label file transfer types, 
and also lets you specify various qualifiers, or switches, to modify the way the file is saved on the 
HP 3000, and how it is handled when the transfer is complete. 

To use the file transfer switches, append the switch you want to the host file’s name when trans-
ferring it. For example, to send the file LUNA to a device on the HP 3000 as a spool file, you 
would enter LUNA;O in the Host file names box in the File Transfer dialog box. The switches 
described here are different from the parameters you can append to PCLINK2 to change 
the timeout value, create a log file, and so on; see page 118 for details about the PCLINK2 
parameters. 

A list of available switches follows. For information on switches specific to QEDIT, see page 129. 

;F – Fixed-Length File Transfers
Reflection lets you specify fixed-length file transfers when using the binary file transfer type. The 
fixed-length type lets you send graphics data files, which may require a fixed-length binary 
format, to the HP 3000. Reflection defaults to variable-length files in binary transfers, but gives 
the option of either fixed or variable formats. Fixed-length files are padded with nulls when 
returned to the PC. 
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;L – Include Label Information
Adding the ;Label modifier (or simply ;L) to a host file name ensures that HP 3000-specific file 
information is retained in the data transmitted to the PC. If your goal is to transfer a file between 
two HP 3000 systems via Reflection, use the labels transfer type or the ;Label modifier. 

Both the ;Label modifier and the labels type force the inclusion of user labels on HP 3000 files. 
Files such as message catalogs and executable programs can be transferred without losing any 
information. Label information is encoded in an ASCII format in the PC file. 

;O – Spool to MPE/iX Machine
You can send a file to a device on the HP 3000 as a spool file. Add ;O to the host file name to 
ensure correct handling and minimize extra form feeds being issued on the printer. 

;P – Purge Existing HP 3000 File
When a file being transferred already exists on the host, file characteristics of the existing file are 
kept, even if you choose to overwrite the host file. You must purge the existing file if you want 
the file characteristics to be determined by the file being transferred. To do this, add a ;P (or 
;Purge) to the host file name, for example MYFILE;P . 
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Advanced OpenVMS File Transfer Topics

Following are some advanced file transfer topics about using Reflection to transfer files to a 
OpenVMS-related host system. 

Transferring Files to Any OpenVMS Host Directory
The default settings for the WRQ/Reflection protocol allow you to transfer files between your 
PC and the host directory in which Vaxlink2.exe is stored. 

There are two ways to transfer files between your PC and any host directory: 

· Define VAXLINK2 as a logical name on the host. This lets you transfer files between your 
PC and any host directory, without changing any transfer settings in Reflection. Defining 
VAXLINK2 as a logical name is described below. 

· Define VAXLINK2 as a foreign command on the host. This also lets you transfer files 
between your PC and any host directory, but you must change the Startup command 
on the WRQ tab in the File Transfer Setup dialog box to remove the word “RUN.” By 
defining VAXLINK2 as a foreign command, you can check its version number, and specify 
additional parameters for running the program. 

Defining VAXLINK2 as a foreign command is described on page 137. 

Defining VAXLINK2 As a Logical Name
By defining VAXLINK2 as a logical name on the host, you create a logical equivalent for the full 
directory path and name of the Vaxlink2.exe program. Whenever the host sees the logical name 
VAXLINK2, it replaces it with the full equivalent name. This allows you to store just one copy of 
Vaxlink2.exe on the host, and run it from whichever directory you’re currently logged into. 
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Further, by defining VAXLINK2 as a logical name, you do not need to make any changes to the 
file transfer settings before transferring files; the default settings will let you transfer files between 
your PC and any host directory. 

If you define VAXLINK2 as a system-wide logical name, all users can share the same 
Vaxlink2.exe program. 

There are a couple of limitations when VAXLINK2 is defined as a logical name: 

· You cannot check the version number of VAXLINK2. 

· You cannot specify additional parameters for VAXLINK2 to modify file transfers. 

If you want to check the version number of VAXLINK2 or specify additional parameters, you 
should also (or instead) define VAXLINK2 as a foreign command, as described in the next 
section. 

To define VAXLINK2 as a logical name, type the following at the DCL prompt: 

DEFINE VAXLINK2 [device]:[directory]VAXLINK2.EXE 

Note: To avoid potential symbol resolution problems on the host, be sure to use the full name 
Vaxlink2.exe when defining the logical name. à

The [device] and [directory] specify the location where you uploaded Vaxlink2.exe. If 
you don’t know the device and directory names, type SHOW DEFAULT at the DCL prompt to 
display them. 

The above command defines the logical name VAXLINK2 in the current process logical table, 
and for the current session only. To define the logical name each time you log in, add the above 
line to your Login.com file on the host, preceding the line with a dollar sign, as in: 

$ DEFINE VAXLINK2 [device]:[directory]VAXLINK2.EXE 
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Defining VAXLINK2 As a Foreign Command
By defining VAXLINK2 as a foreign command on the host, VAXLINK2 can accept a number of 
parameters—to show the version number, change the number of times a failed transfer should 
be retried, create a log file on the host, and so on. When VAXLINK2 is defined as a foreign 
command, you must change the Startup command (on the WRQ tab in the File Transfer Setup 
dialog box) setting to use the defined command; this is described below. The parameters you can 
use with VAXLINK2 are listed on page 138. 

To define VAXLINK2 as a foreign command: 

· Type the following at the DCL prompt: 

VAXLINK2 :== $[device]:[directory]VAXLINK2.EXE 

· Or if VAXLINK2 is defined as a logical name (described earlier):

VAXLINK2 :== $VAXLINK2 

The [device] and [directory] specify the location where you uploaded Vaxlink2.exe. If 
you don’t know the device and directory names, type SHOW DEFAULT at the DCL prompt to 
display them. 

The above command defines the symbol VAXLINK2 as a foreign command, but for the current 
session only. To define the symbol each time you log in, add the above line to your Login.com 
file on the VAX, preceding the line with a dollar sign, as in: 

$ VAXLINK2 :== $[device]:[directory]VAXLINK2.EXE 

You can add the above line to the Sys$manager:Sylogin.com system-wide login file, so that all 
users automatically have VAXLINK2 defined when they log in. 

Changing the Startup Command
To use VAXLINK2 when it’s defined as a foreign command: 

1. On the Setup menu, click File Transfer, then click the WRQ tab.

2. With the System type list set to OpenVMS, remove the word “RUN” from the Startup 
command. The box should then read VAXLINK2. Click OK. 
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Adding Other Parameters to the Startup Command
When VAXLINK2 is defined as a foreign command (see page 137), it can accept additional 
parameters to modify the transfer protocol. 

Once VAXLINK2 is defined, remove the word “RUN” from the Startup command setting (on the 
WRQ tab in the File Transfer Setup dialog box) so that it reads just VAXLINK2. VAXLINK2 then 
has the following syntax and can take the following parameters:

VAXLINK2 [D<n>] [E<n>] [H] [L] [N<n>] [R<n>] [S] [T<sec>] [V] [X<n>]

D<n> Defines how, and if, Reflection should attempt to perform fast file transfers. 
DØ disables fast file transfer, D1 instructs Reflection to try a nonroutable fast 
file transfer, and D2 indicates a request for a routable TCP-style fast file 
transfer. The default, D3, causes Reflection to try all forms of fast file transfer; 
in general, you should never have to change the default. 

E<n> Sets a packet size for fast file transfers. The valid range is 1–4 and the default 
is 4. 

H Displays a summary of VAXLINK2 parameters. 

L Creates a log of the file transfer. The log file is called Wrqlog and is saved in 
the current VAX directory. This is explained on page 153. 

N<n> When there is no response from the PC, the file transfer attempt is repeated 5 
times (by default) before canceling. This parameter sets the retry limit to <n> 
consecutive times (<n> must be an integer). 

R<n> VAXLINK2 tries to queue up several reads at a time in order to speed up the 
terminal I/O. This parameter sets the number of reads that can be queued up. 
The valid range is 1–5, and the default for most connections is 5. If you’re 
connected over either LAT or CTERM, the default value is 1. 

S Displays a summary of valid host file name switches. See page 140 for a 
complete description of the switches. 

T<sec> Sets the timeout—the number of seconds during which there is no response 
from the PC. The default timeout is 30 seconds. This parameter should 
always be set to a value at least 5 greater than the Receive timeout parameter 
on the General tab in the File Transfer Setup dialog box; if the two timeouts 
match and an error occurs, the host and PC will time out simultaneously, 
making recovery more difficult. 
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To use the above parameters, with the exception of H, S, or V, append the parameter to the word 
VAXLINK2 in the Startup command; for example, a Startup command of VAXLINK2 L T15 

creates a log file and sets a timeout value of 15 seconds. 

To use the H, S, or V parameters to obtain VAXLINK2 information, append the parameter to the 
word VAXLINK2 at the DCL prompt. For example, to display VAXLINK2 help, your DCL 
command line would look like this: 

$ VAXLINK2 H 

OpenVMS Host File Name Switches
The WRQ/Reflection protocol lets you specify various qualifiers, or switches, to modify the way a 
file is saved on OpenVMS hosts, and how it is handled when the transfer is complete. When there 
is a Reflection setting equivalent for the switch as provided below, in most cases you should 
specify these parameters in the File Transfer Setup dialog box. 

To use the file transfer switches, append the switch you want to the host file’s name when trans-
ferring it. For example, to submit the file Luna.dat to the print spooler after sending it to the 
VAX, you would enter Luna.dat/S in the Host file names box in the File Transfer dialog box. 
The switches described here are different from the parameters you can append to VAXLINK2 to 
change the timeout value, the number of retries, and so on; this is explained on page 138. 

Warning:  â Do not type a space before appending a switch to a file name; doing so results in an error. 
(Reflection considers this as two separate file names.) For example, <File name>/A  is valid; 
<File name> /A will cause the transfer to fail. à

V Displays the version number of VAXLINK2. This should be version 2.61. 

X<n> During file transfers, blocks may need to be retransmitted. This parameter 
sets the number of retransmits to be performed before giving up the file 
transfer; the default value is 10. 
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The following switches are available:

/A – ASCII Transfer: Set Maximum Record Length

When transferring ASCII files with fast file transfer, you can specify that the maximum record 
length be set in the file header of the resulting host file. 

/B – Block Mode

For binary transfers from the host only. This switch forces VAXLINK2 to read the host file in 
block mode rather than record mode. 

For certain files in nonstandard formats, this gives you every byte that is actually contained in the 
file, including record separators, without regard to record lengths or carriage control. In other 
words, if you do a binary receive of a file that does not have fixed record lengths, record 
separators will be discarded unless you use /B. 

You must use this switch when the file is put onto the OpenVMS system using PATHWORK’s 
COPY command. 

/C – Submit Files to Batch Queue

File transfer to the host only. Submits the file or files to the batch queue (SYS$BATCH) upon 
completion of the transfer. Files are deleted on the host after they have been submitted; use /K 
(described below) to keep the file. The Reflection equivalent is the Submit to batch queue check 
box (in the OpenVMS Advanced File Transfer Options dialog box). 

/D – DECDx Format Files

Binary file transfer only. Transfers files in DECDx format between the VAX and PC. The 
Reflection equivalent is the Preserve record counts check box (in the OpenVMS Advanced File 
Transfer Options dialog box). 

/F – Fixed Length Records

The /F switch was used with VAXLINK to specify fixed length binary files. This is the file format 
that VAXLINK2 creates by default. (This switch is offered only for backward compatibility with 
the older protocol.)
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/I – Image Transfer Method

The /I switch was used with VAXLINK to specify a file transfer image method; the image method 
should be specified in the File Transfer dialog box. (This switch is offered only for backward 
compatibility with the older protocol.) 

/K – Keep Submitted Files

This switch is valid only in conjunction with the /C or /S switch, both of which submit files to a 
queue on the host. Once the files are in the queue, they are normally deleted. To keep a copy of 
the file on the host, use the /K (keep) switch. The Reflection equivalent is the Keep file after 
submitting check box (in the OpenVMS Advanced File Transfer Options dialog box). 

/L – Add Linefeed

Binary file transfers from the host only. This switch appends a linefeed character to each record 
when receiving a file that has carriage control. The linefeed character is added even if the carriage 
control is not stream-lf. 

/P – Translating Carriage Control Characters

ASCII or binary file transfers from the host only. This switch translates FORTRAN or PRINT 
carriage control characters in OpenVMS files. 

If you don’t use this switch on files that contain printer carriage control characters, set the 
Reflection property TranslateCharacters  to False to prevent these control characters from 
being translated unpredictably. When carriage control characters are not translated, they become 
part of the file’s records. To discard these characters, use the /T switch (see below). 

/S – Spool Files to Printer

ASCII file transfers to the host only. Submits the file or files to the print queue (SYS$PRINT) 
upon completion of the transfer. Note that files are deleted on the host after they have been 
submitted; see /K above to keep the file after it is submitted. The Reflection equivalent is the 
Submit to print queue check box (in the OpenVMS Advanced File Transfer Options dialog box). 

/T – Discard Carriage Control Characters

ASCII or binary file transfers from the host only. This switch discards FORTRAN or PRINT 
carriage control characters in OpenVMS files. To translate these characters, use /P (see above). 
The Reflection equivalent is the Translate carriage control check box (in the OpenVMS 
Advanced File Transfer Options dialog box). 
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/V – Variable Host Record Size

Binary file transfers to the host only. Creates the host file with variable-length records (the 
default is fixed). The Reflection equivalent is to select Variable from the Record format list (in 
the OpenVMS File Attributes dialog box). 

/W – Block Mode Binary

Binary file transfers from the host only. This switch supports the block mode binary transfer 
required for files created by applications such as the DOS and OpenVMS versions of Lotus 1-2-3 
and WordPerfect. 
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Advanced UNIX File Transfer Topics

Following are some advanced file transfer topics about using Reflection to transfer files to a 
UNIX host. 

Making UNXLINK2 Available System-Wide
After UNXLINK2 is uploaded to the host, it can be made available to all Reflection users by 
placing it in a system-wide directory, then configuring each user’s login so that the user 
“inherits” an operating environment that includes the directory path to UNXLINK2. 

For more information about UNIX user profiles, operating environments, and directory paths, 
see the documentation for your UNIX host. 

Adding Parameters to the UNXLINK2 Startup Command
For UNIX systems, UNXLINK2 can accept the following parameters to modify the Startup 
command (set on the WRQ tab in the File Transfer Setup dialog box): 

unxlink2 [-C] [-H] [-L] [-N<n>] [-T<sec>] [-V] [-X<n>] 

-C By default, wildcard transfers to UNIX hosts result in host file names that are 
lowercase. This parameter creates host file names that are uppercase. 

In file transfers without wildcards, the local file name is reproduced on the host 
with upper and lowercase as entered; the case is preserved and not changed 
during the transfer. 

-H Displays a summary of UNXLINK2 parameters. 

-L Creates a log of the file transfer. The log file is called Wrqlog and is stored in the 
current UNIX directory. This is explained on page 154. 

-N<n> When there is no response from the PC, by default the file transfer attempt is 
repeated 5 times before canceling. This parameter sets the retry limit to <n> 
consecutive times (<n> must be an integer). 
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To use the above parameters (with the exception of -H  and -V ), append the parameter to the 
word unxlink2  in the Startup command; for example, this Startup command unxlink2 -L 

-T15 creates a log file and sets a timeout value of 15 seconds. 

To use the -H  or -V  parameters to obtain UNXLINK2 information, append the parameter to the 
word unxlink2  at the UNIX host prompt. For example, to display UNXLINK2 help, your 
UNIX command line would look like this: 

ux: unxlink2 -H 

Configuring UNIX File Attributes
To specify UNIX file transfer attributes in Reflection: 

1. Click File Transfer on the Setup menu to open the File Transfer Setup dialog box. 

2. If necessary, click the WRQ tab to bring it to the front. 

3. Make sure the System type is set to UNIX. 

4. Click the Attributes button to open the UNIX File Attributes dialog box. 

A description of each option follows; for more detailed information, click the Help button and 
click on the item you need help with.

-T<sec> Sets the timeout, the number of seconds during which there is no response from 
the PC. The default timeout is 30 seconds. This value should always be set to 
a value at least 5 seconds greater than the Receive timeout parameter on the 
General tab in the File Transfer Setup dialog box. If the two timeouts are the 
same and an error occurs, the host and PC will time out. 

-V Displays the version number of UNXLINK2. The version number required is 
3.03 or higher. 

-X<n> During file transfers, blocks may need to be retransmitted. This parameter sets 
the number of retransmits to be performed before giving up the file transfer; the 
default value is 10. 
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Owner
In this box, enter the owner for the file. The name specified must correspond to a valid login 
name or user ID in the specified group. 

Group
In this box, enter the group of the file’s owner. The value specified must correspond to a valid 
group name or group ID. 

Mode Group Box
Select the Set mode check box to specify read, write, and execute permission for the Owner, 
Group, Others, and All. If this check box is not selected, permissions are determined by the 
default creation mode on the host. 

The modes are as following: 

· Select the Set user ID on execution check box when transferring an executable file to specify 
that the owner’s permissions should determine access when the program is run (instead of 
using the permissions of the person running the program). 

· Select the Set group ID on execution check box to specify that the permissions of the login 
group of the person running the file determine access as the file is running. See chmod (1) in 
your UNIX documentation for more information. 

· If an executable file is prepared for sharing, selecting the Save text image after execution 
(sticky bit) check box will prevent the system from abandoning the swap space image of 
the program-text portion of the file when its last user terminates. When the next user of a 
file executes it, the text does not need to be read from the file system (it is swapped in), 
saving time. 
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Solving File Transfer Problems

This chapter provides solutions to some problems you may encounter when transferring files 
between Reflection and the host. 

Using Predefined Settings
Most file transfer problems can be solved by choosing one of the Preset configurations on the 
Protocol tab in the File Transfer Setup dialog box. Each predefined value also has a trouble-
shooting counterpart; try that setting if your first choice does not work. 

General File Transfer Troubleshooting Solutions
Following are some general troubleshooting solutions for transferring files. 

Changing the Startup Command
If you’re having trouble transferring files, make sure you have the correct Startup command on 
the WRQ tab in the File Transfer Setup dialog box: 

· For HP 3000 transfers, make sure the location of PCLINK2 matches the group and account 
specified in your Startup command; see “Location of PCLINK2” below. 

· For OpenVMS transfers, if you defined VAXLINK2 as a foreign command using the 
procedure on page 137 and you cannot transfer files, make sure the word RUN is not part 
of the Startup command. The sequence should simply read VAXLINK2. 

· For UNIX transfers, first make sure the Startup command reads unxlink2 (this must be in 
lowercase letters). Then, type unxlink2 -h  at the UNIX host prompt. If you receive the 
error message “Command not found” and the file unxlink2 is located in the current UNIX 
directory, change your Startup command to ./unxlink2 . 
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Location of PCLINK2
Is PCLINK2 where you think it is? Normally, PCLINK2 is installed in the PUB group of the SYS 
account. To find out if PCLINK2 is installed, and where, enter the following command at the 
colon prompt: 

LISTF PCLINK2.@.@,2 

It may take several minutes, but your HP 3000 ultimately displays all files and programs named 
PCLINK2, along with the name of the group and account in which they are installed. 

The listing will look something like this: 

:LISTF PCLINK2.@.@,2 

ACCOUNT=  SYS       GROUP=  PUB 

FILENAME  CODE ----LOGICAL RECORD-------- ----SPACE ----- 

               SIZE  TYP   EOF  LIMIT R/B SECTORS  #X  MX 

PCLINK2    PROG 128W  FB    82    82    1     83     1  1 

This indicates that PCLINK2 is installed in the PUB group of the SYS account. Now check the 
Startup command on the WRQ tab in the File Transfer Setup dialog box. The sequence should 
match the PCLINK2 group and account. For example: 

RUN PCLINK2.PUB.SYS;PARM=1 

No Host Response for Transfer
If you get the message “Host doesn’t respond” when initiating a transfer, this means that the 
host file transfer program could not be executed. Review the following situations that cause this 
message to appear: 

· You did not have a host prompt when starting the transfer. First, try manually typing the 
startup sequence from your host prompt. If this works, check the syntax for the Startup 
command on the WRQ tab in the File Transfer Setup dialog box to make sure it matches 
what you just typed. 

· The host program was not uploaded; see page 101. 

· Another program is running on the host, so the startup sequence could not be executed. 
Wait until the other program completes, then try again. 



 

  Solving File Transfer Problems 149
· You are starting a file transfer or uploading a file, and Reflection for HP with NS/VT cannot 
get the normal 

DC1 prompt from the host. In either case, the transfer is never initiated. There 
are a number of possible causes: 

– There may be no connection with the host or you may not be logged on to the host. 

– The serial port on the HP 3000 may not be configured as an HP block mode terminal. 
Log on to the system again, specifying ;TERM=10 at the end of the logon string. 

– Your Startup command is incorrect. Check to see if PCLINK2 is where your Startup 
command says it is; see page 148. 

File Transfer Timeout
When transferring a file, if Reflection and the host do not respond to each other within a certain 
amount of time, the file transfer will time out with the message “Transfer link failed—too many 
retries.”

The following circumstances are possible: 

· You are transferring a file and Reflection times out repeatedly while waiting for a response 
from the host. If the host is really sending data, but slowly, you might try increasing the 
Receive timeout value on the General tab in the File Transfer Setup dialog box (discussed in 
more detail, below). 

· You may have an intermediary device (multiplexer) that is trying to perform flow control or 
to filter out certain characters. Select the appropriate Troubleshooting preset configuration 
on the Protocol tab in the File Transfer Setup dialog box and try again. 

Receive Timeouts
The value of Receive timeout (on the General tab in the File Transfer Setup dialog box) deter-
mines the maximum amount of time that Reflection should wait for a packet of data or an 
acknowledgment from the host when receiving a file; by default, this is set to 15 seconds. If there 
is no response within the timeout period, data is assumed to be lost and Reflection requests that 
the data be sent again. Consecutive timeouts can cause the file transfer to fail. 

If you know that your host computer responds quickly to data requests, but your host connection 
is prone to transmission errors, try decreasing the value of Receive timeout. If noise on the data 
line requires a data packet to be retransmitted, decreasing this value causes Reflection to wait less 
time before timing out from the error, which in turn speeds up transfers. 
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VAX Process Quotas
You may not be able to run the OpenVMS file transfer host program if the process quotas on 
your OpenVMS are not set high enough. For example, you may receive the message “File access 
failed” or “Exceeded quotas.”OpenVMS won’t tell you which quotas you exceeded (for security 
reasons), but following are the recommended minimums: 

To display process quotas, type the following DCL command at the host prompt: 

SHOW PROCESS/QUOTAS 

For example, to set the byte limit quota (which is the Buffered I/O limit) to 16000, modify the 
user authorization file (UAF) with the AUTHORIZE utility. 

Note: Changing process quotas requires certain access privileges. à

Once you are in the AUTHORIZE utility, the syntax is as follows: 

MODIFY username/BYTLM=nnnn 

To set the byte limit for HIMRT to 16000, for example, use: 

MODIFY HIMRT/BYTLM=16000 

The UAF file is updated when you exit AUTHORIZE and the new quota values take effect the 
next time you log in. 

PC File Information
If you do not know the type of the PC file you want to transfer to the host (and therefore do not 
know whether you should specify ASCII or Binary), use the Fileinfo utility copied by the Setup 
program to either the Reflection \HP\Support or \VT\Support folder. 

ASTLM 24 

BIOLM 18 

DIOLM 18 

BYTLM 16000 
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The Fileinfo utility tells you: 

· Whether the file contains any characters outside of the ASCII set (characters with a decimal 
value higher than 127) and is therefore binary. 

Note: If you run this utility on a binary file that has no high-bit characters, Fileinfo will 
(incorrectly) report that the file is ASCII. If you are unsure of results, you should use a more 
sophisticated tool to determine file type. à

· If an ASCII file contains a ^Z as an end-of-file indicator. 

This utility should only be used for examining files that were created on the PC. Fileinfo is not 
intended for use on label files that were received from the host; using it on a label file may yield 
inaccurate results. 

Using Fileinfo
The syntax for the Fileinfo utility, entered from the DOS prompt, is: 

Fileinfo <file name> 

The <file name>  can contain wildcards. Different categories of information are shown, 
depending on whether the file is ASCII or binary. The categories are: 

RECSIZE Specifies the maximum number of bytes per record (the length of the 
longest line). This is the size of the largest record. 

ASC/BIN Indicates whether a file is in ASCII or binary format. Record statistics 
(#RECORDS) are not shown for binary files. 

TYPE Displays V if records are of variable length; F displays if fixed length. 

#RECORDS Shows the total number of records in an ASCII file. 

EOF(^Z) Shows the record in a file where the ^Z end-of-file marker was found. 
If no ^Z is found, NONE displays in this column. 

BYTES Shows the number of bytes in the file. 

ARCV’D Indicates whether the file has been backed up by a backup utility (the 
file’s archive bit is not set). 

TABS Indicates whether the file contains tab (decimal 9) characters. 
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File Transfer Log Files
If you’re experiencing file transfer problems while using the WRQ/Reflection protocol, WRQ’s 
technical support staff may request that you “capture” a trace file that logs file transfer activity. 
How to create a log file when you use the WRQ/Reflection protocol, either on your PC or on the 
host, is explained below (for public domain protocols, you must use event tracing described on 
page 199). 

While the contents of these trace files—a cryptic record of data communications activity that 
occurs during the transfer—will not make much sense to you, the files are of great assistance to 
a WRQ technical support person experienced in reading file transfer trace files. 

HP File Transfer Log
To capture file transfer activity to an HP host log file when using the WRQ/Reflection protocol, 
go through the following steps: 

1. On the Setup menu, click File Transfer, then click the WRQ tab.

2. Append ;PARM=2 to the Startup command. 

3. Click OK. 

4. Perform the transfer you are having trouble with. 

A log file (Wrqlog) containing terminal-based data communications is created in the current 
host directory. This is a variable-length binary file. Because logging requires additional host 
resources, use this facility only for debugging purposes. A brief explanatory record is written to 
the log file after each frame record. The record includes the following information: 

First byte: < Frame sent by the host 

First byte: > Frame sent by the PC 

CTRL (control) frame Protocol overhead 

CTRL DATA frame Configuration and other control information 

USER DATA frame Application data 
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The frames are not converted back from their printable ASCII form. If the application is sending 
binary data, some of it may be transformed to printable ASCII. 

Upon request, you can transfer this file to your PC and send it to the WRQ technical support 
staff. Before receiving the file, press a+L to open the command line and enter the following 
command: 

TranslateCharacters = False 

OpenVMS File Transfer Log
To capture file transfer activity to an OpenVMS host log file when using the WRQ/Reflection 
protocol, go through the following steps: 

1. Define VAXLINK2 as a foreign command (page 137). 

2. On the Setup menu, click File Transfer, then click the WRQ tab.

3. Append L to the Startup command: 

VAXLINK2 L 

4. Click OK. 

5. Perform the transfer you are having trouble with. 

A log file containing terminal-based data communications is created in the current host 
directory. The log file name is Wrqlog. Upon request, you can transfer this file to your PC and 
send it to the WRQ technical support staff (a period is required after the file name, as in 

Wrqlog. ). 

Before receiving the file, press a+L to open the command line and enter the following 
command: 

TranslateCharacters = False 
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UNIX File Transfer Log
To capture file transfer activity to a UNIX host log file when using the WRQ/Reflection protocol, 
go through the following steps: 

1. On the Setup menu, click File Transfer, then click the WRQ tab.

2. Add the -L  parameter to the Startup command: 

unxlink2 -L 

(The case of the letter L does not matter, unlike the lowercase requirement of the Startup 
command.) 

3. Click OK. 

4. Perform the transfer you are having trouble with. 

File transfer activity is logged to a host file called Wrqlog. 

PC File Transfer Trace File
To capture file transfer activity to a local file when using the WRQ/Reflection protocol, press 
a+L to open the command line and enter the following command before initiating the 
transfer: 

StartTrace "Wrqlog." 

The StartTrace  method lets you capture all data communication between the host and PC to a 
local file named Wrqlog.pc, which is created in the Reflection\User folder. 

You can include the option rcTraceTimed  parameter to create a file that also includes the time 
at which data was sent or received from the host: 

StartTrace "Wrqlog." ,rcTraceTimed 

When you’re through with tracing, press a+L to open the command line and enter this 
command: 

StopTrace 



 

  Solving File Transfer Problems 155
Fast File Transfer Traces
If you use PCLINK2 over a VT-MGR or Telnet connection, or VAXLINK2 over a Telnet or LAT 
connection, Reflection’s “fast file transfer” may be in effect; if it is, the PC log file Wrqlog.pc will 
contain only the initial data communication used to determine that a “fast” transfer can occur. 
At that point in the transfer, data communication switches from terminal communication to 
network communication. Any data sent or received via network communication is not included 
in the log file. 

When using PCLINK2, the HP host log file will record all terminal-based communication. In 
contrast, when using VAXLINK2, the OpenVMS host log file records only the initial data commu-
nication, as described above. 

If the resulting log file does not help in solving your file transfer problem, and you suspect that 
fast file transfer is not the cause of the problem, you can disable this feature: 

1. On the Setup menu, click File Transfer, then click the WRQ tab.

2. Select Never from the Fast file transfer list. 

3. Click OK. 

4. Click Save on the File menu to save your settings file. 

Now, when you perform a transfer and create a log file, this will record all terminal-based 
communication, as explained earlier. 

Transferring Files Running PCLINK2 in Compatibility Mode
If you start a file transfer from Reflection and notice slow performance on your MPE/iX system, 
you can do one of two things: 

· Your host may be running the compatibility mode of the PCLINK2 software; to take 
advantage of optimum system performance, you need to upload the Reflection file transfer 
host software that runs in native mode. This is explained below and is the recommended 
solution. 

· If you must run PCLINK2 in compatibility mode, you can change the queue priority for 
PCLINK2; this is explained below. 
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Uploading Native Mode PCLINK2
The compatibility mode version of PCLINK2 is intended for use on the older HP 3000 Classic 
machines. If you want to transfer files using the faster native mode on your MPE/iX system, use 
the supplied script file Uploadhp.rbs to upload the Reflection file transfer host program (see 
page 102 for information about restoring the Script menu). The upload procedure automatically 
detects which MPE operating system you have, and uploads the appropriate software for your 
environment. 

Uploading the native mode version of PCLINK2 results in the best system performance. 
Therefore, if you do not need to run your MPE/iX system in compatibility mode, this is the 
recommended solution. See the instructions starting on page 101. 

Changing the System Priority for PCLINK2
If you’re running PCLINK2 and notice a decrease in performance when transferring files from 
Reflection, you can change the system priority by reassigning PCLINK2’s “queue” priority level 
to either D or E. To do this, modify the Startup command on the WRQ tab in the File Transfer 
Setup dialog box. 

For example, to reassign PCLINK2 to the HP 3000’s D queue, enter the following startup 
sequence: 

RUN PCLINK2.PUB.SYS;PRI=DS 

File Transfers over High-Speed Modems
If you’re experiencing trouble transferring files over a high-speed modem, first try disabling 
Reflection’s data compression. To do this, press a+L to open the command line and type the 
following command: 

WRQCompression = rcNone 

If this setting does not resolve your problem, then try turning off the modem’s data compression. 
This can be done using a modem initialization string that you enter in the More Settings dialog 
box (see the online help for details). 
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Zmodem Transfer Problems
If you are unable to transfer files using the Zmodem protocol, typically this can be corrected 
by changing the Transfer type to Binary. 

If you’re transferring files using the Zmodem protocol and receive the message “Unable to 
communicate with remote system,” first check to see if the Zmodem program on the host is a 
public domain version. To do this, type the command that starts a Zmodem download at the 
host prompt; this is typically sz . The resulting output produces a syntax listing: if you see 
“For Use with Omen Technology Products,” then the version of Zmodem you’re attempting 
to use will not work with Reflection’s public domain implementation of Zmodem. 

Kermit Transfer Problems
If you are unable to transfer files using the Kermit protocol, typically this can be corrected by 
changing the Transfer type to Binary. 

Both the host and the PC determine which parity Kermit uses during file transfers. If both are 
able to operate in 8-bit mode, Reflection transfers in 8-bit mode. If Reflection’s Parity setting is 
other than 8-bit, 7-bit mode is used. Problems occur if both systems can operate in 8-bit mode, 
but an intermediary, connecting system can only operate in 7-bit mode. You must set the parity 
to 7/0’s in this case to force Kermit to operate in 7-bit mode. 
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The LAT Protocol

This chapter only applies if you are using a Reflection suite.

Your Reflection suite provides NDIS3 support for the LAT protocol on PCs running 
Windows 95, Windows 98, or Windows NT 4.0. You can use the LAT protocol over multiple 
network card interfaces. 

The LAT protocol is installed during Setup; see your Reflection suite User Guide for a 
detailed installation procedure. The Setup program automatically binds the LAT protocol to 
your computer’s Ethernet hardware address via an NDIS2- and NDIS3-compliant driver, 
or via an ODI driver. NDIS3 is the recommended driver.

You can only use the LAT protocol over an Ethernet interface. You cannot use LAT over a 
Token-Ring or serial interface. 

LAT Configuration
The Setup program does not configure any parameters specific to LAT. The initial value 
for PC name is based on your Ethernet hardware address. The other initial values for LAT 
parameters are based on LAT protocol defaults. 

When you make changes to your network configuration, the changes do not become 
effective until you click OK to close the Network Control Panel and restart the Reflection 
network software. In some cases you must exit and then restart Windows to have network 
configuration changes take effect. You will be prompted to do this if it is necessary.
Reflection NFS Connection • Chapter  • The LAT Protocol • TEMPLATE: docs_v4 • D:\working\rwin\sag\Online\LAT.FM • 8.25.98 • 07:10pm

161



162     The LAT Protocol
To configure LAT: 

1. Open the Windows Control Panel and double-click the Network icon. If you’re using 
Windows NT, click the Protocols tab.

2. In the list of installed components, click Reflection LAT.

3. Click Properties.

There are two LAT configuration options that are only available on PCs running Windows NT. 
In Windows 95 or Windows 98, the Circuit timer and Fast transfer mode options are not 
available and do not appear in the Reflection LAT Properties dialog box. 
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PC Name
Your Ethernet address (in the format WRQ_<Ethernet address>) can identify your PC as a node 
on the network. To generate the PC name this way, select the Use default PC name check box. 

To identify your PC with a name other users on the network can readily recognize, type in a 
string of up to 16 characters. 

Local Characteristics
You can configure local settings that apply to LAT.

Keepalive Timer
The LAT protocol sends keepalive packets to notify the network that your system is still 
available; this setting lets you set the number of seconds between packets. You can enter a value 
from 10 to 600 seconds. The default is 20 seconds. For a busy network, choose a value between 
60 and 180 seconds. 

Retransmit Limit
The PC may have a problem sending messages to, or receiving messages from, the host server on 
a busy network. This parameter sets the number of times the PC will retransmit a message 
before it drops the connection. You can enter values from 4 to 255. The default is 20. If you lose 
established LAT connections, try increasing the Retransmit limit. 

Circuit Timer
The Circuit timer determines the time interval between transmits when Fast transfer mode 
is disabled. A higher Circuit timer setting slows down the connection by increasing the time 
between packet transmissions. A lower setting speeds up the connection by reducing the time 
between packets. You can enter a value from 10 to 1000 milliseconds. The default is 10 
milliseconds.

The Circuit timer setting is only available for PCs running Windows NT.
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Fast Transfer Mode
Fast transfer mode allows your PC to transmit data over your LAT connection as fast as 
possible. (When Fast transfer mode is enabled, the Reflection software ignores the Circuit 
timer setting.) Fast transfer mode is enabled by default. You should disable this setting only 
when you want to reduce traffic on the network or reduce the network load on your PC.

The Fast transfer mode setting is only available for PCs running Windows NT.

Services
Click Services on the LAT tab to see the service table.

The LAT protocol uses a directory of services available on the network, which includes the 
names and addresses of service providers. Service providers periodically send multicast 
messages advertising their services on the network. The information in the service directory 
(such as rating) is updated on the basis of these messages. Existing dynamic entries are removed 
from the directory if advertisements of that service are not received for a period of time. You 
can define static entries that remain in the service table even when they are not updated by new 
service advertisements. 

See the description of service Type on page 165 for information about making a service static 
or dynamic. 
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The LAT Service Table Maintenance dialog box displays the LAT services that are currently 
available on your network. The Reflection networking software continually updates these LAT 
services. When you shut down your network software or exit Windows, the service table entries 
are saved in a file called Rservice.ini in your Windows directory. When you restart the Reflection 
LAT protocol, these entries are available in the service table. 

Service Name
The Service name is the resource that a host server provides on a LAT network. 

Node Name
The Node name is the location from which the service is advertised. 

Rating
A service Rating  indicates how much traffic a service on a particular node is getting. A low 
rating indicates that the service is busy. If a service is available from multiple nodes, the node 
with the highest rating (least amount of traffic) is used. 

Type
A service is either dynamic or static. By default, all services are dynamic. 

To ensure that a service on a particular node is available when you try to make a connection, 
change its entry from dynamic to static. To do this, select the entry, then click Make Static. A 
static entry stays in the service table regardless of any multicasts. 

You may also need to build a static table in cases where the system administrator has disabled 
multicasting and you must preload service entries. 

To change an entry from static to dynamic, select the static entry and click Make Dynamic. 

Note: If you do not want to display any dynamic entries in the service table, click Group Codes 
on the LAT tab and disable all groups. No multicasts will update the service table. à
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A service table can be as large as 64K, or approximately 300–500 entries, depending on the 
amount of information associated with each entry. You may see a description of the service 
(sent as part of the multicast) at the bottom of the dialog box when you select a particular 
service. The amount of information in these entries affects how many total entries your service 
table can accommodate. 

Update
The service table displays the services available when you opened or last updated the table. Click 
Update to have the display reflect multicast information received since you opened or updated 
the table. 

Group Codes
The LAT protocol can divide a local area network into subnetworks called groups. A system 
administrator can use groups to reduce the number of services that the users see. Click Group 
Codes on the LAT tab to open the LAT Group Codes dialog box. 
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By default, all group codes are enabled. If you only use services in specific groups, clear the 
check box for any group announcements you do not want to see. You can enable or disable 
groups numbered from 0 to 255. Click Enable All to reset all groups to the default. To enable 
only a few groups, first click Disable All, then select the groups. The group codes settings are 
stored in Rservice.ini in the Windows directory. 

When you change your group codes, the dynamic entries in your service table are cleared; new 
entries will be added to reflect subsequent multicast messages. 
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LAT Statistics

This chapter only applies if you are using a Reflection suite.

The LAT Statistics utility displays statistics for the LAT protocol. Most users don’t need to 
view a statistics display, but system administrators can use this information when tuning, 
troubleshooting, or monitoring network transactions. This utility applies only to PCs 
running Windows 95 or Windows 98; it is not available for PCs running Windows NT. 

Network counters are updated continuously while the counter window is open.

Viewing LAT Statistics
By default, the LAT Statistics utility is located in the Reflection\Utilities folder available from 
the Start menu. (On the Start menu, point to Programs, Reflection and then Utilities. Click 
LAT Statistics.)

On the LAT Statistics Settings menu, click Interface Counters or LAT Counters to specify the 
statistics you want to see. This will display the counts for a prescribed set of statistics for the 
interface or the LAT protocol—almost all counter values are numeric. You can display both 
interface and LAT protocol counter types at the same time.
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Interface Statistics
The title of the interface statistics group indicates that it is an Ethernet interface and includes 
your hardware address. 

For a detailed description of the interface counters, see the online help.

LAT Protocol Statistics
LAT statistics shows counters associated with LAT sessions. Multicast counters are displayed 
even if you don’t have a LAT session open. 

 

For a detailed description of the LAT protocol counters, see the online help.
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LAT Services
The LAT Services table shows information about each service currently known to LAT. The 
services table consists of information read from the static service table and information received 
from service announcements on the network. The information for each LAT service is shown as 
a row in the table. 

To see the Ntework LAT Services table, open the LAT Statistics utility. On the Settings menu, 
click LAT Services. 

The table provides the following information about each LAT service: 

Service Name
The name of the resource on a LAT network that is provided by a host server. 

Node Name
The node from which the service is advertised. A service can be advertised on multiple nodes, 
but the node with the highest rating is used. 
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Rating
A service rating is determined by how busy a service is. As traffic increases, the service rating 
decreases. LAT attempts to connect to the node offering the highest rating. 

Type
A service is either Dynamic or Static. 

Description
A text string describing this LAT service. This is defined by your LAT administrator. 

A service table can be as large as 64K, or approximately 300–500 entries, depending on the 
amount of information associated with each entry. 
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Network Trace

This chapter only applies if you are using the LAT networking protocol that you received 
as part of a Reflection suite. If you need to perform an event trace with Reflection for 
Windows, see page 199.

The Network Trace utility allows you to capture packets on your own machine or from a 
remote machine. The trace file is saved in a binary format that WRQ technical support can 
use for troubleshooting. This LAT Connection utility applies only to PCs with Windows 95 
or Windows 98; you can not use it to capture a trace on a PC running Windows NT. 

Setting Up Network Trace
To open the Network Trace window illustrated below, click the Start button, point to 
Programs, point to your Reflection network software folder, point to Utilities, and then 
click Network Trace. 

Network Trace includes options for configuring a local or a remote network trace. 
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Interface
From the Interface  list, select the network interface whose traffic you want to capture. The 
Interface list shows the Ethernet interfaces configured on your PC. 

Trace Mode
You can choose from four different trace modes: 

· Local 
This mode captures all packets sent or received on your PC. 

· Remote Address 
This mode captures packets sent or received by another system or gateway on your local 
subnet. This mode therefore allows you to capture the specified system’s or gateway’s 
“view” of the network. You can specify the packet types you want to trace. 

· Between Remote Addresses 
This mode captures packets sent between two remote systems. You can perform traces 
that involve systems and gateways on your local subnet (including your own PC). However, 
you cannot perform a trace between two systems that are on a remote subnet, since the 
traffic between two systems on a remote subnet does not cross the router to your PC. You 
can specify the packet types you want to trace. 

· All Addresses 
This mode captures all packets sent and received on your local subnet. This mode therefore 
allows you to see all traffic on your local subnet. You can specify the packet types you want 
to trace. 

Remote Trace Filters
Remote trace filter options are available if you choose any trace mode except local trace. 

Packet Type
If you do not select (All), only the packet type that you specify is captured. You can use the 
Symbols command described on page 176 to assign commonly used packet types. Once a 
packet type is assigned to a symbol, you can you can select it from the Packet type list. 
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Machine Address 1
If you have chosen Remote Address or Between Remote Addresses as your Trace mode, type 
in the hardware address of the network card to be monitored. Alternatively, you can select a 
symbol from the list if you have used the Symbols command described on page 176 to assign 
symbols to commonly used addresses. 

If the system that you want to monitor is running the LAT networking protocol, you can display 
that system’s machine address by doing either of the following: 

· Right-click the LAT icon in the notification area at the end of the taskbar, then click About. 
Select Hardware addresses from the Information list. 

· Open the LAT Statistics utility and click Interface Counters on the Settings menu. The 
machine address is displayed as the header of the interface display. 

Machine Address 2
This option is available if you have chosen Between remote addresses as your Trace mode. 
Type in a machine address to capture any packets assigned to this destination. Alternatively, 
you can select a symbol from the list if you have used the Symbols command described on 
page 176 to assign symbols to commonly used addresses. 

You can confirm the destination’s machine address if you have a network connection to this 
destination. 

Trace Buffer
The packets that are captured are kept in a circular trace buffer. 

Size
This is the size (in kilobytes) of the trace buffer for the capture. You can enter a size from 16K to 
1024K. The default is 64K. 

Wrap When Full
If you select the Wrap when full check box, the oldest entries in the trace buffer are overwritten 
with new entries when the buffer is full. If the Wrap when full check box is cleared, the capture 
stops when the buffer is full. 
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Trace All Broadcasts and Multicasts
Select this check box if you want the trace to include all applicable broadcast and multicast 
packets. Broadcast packets are directed to all machines on the network, and multicast packets 
are directed to a set of machines on the network. To exclude all broadcasts and multicasts from 
the trace, clear the Trace all broadcasts and multicasts check box. Be sure you have selected the 
correct option for your trace before clicking the Start button. 

Setting Symbols
If you trace the same packet types or addresses often, you can assign symbols to make them 
available. Click Symbols on the Trace menu to see the dialog box illustrated below. 

Address Symbols
Any address symbols you have already defined are displayed. These symbols will be available as 
options for source address or destination address when you run a remote trace. Click Add to 
define a new address symbol. 
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Symbol
You can use any string that helps you recognize the address. 

Value
Type in the machine address you want to include in the selections for Destination or Source 
Address for a network trace. The address must follow the standard machine address format 
(00-00-00-00-00-00). 

Packet Type Symbols
Any packet type you have already defined is displayed here. Click Add to define another 
packet type. 

Symbol
You can use any string that helps you recognize the packet type. 

Value
Some common Ethernet packet types are: 

You cannot request Ethernet frames such as 802.2 HP or 802.2 SNAP by type. 

0800 DoD IP (TCP/IP standard) 

0806 ARP (for IP) 

6001 DEC MOP Dump/Load Assistance 

6002 DEC MOP Remote Console 

6004 DEC LAT 

8005 HP Probe 

8035 RARP (for IP) 

809B Kinetics Ethertalk (Appletalk over Ethernet) 

80D5 IBM SNA Services over Ethernet 

80F3 Kinetics, Appletalk ARP (AARP) 

8137 Novell NetWare IPX (ECONFIG E Option) 

8138 Novell 
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Using Trace
After specifying the type of trace and any additional parameters, click Start on the Trace menu 
to begin the trace. The message “Tracing” appears at the bottom of the dialog box. 

After you have captured the sequence you want to trace, click Stop on the Trace menu. The 
number of packets in the trace is reported at the bottom of the dialog box. To save this trace 
to a file, click Save As on the Trace menu. The default is a file with a .pkt extension in your 
Reflection\User\Cache folder. If you select a file name that already exists, you are given an 
opportunity to overwrite the file or to cancel the operation. 

The packets you have captured remain in memory until you exit the Trace utility or until you 
start another trace. If you choose to exit the Trace utility without saving the trace to a file, you 
are prompted to confirm that you do not want to save the trace. The captured packets are 
discarded after you exit the Trace utility. 

Interpreting the contents of the file requires the assistance of WRQ technical support or your 
authorized distributor.     
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Troubleshooting
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Troubleshooting Tools

The different troubleshooting tools described in this chapter may help you identify a problem 
that is preventing Reflection from working. In general, these tools narrow the range of software 
and hardware problems. 

Using the Troubleshooting Toolbar
The troubleshooting toolbar was developed by WRQ technical support to help you resolve 
problems with Reflection. This toolbar helps you: 

· Collect information about a problem with the help of the Information Gathering Assistant 
and send it to technical support for analysis by technicians.

· Receive helpful troubleshooting information from WRQ using the Technical Note Assistant.

· Download files from the WRQ technical support bulletin board system (BBS).

· Get updated troubleshooting tools from the WRQ technical support BBS.

· Perform an event trace to determine the cause of a problem. An event trace “captures” all 
communications activity (except modem commands), keystrokes, commands, and menu 
and dialog box selections to an event file. 

· Open Reflection online troubleshooting help.

The troubleshooting toolbar files are automatically installed during Setup to your Reflection 
User folder. However, the toolbar is not displayed by default. 

To view the troubleshooting toolbar, click Troubleshooting Toolbar on the Help menu.
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Reflection Tools
Unless you cleared the Utility and Support Files check box when performing a Custom instal-
lation during Setup, the utilities described next are in these folders: 

· Reflection for HP with NS/VT: Reflection\HP\Support 

· Reflection for UNIX and Digital and Reflection for ReGIS Graphics: Reflection\VT\Support 

Using Fileinfo to Identify File Types
Use Reflection’s Fileinfo utility to determine a file type when transferring files from your PC. 
This utility tells you: 

· If the file is Binary. (If the file used characters outside the ASCII set, or characters with a 
decimal value higher than 127, it is Binary.) 

· If an ASCII file contains a ^Z as an end-of-file indicator. 

Determining File Versions Using the About Box
When calling technical support at WRQ, you may be asked to give the version of a file, or 
module, in Reflection. To determine a file version in Reflection: 

1. Click About Reflection on the Help menu to open the About Reflection dialog box. This lets 
you view details on Reflection modules (and a variety of other topics you can select from the 
Information box). 

2. Select Modules (or Network Modules) from the Information box. 

3. Select the module and note the version number from the list that appears. 

4. Click OK to close the dialog box. Or, click Copy to send the information to the Windows 
Clipboard, then paste the information into a document to save it to a file or print it. 

Using the Paper Clip Test to Check Connections
Using a paper clip, you can determine if communications problems are occurring in your PC 
or elsewhere, such as in cabling or the host port configuration. Search for Paperclip test in the 
online help for information on how to do this.
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Windows 95, Windows 98,  and Windows NT 4.0 Tools
Windows 95, Windows 98, and Windows NT 4.0 provide several diagnostic tools you can use to 
locate conflicts and troubleshoot problems. These tools are located in the Control Panel folder. 
To open Control Panel: 

· From the Start menu, point to Settings and click Control Panel. The Control Panel folder 
opens. 

Using System to View Computer Status
The System utility, opened by double-clicking the System icon or folder, profiles your 
computer’s hardware and performance. In most cases, Windows 95, Windows 98, and Windows 
NT 4.0 are configured for optimal performance, and adjustments to settings such as Virtual 
Memory are not recommended. However, you can use the tabbed dialog boxes to change port 
and network settings. 

For example, open the System folder and click the Device Manager tab. Some of the devices you 
can configure from this panel include: 

· Network adapters—Open this folder to configure interrupts and I/O range for your installed 
network card. 

· Ports (COM & LPT)—Open this folder to determine port status, and configure drivers, settings, 
and resources available to your ports. 

· System devices—Open this folder to display a list of your installed hardware. Each device 
folder can be opened to see properties, such as drivers and current performance config-
uration. Anything marked with an exclamation mark (!) indicates a problem.

Using Network to View Network Settings
You can display your current network settings by double-clicking Network in the Control Panel 
folder. Use the Network dialog box to identify your computer to other computers on the 
network, configure network protocols, and control who has access to your computer. 
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General Troubleshooting

This chapter offers troubleshooting tips on a variety of areas. The topics are presented in alpha-
betical order. 

Display Problems
If you’re experiencing display problems in Reflection, refer to the topics below. 

Cannot See Line Drawing Characters
If you are having trouble displaying line drawing characters, try changing the Host character set 
(on the Emulation tab in the Terminal Setup dialog box) to either PC English (437) or PC Multi-
lingual (850). 

Colors Not Displaying Properly
If the correct color display is not selected, certain colors and shapes may appear to be white. For 
accurate ReGIS and sixel graphics emulation, a 256-color display is recommended. To set your 
display to 256 colors:

1. Right-click on your Windows desktop.

2. Click Properties.

3. In the Display Properties dialog box, click the Settings tab.

4. In the Color palette list, select 256 Colors.

5. Click OK to exit.
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Terminal Window Flashing When Inactive Window
If you are working in another application (even another instance of Reflection), and you notice 
that an inactive Reflection terminal window is flashing, this means your host connection was 
dropped or you set a printer timeout, and that time has expired and the printer has closed. 

To stop the flashing, make Reflection the active window. You’ll see the message “Your 
<connection type> connection has been terminated.” The cause of this problem may be that: 

· Your connection to the host has timed-out.

· Your network has gone down. 

· The cable connecting your PC to the network has been physically disconnected. 

· An error has occurred with your serial connection. 

After determining why your host connection was dropped, press n to resume the 
connection. 

To stop Reflection’s terminal window from flashing at a host disconnect:

1. On the Setup menu click View Settings.

2. From the Reflection settings list, highlight Flash Window on Disconnect.

Tip: To quickly select this setting, type Flash  in the Search box. à

3. In the Setting details box, click No.

4. Click OK to exit the View Settings dialog box.

5. Click Save on the File menu to save this change.
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Fonts
If you’re having trouble with display fonts in Reflection, refer to the solutions that follow. 

· You can copy any combination of text and line drawing characters from Reflection, and 
paste this to any application that supports RTF (Rich Text Format). If the line drawing 
characters are misaligned or jagged after pasting: 

1. On the Setup menu, click Display, then click the Fonts tab. 

2. Select r_ansi from the Font list. 

3. Click OK. 

Now, recopy and paste the text; the pasted line drawing characters using the default font will 
be properly aligned. 

· If you need the international fonts used when you select a character set from the Host 
character set box (on the Emulation tab in the Terminal Setup dialog box), you must first 
install them. This is explained in the Reflection User Guide. 

· You can change the Reflection display font to support international fonts you have installed. 
To perform a file transfer that includes these fonts, however, you must be running that 
language’s version of Windows (for example, Chinese Windows) for the fonts to transfer 
correctly. 
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Reflection Fonts not Found Error Message
If you receive the error message “Reflection fonts not found” when starting Reflection, it is 
possible that you either have too many fonts installed or you need to reinstall Reflection fonts. 

To solve the problem, do the following in the order described:

· Reduce the number of installed fonts:

1. Open Windows Control Panel, and double-click the Fonts icon.

2. Press c, and select each font to remove.

3. On the File menu, click Delete.

4. Exit Control Panel and restart Windows.

· Reinstall the Reflection fonts:

1. Run Reflection Setup with all applications closed, reinstalling to the same Reflection 
folder.

2. Choose the Custom installation option, and click Clear All.

3. Select the Application Files check box, and proceed with Setup.

4. When Setup is finished, click the Restart Windows button.

Problems with Soft Fonts
If you’re experiencing display problems when an OpenVMS host application downloads its “soft 
fonts,” execute the following command at the host prompt: 

· SET TERM/NOSOFTCHARACTERS 
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Keyboards and Keyboard Mapping
If you’re having trouble with your keyboard or with keyboard mapping, refer to the solutions 
that follow. 

· Do you have a keyboard attached to your PC that is not a US Enhanced 101-key keyboard? 
If so, choose the proper keyboard from the PC list (click the Keyboards button in the 
Keyboard Map Setup dialog box). 

· If you’re using Reflection for UNIX and Digital or Reflection for ReGIS Graphics and you 
don’t see the characters you expect when you type from the right half of the keyboard, turn 
off j. 

Multiple Connections
When the default settings file (for example, Settings.r2w) is found, it is loaded the first time 
you start Reflection. Each time thereafter, when you click New Session on the File menu, the 
Reflection product you select does not load the default settings file, and instead starts in a new 
Untitled terminal window. 

To load the default settings (or, for that matter, any other settings file): 

1. Click Open on the File menu. 

2. In the Open Settings dialog box, highlight the name of the settings file you want to load. 

3. Select the New window check box. 

4. Click the Open button. 
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Printing
If you’re having trouble printing (either output is not printing at all or the printout is 
garbled), follow these steps in the order presented to troubleshoot printing from Reflection. 
After completing a step, try printing and see if your printing problem is fixed. 

· Prevent Windows from handling fonts, font size, font style, and characters by selecting the 
Bypass Windows print driver check box in the Print Setup dialog box; this solves many 
printing problems. For example, do this if you’re receiving the message “Error writing 
to printer.”

· If this doesn’t solve your problem, clear the Bypass Windows print driver check box and 
continue with the next step. 

· Open the File menu; is the Close Printer command available (that is, not dimmed)? If so, 
click it now to close the printer. 

· Press a+Y to open the Reflection command window, type some text, and click Print on the 
File menu. If this works, then the problem is with a Reflection setting in either the Print 
Setup or Page Layout dialog box. 

· Select the Bypass Windows print driver check box in the Print Setup dialog box. Then try 
printing characters in the character set exactly as they come from the host by selecting the 
Disable printer translation check box. 

· If this doesn’t solve your problem, clear the Disable printer translation check box and 
continue with the next step. 

· Try directing printed output to a disk file (explained in the Reflection User Guide). If this 
works, then the problem is either with a Windows print parameter or your physical printer; 
continue with the steps below. 



 

  General Troubleshooting 191
If your printing problem is still not solved, check how Windows is configured to print: 

· Open a file in Windows WordPad and click Print on the File menu; does the output print? If 
so, click the Print Setup button and see what printer you have assigned, then verify this is the 
same printer selected in Reflection’s Print Setup dialog box. 

· Do you have the correct default printer specified under Windows? Open the Print Setup 
dialog box and see what printer is selected. 

· Try printing to a generic or text-only printer, by assigning a Generic/Text Only printer 
under Windows (this option will not work with serially connected printers, such as COM1 
and COM2). In Reflection’s Print Setup dialog box, select this printer type and see if you 
can print. 

If you’re still having trouble, check the physical aspects of your printer: 

· Is the printer online? (The word “online,” or a light, should appear on your printer.) 

· Try pressing the Self Test button (or an equivalent button combination) found on the front 
panel of most printers. If this does not produce a test page, there is something wrong with 
your printer hardware. 

· Can other users print to the same printer? If so, check how they are configured for this 
printer under Windows. 

· If you’re printing over a network, check the network print queue. Is your job “stuck” behind 
someone else’s that is holding up the print queue? 

· If you’re connected serially (click Connection Setup on the Connection menu, and see if 
you’re connected over COM1—COM4), make sure the baud rate specified under Windows 
matches that of your printer. 

If you still cannot print, perform an event trace as explained on page 199. 
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Registry
When Setup installs Reflection, it writes information to the Windows registry, a central database 
of PC resources. Because the registry consolidates Reflection information into a single database, 
it is easy to access and reconfigure, even across a network. 

Before the registry on each networked PC can be remotely administered, the proper security and 
remote access requirements must be configured. Once this is done, a system administrator can 
use the Win32-based registry APIs through Remote Procedure Call (RPC) to access and recon-
figure a PC’s registry. This is useful whenever network management mechanisms, such as Simple 
Network Management Protocol (SNMP), are used by a company to provide uniform changes 
across a wide base of users. 

For a detailed explanation, see your Windows documentation. 
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Resetting Reflection

This chapter describes the different methods you can use to reset Reflection’s default values, 
and different commands you can choose when Reflection appears to be “stuck.”

Restoring Reflection’s Default Settings
Reflection offers many methods for restoring default settings: 

· If you need to restore Reflection’s factory default settings, click Defaults on the Setup menu. 
If you have an active connection, the Defaults command is dimmed—instead click New 
Session on the File menu. This starts another copy of Reflection with a new, untitled 
terminal window and the default factory settings. 

Note: If you have your users running a site defaults settings file, then the default settings in 
Reflection may not match those listed in the online help. The only way to get back to factory 
defaults is to remove the site default file using the Profiler. à

· Most Reflection dialog boxes have a Defaults button; click it to restore the default dialog 
box values. 

When you click the Defaults button in a tab dialog box, Reflection asks if you want to reset 
the default values on the active panel, or to reset the defaults. Clicking the Defaults button in 
the Toolbar Setup dialog box restores the default toolbar at the top of the terminal window, 
in addition to resetting the values in the dialog box. 

Reset Commands in Reflection for HP with NS/VT
This information applies only to Reflection for HP with NS/VT. 

If users call you, as a system administrator, because Reflection for HP with NS/VT appears to be 
“stuck,” see if instructing them to select one of the Reset commands on the Connection menu 
won’t solve the problem. 
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Recall User Keys
Recalls the set of user keys from the current settings file. User keys are configured on the Function 
Keys tab in the Terminal Setup dialog box. 

A user might accidentally overwrite preconfigured user keys when, as an example, a host appli-
cation is active with application-specific user key labels showing and the user clicks Save on the 
File menu. 

Clear Typeahead 
The Clear Typeahead command clears buffered keystrokes. Typeahead allows you to type ahead 
of the HP 3000. To enable typeahead: 

1. On the Setup menu, click Terminal, then click the Keyboard tab. 

2. Select the Typeahead check box. 

3. Click OK. 

When typeahead is enabled, Reflection buffers each line of keystrokes until it sees a 
DC1, 

indicating the HP 3000 is ready to receive. If you type ahead of the HP 3000 and then decide not 
to transmit the buffered keystrokes, clear the typeahead buffer by selecting this command. After 
clearing the buffer, you can continue to type ahead of the host. 

There are other situations where it is necessary to clear Reflection’s typeahead buffer. You may 
need to do this because: 

· You have logged off the host system but continue to type. 

· The HP 3000 does not respond with a host prompt after you log on and press n. 

· The MPE SPEED command is used to changed the baud rate. 

· Reflection never received a 
DC1 character from the host because it either got lost or garbled 

in transmission. 
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Soft Reset  
A soft reset does the following: 

· Beeps. 

· Unlocks the keyboard (if it was locked). 

· Turns off display functions (if they were on). 

· Initializes the serial communications ports to the last activated values, and clears the 
receive buffer. 

· Resets typeahead and clears the keyboard buffer. 

· Transmits an XON if the Receive option is set to Xon/Xoff in the Pacing group box. 

· Terminates an executing Reflection macro, or a Reflection Basic or Reflection command 
language script. 

Hard Reset
A hard reset does everything that a soft reset does, plus the following: 

· Terminates an executing Reflection macro, or a Reflection Basic or Reflection command 
language script. 

· Homes the cursor and clears display memory. 

· Resets the margins to their default values, and clears all tab stops. 

· Sets all configuration parameters that were set (typically by the host) with escape sequences* 
to their last activated values. 

· Sets the function key labels to the value specified in the Function key set list (on the 
Function Keys tab in the Terminal Setup dialog box). By default, this displays the user keys. 

· Sets the user keys to their last saved values. 

· Turns off Í, SMOOTH SCROLL, and Î, MEMORY LOCK, from the modes keys. 

* When an item is configured with an escape sequence, it is considered to be volatile and can be changed 
with a hard reset. Setting a value in a dialog box is considered to be non-volatile; it cannot be changed with 
a hard reset. 
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· Turns off the following modes: 

– Format mode (which is enabled with the sequence 
ESCW) 

– Insert character mode 

– Caps lock mode 

· Turns off any active logging mode. 

· Clears the printer buffer and sends a reset command to the printer. 

Hard reset does not change the following modes keys: 

Ê, MODIFY ALL 

Ë, BLOCK MODE 

Ì, REMOTE MODE 

Ð, AUTO LF 

Reset Commands in Reflection for UNIX and Digital and 
Reflection for ReGIS Graphics

This section applies only to Reflection for UNIX and Digital and Reflection for ReGIS Graphics.

If users call you, as a system administrator, because Reflection appears to be “stuck,” see if 
instructing them to select one of the Reset commands on the Connection menu won’t solve 
the problem. 

Clear Communications
When you click Clear Communications on the Connection-Reset cascading menu, the 
following happens: 

· Printing operations, escape sequences, control functions, and device control strings are 
canceled. See the Terminal Reference manual for more information on these topics. 

· If enabled, logging is turned off. 
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· Receive, transmit, and keyboard buffers are cleared, and the keyboard is unlocked. 

· XOFF (
DC3) signals from the host are reset. 

· For all connections except VT-MGR, an XON (
DC1) signal is sent to the host. 

This command can often remedy communications problems when the host connection appears 
to be “stuck.” Clear Communications does not disconnect you from the host computer. 

Terminal
When you click Terminal on the Connection-Reset cascading menu, the following items are 
reset to their factory default values—this is also known as a soft reset: 

Terminal Feature Value after Reset 

Active display Main display 

Autowrap pending Cancel pending autowrap 

Character sets Default sets 

Cursor keys Normal 

Insert/replace Replace 

Keyboard action Unlocked 

Numeric keypad Numeric characters 

Origin Absolute 

Saved cursor state Home position 

Select graphic rendition Normal rendition 

Selective erase Normal attribute 

Text cursor enable Cursor enabled 

Top/bottom margins Top/bottom of display 

UPSS Last saved value 

Use NRC characters No 



198 Resetting Reflection
In addition, the Terminal command: 

· Initializes the communications port for serial connections to the last activated values, and 
clears the receive buffer. 

· Terminates an executing Reflection macro, or a Reflection Basic or Reflection command 
language script. 

Note: This command does not cancel a Wait  method; you must use the Recall Last Setup 
command (explained next). à

Recall Last Setup
Click Recall Last Setup on the Connection-Reset cascading menu to restore Reflection’s terminal 
settings, for the active connection only, to their last saved values—this is also known as a hard 
reset. Settings specific to Reflection, such as file transfer parameters, preferences, and printer 
options, are not reset. A hard reset is like reloading the terminal settings from your most recent 
settings file before any changes were saved. This is how to “undo” any actions a user has done. 

In addition to recalling the last saved settings, this command also does the following: 

· Clears the display and places the cursor in the upper-left corner. 

· Sets the select graphic rendition (SGR) function to normal. 

· Sets the selective erase attribute (DECSCA) to erasable. 

· Clears the user-defined keys. 

· Selects the default character sets: ASCII in the graphic left (GL) table and user-preferred 
supplemental set in the graphic right (GR) table. 

· Terminates an executing Reflection macro, or a Reflection Basic or Reflection command 
language script. 

· Cancels a pending Reflection Basic Wait  method. 

· Disconnects from the active connection. 

See the Reflection Terminal Reference manual for information on the DEC mnemonics (such as 
SGR) referenced here.
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Performing an Event Trace

One way to determine the cause of a problem is through an event trace. The troubleshooting 
toolbar has an event trace function that lets you start, stop, and process an event trace. The 
troubleshooting toolbar also provides connection statistics (for serial-based connections only). 

An event trace “captures” all communications activity, keystrokes, commands, and menu 
and dialog box selections to an event file on disk. Using the troubleshooting toolbar, you can 
then send the event file to Reflection technical support, along with a report, for help in solving 
the problem.

Note: If you are using a Reflection suite and suspect that your problem is related to your LAT 
networking software, use the Network Trace utility described on page 173. à

To perform an event trace:

1. Click Troubleshooting Toolbar on the Help menu.

2. Click the Start Trace button on the troubleshooting toolbar (at the bottom of the terminal 
window) to open the Save Trace Events dialog box.

3. Change to the Reflection User folder and enter an event trace report file name or accept the 
proposed name.

4. Click Save. If a file by that name already exists, Reflection asks if you want to overwrite 
the file. 

When event tracing is on, a bug icon appears in the Reflection status bar. 

5. Do whatever actions are required to demonstrate the problem. 

6. As soon as the problem has been demonstrated, click Stop Trace on the troubleshooting 
toolbar.
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Creating an Event Trace Report
Once you have captured the events leading up to a problem, you can print a report of the event 
trace to either a printer or a disk file. This is not the version of the trace file you need to send to 
a WRQ technician for analysis as explained above; the event trace report is in ASCII format (as 
opposed to binary) so you can study it and perhaps resolve the problem yourself. 

To print an event trace report: 

Caution:  â Event traces are not backward-compatible. If you have an event trace captured by an earlier 
version of Reflection, you must use that earlier version to process the trace. à

1. Click the Process Trace button on the troubleshooting toolbar.

2. Select Printer as the Destination option. 

3. Click OK.

4. In the Open Events dialog box, select the event trace file and click Open to print the report. 
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Solving Communications Problems

This chapter provides solutions to some common host communications problems. You can also 
create a disk file that records the events leading to the problem. This is known as an event trace 
and is explained on page 199. 

No Response from Host
If nothing is echoed on the screen when you type characters while connected to the host, consult 
the following list: 

· Is the physical connection correct? If possible, verify this by connecting a terminal to the 
host with the same cable you use to connect the PC (using a gender changer is usually 
necessary due to the male serial port on the PC). If the terminal works, you can assume that 
the physical connection is correct. If not, see the cable diagrams located in the Reflection 
User Guide. Ensure that the cable and gender changer (if used) both have straight-through 
pin connections (for example, 2–2 and 3–3). 

· Try connecting to the host using HyperTerminal, the emulator included with Microsoft 
Windows. If you cannot get a host response using HyperTerminal, then the problem is 
related to the PC or host configuration, or your physical cabling. 

If you can get a host response using HyperTerminal, the problem is probably that an invalid 
configuration setting is preventing Reflection from communicating with the host. Start by 
configuring Reflection with the factory defaults (click New Session on the File menu), and 
then make sure you select the correct connection type. 

· Is Reflection in remote mode, and able to communicate with the host? Make sure the Online 
check box (on the Emulation tab in the Terminal Setup dialog box) is selected; otherwise, 
Reflection does not transmit anything to the host. 
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· Check your host connection in the Connection Setup dialog box. You may be using the 
wrong COM port as a connection type. If this is the case, click Disconnect on the Connection 
menu, then click Connection Setup and try again. 

· Check the communication parameters in the Connection Setup dialog box. For example, 
make sure you’ve selected the correct Baud rate. 

If none of the above solutions solved your problem and you still do not see any characters on 
your screen, try the paperclip test, described in the online help. (Search for Paperclip test in the 
online help index.) If the characters appear on the screen during the paper clip test and do not 
appear without it, then the PC can successfully send and receive characters. The problem lies 
outside of the PC—the cable may be the wrong kind or the host port may be bad. 

Checking Serial Ports
If you have more than one serial port in your PC, find out if the boards are set up according to 
the documentation supplied with them. You may have to open your PC and look at how they are 
set up. There are usually two jumper wires on these boards that can be adjusted to make a serial 
port function as COM1–COM4. (PS/2 serial boards are not configurable.) Problems occur if 
boards have conflicting configurations. Check the following: 

· The IRQ line. Check the setting on the boards for the jumper that sets the interrupt request 
line. See the information below for the default IRQ line each COM port uses and how to 
configure the IRQ for a different line. 

· The I/O port. Check the setting on the boards for the jumper that sets the I/O port address. 

Refer to the documentation supplied with the boards to determine how to configure them 
correctly. 

Note: Simple communications programs that use polling may work even if the IRQ line is incor-
rectly configured. However, Reflection is interrupt driven and does not work unless the IRQ and 
I/O ports are correctly configured. à
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Changing the IRQ
Changing the setting for your IRQ line only applies to AT-class machines. The IRQ and I/O base 
address are not configurable for PS/2 serial ports. 

Reflection uses the IRQ values specified in the System.ini file. If you are using the default values, 
these correspond to the following IRQ settings: 

If either the IRQ or the I/O base address differs from the default, you can easily change the IRQ 
in Windows by modifying the values under Windows (see the Windows documentation for 
instructions on how to do this). 

Transmit Pacing Problems
If Reflection transmits data as fast as it can, the host computer may not be able to keep pace. If 
this happens, use one of the following methods to control the speed of transmission: 

· If the host uses XON/XOFF pacing to control transmission speed, make sure Transmit 
pacing is set to Xon/Xoff in the More Settings–Serial Port dialog box. 

· Enter a value in the Char transmit delay box in the More Settings–Serial Port dialog box. 
This causes Reflection to wait the specified time between the characters it transmits. A delay 
of 1–3 milliseconds should be sufficient for most systems. 

· If the host computer does not use a prompt character, you may have to specify a time delay 
after each line transmission in the More Settings–Serial Port dialog box. 

Port IRQ I/O Base Address

COM1 04 03F8h

COM2 03 02F8h

COM3 04 03E8h 

COM4 03 02E8h
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Serial Connection Statistics
If you’re connecting serially, Reflection records any data communications statistics that may 
occur (if your connection is over any other type of network, connection statistics are not 
available). 

To view these statistics:

1. Click Troubleshooting Toolbar on the Help menu to open the troubleshooting toolbar.

2. Click the Serial Connection Statistics button on the troubleshooting toolbar to open the 
following dialog box: 

If any of the fields have non-zero values, refer to the explanations below. When you’re through, 
click Close to continue using Reflection. To clear any errors, click Reset (when you exit 
Reflection, the values are automatically reset to 0). 

Analyzing Datacomm Errors
Any fields in the Serial Connection Statistics dialog box that are non-zero indicate some problem 
in data reception. Whenever the data communications hardware detects an error, Reflection 
increments a counter. 

Receiver Overruns
Each time the host computer transmits a character, the data communications hardware notifies 
the processor, saying, in effect, “I just received a character.” Reflection must read that character 
before another character is received; if it doesn’t, a receiver overrun error occurs. 

Receiver overruns occur for the following reason: the serial port typically has a 16450 UART,* 
which only has a one-character buffer. Reflection needs to be notified by the CPU before the next 
character arrives. With a one-character buffer, this results in a lot of receiver overruns. 
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To prevent receiver overruns: 

· You can purchase an updated UART chip. 

· You can change the stacks statement in your Config.sys file to the following: 

STACKS=0,0 

· If you have a PC speaker driver installed under Windows and experience receiver overruns, 
set the Terminal Sound setting (available in the View Settings dialog box) to Simple. 

If this solves your problem, save your settings file. 

Parity Errors
Parity errors are much more likely to occur with a modem connection than with a direct 
connection. To correct parity errors, make sure your PC matches the parity of the host or inter-
mediary system. 

Framing Errors
Framing errors often indicate that the baud rate is incorrect; change the rate in the Connection 
Setup dialog box. A bad cable or one that is too long can also cause framing errors; try replacing 
the cable to fix this problem. A framing error (a square symbol on the screen) may also indicate 
that the UART received a character with the wrong number of stop bits. If you’re consistently 
getting these errors, you may have specified the wrong number of stop bits when you configured 
the remote port. Most systems use one start bit and one stop bit, but two stop bits are often used 
when transmitting at 110 baud. 

Receive Buffer Overflow
Reflection has a buffer; characters received from the host computer are held there until they can 
be processed. If Reflection cannot keep up with the incoming data, the buffer fills up and this 
field is incremented by one. If this happens, set Receive pacing (click the More Settings button 
on the Connection Setup dialog box) to Xon/Xoff. 

* UART stands for Universal Asynchronous Receiver/Transmitter. This device receives and transmits data asynchro-
nously and checks incoming data for errors. It is capable of halting transmission when certain events occur, such as 
the receipt of a character or line error. A common UART is the INS 8250. 
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Break Detect
Whenever the UART detects a break (a 200 millisecond signal), this field is incremented by one. 
Your communications line is probably noisy and the signal is being interrupted; try connecting 
to the host (or re-dialing the modem). 

Modem Communications Problems
One of the more common problems when using a modem is that you’re able to dial out success-
fully (for example, to a host or bulletin board), but pressing n does not result in a host or 
login prompt. Reflection receives its default baud rate from Windows. To confirm this: 

1. Click the Start menu, point to Settings, then click Control Panel. 

2. In the Control Panel, double-click the Modems icon.

3. On the General tab, click Properties.

4. Note the value listed in the Maximum speed box. Click OK to exit.

5. In Reflection, click Connection Setup on the Connection menu to open the Connection 
Setup dialog box. 

6. Click More Settings. Confirm that the value you noted in step 4 is the value in the Baud rate  
list. If it isn’t, select Default as the Baud rate. 

7. Click OK to exit. 

If you can now connect, click Save on the File menu to save your settings file. 

Monitoring the Modem’s 232 Line
If you want Reflection to indicate the state of one of the modem’s RS-232 lines so that you can 
troubleshoot the connection: 

1. On the Setup menu, click Display, then click the Options tab. 
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2. Select a value from the Connection indicator list: CTS, DSR, or DCD. 

This specifies which connection status line you want to have monitored. If the selected line 
(pin) is in a true state, an indicator is shown in Reflection’s status bar. 

3. Click OK. 

Some modems can be configured to force these lines to a true state, in which case the indicator 
has little meaning. Hayes Smartmodem factory settings cause it to always set the data carrier 
detect (DCD) signal to a true state. 

Using the Modem’s Indicator Lights
If you are using an external modem to connect to the host, there are probably some indicator 
lights on the modem that can help diagnose problems you may be having: 

· Is there an indicator marked SD (send data) or TD (transmit data)? This light should flash 
whenever you press a key. 

· Is there an indicator marked RD (receive data)? If it flashes after you key a character, it 
means that an echo is coming back from the modem. 

If the SD light flashes but the RD light does not, then the problem probably lies with the 
modem. It could also mean that the host computer is not echoing, either because it is not 
accepting input, or because it is operating in half-duplex mode. Select the Local echo check 
box (on the Keyboard panel in the Terminal Setup dialog box) if your host operates in half-
duplex mode. 

If you need help entering modem commands, see below. 

Modem Command Summary
The command summary on the following pages can be used with a standard modem. Your 
modem manual will have more detail about these commands: they are listed here for your 
convenience and should not be confused with Reflection commands. Not all modems support 
these commands; see your modem manual to find out which ones are valid for you. 

The rules for entering modem commands are as follows: 

· If a command accepts a parameter and you do not enter one, the modem assumes a zero 
(Ø) value. 
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· The length of the command cannot exceed 40 characters (spaces are not counted) for most 
modems: the initial “AT” and the ending CR are not counted. You can use optional hyphens 
and parentheses when you enter a telephone number, however, they are counted as 
characters. 

· The maximum number of digits you can dial in a single command is 38. 

· Pressing n executes each of the commands in the following table, with the exception 
of +++ . 

· Each command line must start with AT. Commands may be concatenated together, for 
example: 

ATE1 Turns echo on 

AT&W Stores status registers 

ATE1&W Turns echo on and stores status registers

Command Parameter Description 

+++ <none> Escape from online to the OK prompt; pause one 
second before typing and do not follow with a 
carriage return 

A/ <none> Repeat previous command 

AT <none> Attention 

ATA <none> Manually answer incoming call (force answer mode) 

ATB<n> <n>=Ø
<n>=1 

CCITT V.22 (international) 
Initiate calls using Bell 103/212a at 1200 baud 

AT&C<n> <n>=Ø
<n>=1 

DCD always high 
DCD follows carrier detect

ATD<number> <none> Dial <number>  using tone dial; <number>  can 
include special characters (/ , ; ! ), explained on  
page 211 

ATDP<number> <none> Dial <number>  using pulse dial; <number>  can 
include special characters, explained on page 211  

ATDS <none> Dial previously stored number 
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ATDT<number> <none> Dial <number>  using tone dial; <number>  can 
include special characters, explained on page 211

AT&D2 <none> Enable disconnect 

ATE<n> <n>=Ø
<n>=1 

No echo in command mode
Echo enabled 

AT&F <none> Reset modem to factory defaults 

AT&G<n> <n>=Ø 
<n>=1 
<n>=2 

Guard tone off 
Guard tone, 550 hertz on 
Guard tone, 1800 hertz on

ATH<n> <n>=Ø
<n>=1 

Hang up, immediate (go on-hook) 
Pick up (go off-hook) 

ATI<n> <n>=Ø
<n>=1 
<n>=4 

Request product code 
Request checksum 
Display registers 

ATL<n> <n>=1 
<n>=2 
<n>=3 

Speaker volume low 
Speaker volume medium 
Speaker volume high 

AT&L1 <none> Leased line operation 

AT&K<n> <n>=Ø
<n>=1 or 3

<n>=2 or 4
<n>=5 

Disable local flow control
Enable RTS/CTS local flow control (hardware 
handshaking)
Enable XON/XOFF local flow control 
Enable transparent XON/XOFF local flow control

ATM<n> <n>=Ø 
<n>=1 
<n>=2 
<n>=3 

Speaker always off 
Speaker on until carrier is detected 
Speaker always on 
Speaker on during carrier detect 

ATO<n> <n>=Ø
<n>=1 

Return online 
Return online and retrain (2400 baud) 

AT&P<n> <n>=Ø
<n>=1

Set dialing mode to pulse (rotary), U.S. timing 
Set dialing mode to pulse (rotary), U.K. timing

Command Parameter Description 
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ATQ<n> <n>=Ø
<n>=1

Send result codes
Do not send result codes 

ATS<n>? <none> Status check of register <n>  

ATS<r>=<n> <n>=Ø-16 Set register <r>  to <n>; see the table on page 211 

AT&S<n> <n>=Ø
<n>=1 

<n>=2 

DSR always on 
DSR per V.22bis (RS-232 specification); assert DSR 
signal before handshake only 
Assert DSR after negotiation, but before CONNECT 

nnnn  result code is sent to the Data Terminal 
Equipment (DTE)

AT&T<n> <n>=Ø
<n>=1-8

Exit test mode
Enter test mode 

ATV<n> <n>=Ø 
<n>=1

Result codes as digits 
Result codes in words

ATW <none> Wait for dial tone 

AT&W <none> Store status registers 

ATX<n> <n>=Ø   

<n>=1 
<n>=2 

<n>=3

<n>=4 

Give results indicating connection, no carrier, and 
ring detection 
Give result codes indicating connection speed 
Give result codes indicating connection speed and 
dial tone detection 
Give result codes indicating connection speed 
and busy signal detection 
Give result codes indicating connection speed, dial 
tone, and busy signal detection 

ATY<n> <n>=Ø
<n>=1 

Ignore breaks; long space disconnect disabled 
Enable breaks; long space disconnect enabled

ATZ <none> Reset (“zap”) modem to power-on values 

AT&Z<number> <none> Store telephone number; <number> can include 
special characters, explained next

Command Parameter Description 
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The commands used as the <number>  parameter with ATD and AT&Z are shown in the 
following table:

ATD and AT&Z Special Character Commands

The command ATS<r>=<n>  sets register <r>  to <n>. Use ATS<r>? to display the contents 
of register <r> . The table below lists the possible values of <r> :

Command Description 

/ 125-millisecond pause in dialing 

, 2-second pause in dialing 

; Return to command mode 

! Flash (on-hook, off-hook) for one-half second 

<r> Description 

0 Auto answer, number of rings 

1 Count number of rings 

2 Escape code character (<n> is a decimal ASCII value) 

3 Carriage return character (<n> is a decimal ASCII 
value) 

4 Linefeed character (<n> is a decimal ASCII value) 

5 Backspace character (<n> is a decimal ASCII value) 

6 Wait time before dialing 

7 Wait time for carrier detect 

8 Duration of pause while dialing 

9 Carrier response time (<n> is the amount of time) 

10 Wait time before disconnect 

12 Escape guard time (<n> is the amount of time) 

14 Option register status 
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Examples of Modem Commands
ATD<number1>W<number2> 

Dial <number1> , wait for a secondary dial tone, and then dial <number2> . 

ATS0=1

Enable the modem to answer on the first ring. 

ATS0=0

Disable modem answer. 

ATDT1,P(800)555-1212

Tone dial 1, pause, then pulse dial the remainder of the number. 

16 Self-test register 

18 Self-test timer value 

21 Option register 

22 Option register 

23 Option register 

25 DTR delay value 

27 Option register 

<r> Description 
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WRQ Event Viewer

WRQ network protocols and many WRQ applications log events to the WRQ Event Viewer. By 
default, events are logged to an event log file, Rnevent.rel, in your Windows directory. The WRQ 
Event Viewer gives system administrators a troubleshooting tool for viewing these events and 
configuring event log settings. 

The event log stores events from a variety of Reflection software modules. Your list of choices 
depends on the WRQ products you installed—each product has one or more components. 

You can configure the size of the event log and the types of events you want to log. Fatal 
errors are always logged. The Rnevent.dll module records events and Rnlog.exe allows you 
to view them.

Fatal Errors and the Event Log
The event log can be configured to record events for a variety of severity levels and for a subset of 
Reflection software modules. Fatal errors, however, are always logged: these errors may indicate 
that a Reflection module has failed to load. 

If one of these events occurs, you’ll see a dialog box that indicates that the Reflection soft-
ware module failed to load and allows you to look at the events in the event log associated 
with this error. 
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Using the WRQ Network Event Viewer
When you open the WRQ Event Viewer it displays the currently configured log file: 

Some event log messages are longer than will fit in the message area in the upper part of the 
log. To see the rest of the message, select the message and the full text will appear in the lower 
window.

Type The five message types are Debug, Information, Warning, Error, and Fatal. 

By default, the WRQ Event Viewer logs Information, Warning, Error, and Fatal 
messages. See page 216 for information about configuring which events are logged. 

Date This is the date of the event. 
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Configuring Log Settings
Click Log Settings on the File menu to choose the events you want to capture. The event sources 
you see in the list depend on the Reflection product you have installed and the options you chose 
during Setup. 

After capturing the events, you can choose what portion of them you want to view by clicking 
Filter on the View menu. 

Event Sources
Click Select All to have events for all installed modules logged. Otherwise, select the check box 
for each module that should have events recorded in the log file. The Event sources available will 
depend upon the WRQ products you have installed.

Time This is the time of the event. By default, the most recent event is listed first, but you 
can configure the WRQ Event Viewer to list events with the oldest event first. 

Source This is the module that produced the event. 

Data This is the transaction message. 
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Event Type
You can select any combination of the following event types: 

Debug 
Information 
Warning 
Error 

By default all event types except Debug are logged. Fatal messages are always logged. Don’t 
enable Debug unless you are troubleshooting—logging debug messages has a significant 
impact on your machine’s performance. 

Event Buffer Size
Use this setting to specify the size limit of the event log buffer. Once the limit is reached, newly 
logged events overwrite the oldest events. Events are periodically saved to disk. If you have suffi-
cient memory and want to minimize disk activity, set this size higher. If you have limited 
Windows memory, lower this size. 

WRQ Event Viewer Options
When you start the WRQ Event Viewer, it automatically opens the event log file for your PC, 
Rnevent.rel, which is located in your Windows root directory. The WRQ Event Viewer updates 
this binary file when Reflection software events occur. 

In addition to selecting the event sources and types you want to log, you can configure the 
following WRQ Event Viewer options:

· You can use the WRQ Event Viewer to view event log files other than the default Rnevent.rel. 
On the File menu, click Open to locate and open the event log file you want to see. You can 
use this option to examine event logs from other PCs. In order for the WRQ Event Viewer to 
open a log file, it must be in the original binary format. 

· You can create an ASCII version of the current event log information. The default extension 
is .txt. You will not be able to view the ASCII file in the WRQ Event Viewer, but can read it 
in any text editor (such as Notepad). 
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· By default, the event log displays the most recent events first. To display the oldest events 
first, click Sort by Oldest on the View menu. 

· The upper portion of the WRQ Event Viewer provides a one-line view of each event; the 
lower portion provides a larger display area for the selected event. To change the size of 
these panes, click Split on the View menu, then click the location for the new window 
division. You can also position the cursor on the divider and drag it to a new position. 

· By default, the WRQ Event Viewer updates the log file display as it records new events. You 
can disable this option by clicking Auto Refresh on the View menu. If you disable Auto 
Refresh, you will only see new events when you click Refresh to refresh the display manually.

Filtering Event Log Messages
You can independently configure which events to log, and which events in an existing log you 
want the WRQ Event Viewer to display. 

The filter options, accessible on the View menu, let you select which events in the log file you 
want to display in the WRQ Event Viewer. This is not the location where you determine which 
events are actually logged—use Log Settings on the File menu to determine which events are 
written to the log. You can configure WRQ Event Viewer filters to show all types of events from 
all of the event sources that you chose to log, or you can display a subset of these. The selection 
procedure is similar to that in the Log Settings dialog box. 

Except for fatal events, all the event levels you can select for logging are available for filtering. By 
default, the WRQ Event Viewer displays information, warning, error, and fatal events. For 
example, if you only want to see error and warning messages, clear all the other options. The 
other events are still written to the log; to see a different set of events, change your filter options.  
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Contacting Reflection Technical Support

WRQ strives to provide the best possible technical support for all of its products. To receive 
technical support, you must be a registered user of WRQ products. Complete the registration 
card and send it to our USA or European address. 

Technical Support Options
When you have a problem that you cannot resolve with our online help and manuals, WRQ 
offers several options for technical support: 

· Request Technical Notes through a 24-hour automated fax request line: call 206.216.2680. 
Select from a wide range of available topics. 

· In the USA, use your modem to dial into WRQ’s bulletin board system (BBS) by calling 
206.217.0145.

· You can also connect to the WRQ BBS over the Internet: Telnet to bbs.wrq.com . The 
anonymous FTP server address is ftp.wrq.com . 

· Leave a message for WRQ technical support via the Internet at support@wrq.com . 

· You can view WRQ’s World Wide Web Technical Support site at http://support.wrq.com. 
The site contains technical notes, tutorials, access to other WRQ online services, and links to 
other technical resources available on the Internet. 

· One way for WRQ technical support to determine the cause of a problem is through an 
event trace. The troubleshooting toolbar lets you start, stop, and process an event trace. 
This records all communications activity, keystrokes, commands, and menu and dialog box 
selections to an event file on disk. For an explanation of how to perform an event trace, see 
Chapter 26 starting on page 199. 

· If you have questions or comments on the documentation (either the printed manuals or 
the online help), send them via the Internet to docs@wrq.com . 
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Technical Support by Telephone
If you prefer to speak with a WRQ support technician, call the technical support team. When 
you call: 

· Be seated at your computer. If you cannot be at your computer, have the appropriate system 
files available to you, such as your Autoexec.bat file or any initialization (.ini) files.

· Have your product version number ready. Click About Reflection on the Help menu to 
display the version number. 

· If appropriate, know your Internet address. 

· Be able to answer questions about your hardware and software. What kind of processor does 
your PC have? What version of Windows are you using? 

· Be familiar with how you are connected to the host. Are you using a direct serial connection 
or a modem? What baud rate and parity are you using? Are you connecting over a network? 
What kind of network are you on? 

· Know what kind of host computer you are using, which operating system your host is 
running, and the name of the host application in which the problem occurs. 



 

  Contacting Reflection Technical Support 223
For Telephone Support in the USA
In the USA, telephone support hours are from 5AM to 5PM Pacific time, Monday through Friday. 
Call WRQ technical support at 206.217.7000. 

If you prefer to send a fax describing the problem, the technical support fax number is 
206.217.9492. In your fax, provide the information requested above. 

For Telephone Support Outside the USA
For support outside the USA, contact an authorized Reflection distributor. If you need the name 
of a distributor, call WRQ for information: 

· In Europe, call +31.70.375.11.00 for the name of the distributor nearest you. The corre-
sponding fax number is +31.70.356.12.44. 

· In Asia, call +65.336.3122 for the name of the distributor nearest you. The corresponding 
fax number is +65.336.5233. 

· In other countries, call WRQ at +1.206.217.7100 (USA) and ask for the International 
Department. Or fax +1.206.217.0293. 
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Electronic Technical Support Options
WRQ is here to answer your questions online, by fax, or by telephone: 
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Escape Sequences and Control Functions

An escape sequence (Reflection for HP with NS/VT) or control function (Reflection for UNIX 
and Digital and Reflection for ReGIS Graphics) is a command sent to a terminal to perform an 
operation. Typically, escape sequences and control functions are sent to Reflection from a host 
program, but they can also be entered from the keyboard. For example, these functions can 
make Reflection do such things as move the cursor, add a line of text, assign display enhance-
ments, and change character sets. 

All escape sequences begin with the ASCII escape character (decimal 27) and control functions 
begin with the CS1 7-bit equivalent ESC-[. 

When coding escape sequences and control functions, take care to distinguish between uppercase 
and lowercase characters; in general, sequences are case sensitive. Further, if an escape sequence 
consists of more than one character and ends with a letter, the final letter must be capitalized. 
Reflection does not process the escape sequence until it receives an uppercase letter. The control 
codes are represented by ESC, 

C
R, 

L
F, etc. 

Entering Escape Sequences and Control Functions
To enter these escape sequences and control functions from the terminal window:

To indicate the ESC character on the Reflection Basic command line, use the following syntax: 

Application.Transmit Chr$(rcESC) & "<escape sequence>" 

To enter this sequence: Esc Csi Dcs 

In the terminal window press: e e+[ e+P
roject Name • Chapter  • Escape Sequences and Control Functions • TEMPLATE: docs_v3 • D:\working\rwin\sag\Online\ESC.FM • 8.25.98 • 07:10pm

227



228 Escape Sequences and Control Functions
For example, the escape sequence ESC&w6f132X sets the display in Reflection for HP with NS/VT 
to 132 columns. To enter this sequence: 

1. In the terminal window, press e and type &w6f132X . 

2. Press a+L to open the command line, then execute one of the commands shown 
below. 

Application.Transmit Chr$(rcESC) & "&w6f132X" 

Application.Display Chr$(rcESC) & "&w6f132X" 

The first sequence transmits the command to the host; the second causes the sequence to 
change your display. 

The corresponding control function in Reflection for UNIX and Digital or Reflection for 
ReGIS Graphics is 

CSI ?3h, so your command would look like this: 

Application.Transmit Chr$(rcESC) & "[?3h" 

ESC+[ is the 7-bit equivalent of CSI . 

Reflection for HP with NS/VT escape sequences when emulating an HP terminal are explained 
next. For those control sequences supported when using Reflection for HP with NS/VT to 
emulate a VT-series terminal, see page 239. See page 246 for the control functions supported by 
Reflection for UNIX and Digital and Reflection for ReGIS Graphics. 

For a complete reference of all escape sequences and control functions supported by Reflection, 
see the Reflection Terminal Reference manuals, available as .PDF files on the Reflection product CD. 

A Word About Notation
The following notation is used in the remainder of this appendix: 

· Escape sequences and control functions are case sensitive, and must be typed exactly as 
shown. 

· Where appropriate, a slash is used through a zero (Ø) to distinguish it from the uppercase 
letter O. 

· Note the difference between a lowercase L (l) and the number 1 (1). 
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· Parameters you supply for a sequence are enclosed in angle brackets. 

For example, when using the 
CSI <n>C control function, replace <n> with the number of 

spaces you want the cursor to move. 

· Most control functions (shown starting on  page 246) have a mnemonic identifier. You do 
not enter the mnemonic; it’s simply a convenient “word” to help you remember the name 
of the control function. For example, DECCOLM is the DEC mnemonic for setting the 
number of display columns. 

Reflection for HP with NS/VT Escape Sequences

Escape Sequence Description 

ESC[ Start unprotected field 

ESC]  End unprotected field 

ESC{ Start transmit-only field 
ESĈ Primary status request 

ESC~ Secondary status request 
ESC̀ Sense cursor, relative 

ESC@ Delay one second 

ESC)@ Select base characters 

ESC.  Enable NS/VT typeahead for MPE/iX machines 

ESC,  Disable NS/VT typeahead for MPE/iX machines

ESC)B  Select line drawing characters 

ESC1 Set tab stop 

ESC2 Clear tab stop 

ESC3 Clear all tabs 

ESC4 Set left margin 

ESC5 Set right margin 
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ESC9 Reset margins 

ESC&a<col>c<row>R  Cursor movement sequences (absolute)

ESC&a<col>c<row>Y Cursor movement sequences (relative) 

ESC&bR Reset data communications 

ESC&d<x>  Select display enhancement 

ESC&ds<x> Display enhancement with security 

ESC&f... Define user key 

ESC&f-1E Transmit HP r 

ESC&f<x>E  Trigger function key 

ESC&fØB Store setup 

ESC&f1B  Restore setup 

ESC&f211P... Configure t key 

ESC&fR  Configure t key 

ESC&f1m149P<!149>  Configure n key as n 

ESC&f1m149P<!154> Configure n key as keypad r

ESC&k2S Enable compressed (132-column) printing

ESC&k0S Enable regular printing 

ESC&j@ Enable user keys, no labels 

ESC&jA Display modes keys 

ESC&jB  Display and enable user keys 

ESC&jC Remove message, replace labels 

ESC&j<n>D Select function key features 

ESC&j<x>L... Remove function key labels and display message

Escape Sequence Description 
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ESC&jR Enable function key labels 

ESC&jS Disable function key labels 

ESC&kØA Auto linefeed off 

ESC&k1A Auto linefeed on 

ESC&kØB Block mode off 

ESC&k1B Block mode on 

ESC&kØC Caps lock off 

ESC&k1C Caps lock on 

ESC&kØD Margin bell off 

ESC&k1D Margin bell on 

ESC&kØI Set previous parity 

ESC&k1I No parity 

ESC&kØK Auto keyboard lock off 

ESC&k1K Auto keyboard lock on 

ESC&kØL Local echo off 

ESC&k1L Local echo on 

ESC&kØM Modify all mode off 

ESC&k1M Modify all mode on 

ESC&kØN SPOW latch off 

ESC&k1N SPOW latch on 

ESC&kØP Caps mode (TeleType) off 

ESC&k1P Caps mode (TeleType) on 

ESC&kØR Remote mode off 

Escape Sequence Description 
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ESC&k1R Remote mode on 

ESC&kØZ Modified data tags off 

ESC&k1Z Modified data tags on 

ESC&kØ\  HP terminal mode 

ESC&k1\ VT terminal mode 

ESC&kØ[ Smooth scroll off 

ESC&k1[ Smooth scroll on 

ESC&kØ]  Select key off 

ESC&k1] Select key on 

ESC&oB<cmd>
C

R Reflection command with completion code

ESC&oC<cmd>
C

R Reflection command 

ESC&oF<cmd>
C

R Reflection command without completion code

ESC&oX Clear typeahead 

ESC&p[<a>d]<b>D  Select destination device 

ESC&p[<a>d][<b>d]<Y>  Copy data to destination device

ESC&p<x>^  Device status request 

ESC&p<x>p<y>u<z>C  Perform action on device 

ESC&p<x>p2ØC Enable record mode 

ESC&p[<a>d][<b>d]<x>W<data string>  

Transfer bytes of string to destination device

ESC&p[<a>d][<b>d]W<data string>  

Transfer string to destination device

ESC&p9^  Forms buffer status request 

Escape Sequence Description 
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ESC&p <>n9^  Read forms cache directory 

ESC&p<<name>>n9^ Forms buffer status request (by name)

ESC&p9u<f#>p<<con>>L Store form, length unknown

ESC&p9u<<name>>n<f#>p<<con>>L  

Store form using name, length unknown

ESC&p9u<f#>p<len>L<con> Store form 

ESC&p9u<name>n<f#>p<len>L<con>  

Store form, using name 

ESC&p9u<form#>pF Display form 

ESC&p9u<form#>pL Purge form 

ESC&p<form#>p9^ Forms buffer status request (number) 

ESC&p16C Enable compressed (132-column) printing

ESC&p14C Enable regular printing 

ESC&qØL Configuration unlocked 

ESC&q1L Configuration locked 

ESC&q8teØ{ØD Turn bell off 

ESC&q8teØ{1D Turn bell on 

ESC&q8te1{<x>A Return definition 1st character 

ESC&q8te1{<x>B Return definition 2nd character 

ESC&q8te1{ØR Return equals enter off 

ESC&q8te1{1R Return equals enter on 

ESC&q8te1{ØT Transmit tab as spaces off 

ESC&q8te1{1T Transmit tab as spaces on 

Escape Sequence Description 
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ESC&q<m>teØ{ØA Transmit functions off 

ESC&q<m>teØ{1A Transmit functions on 

ESC&q<m>teØ{ØB SPOW off

ESC&q<m>teØ{1B SPOW on 

ESC&q<m>teØ{ØC Inhibit EOL wrap off

ESC&q<m>teØ{1C Inhibit EOL wrap on 

ESC&q<m>teØ{ØD Line mode

ESC&q<m>teØ{1D Page mode 

ESC&q<m>teØ{ØG Inhibit handshake off

ESC&q<m>teØ{1G Inhibit handshake on 

ESC&q<m>teØ{ØH Inhibit DC2 off

ESC&q<m>teØ{1H Inhibit DC2 on 

ESC&q<m>teØ{ØN Esc xfer to printer off

ESC&q<m>teØ{1N Esc xfer to printer on 

ESC&q<m>te1{ØA Auto linefeed off 

ESC&q<m>te1{1A Auto linefeed on 

ESC&q<m>te1{ØB Block mode off 

ESC&q<m>te1{1B Block mode on 

ESC&q<m>te1{ØC CapsLock off 

ESC&q<m>te1{1C CapsLock on 

ESC&q<m>te1{ØL Local echo off 

ESC&q<m>te1{1L Local echo on 

ESC&q<m>te1{ØM Modify all mode off 

Escape Sequence Description 
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ESC&q<m>te1{1M Modify all mode on 

ESC&q<m>te1{ØR Remote mode off 

ESC&q<m>te1{1R Remote mode on 

ESC&q<m>te2{<x>F  Field separator character 

ESC&q<m>te2{<x>L Set forms buffer size 

ESC&q<m>te2{<x>R Set block terminator character 

ESC&q<m>te2{ØZ Transmit all 

ESC&q<m>te2{1Z Transmit modified 

ESC&sØA Transmit functions off 

ESC&s1A Transmit functions on 

ESC&sØB SPOW off 

ESC&s1B SPOW on 

ESC&sØC End-of-line wrap off 

ESC&s1C End-of-line wrap on 

ESC&sØD Line mode on 

ESC&s1D Page mode on 

ESC&sØG Inhibit handshake off 

ESC&s1G Inhibit handshake on 

ESC&sØH Inhibit DC2 off 

ESC&s1H Inhibit DC2 on 

ESC&sØZ Parity checking off 

ESC&s1Z Parity checking on 

ESC&w6f8ØX Set 80-column mode 

Escape Sequence Description 
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ESC&w6f132X  Set 132-column mode 

ESC&w12F Turn on display 

ESC&w13F Turn off display 

ESC&xØC Clear send cursor position mode 

ESC&x1C Set send cursor position mode 

ESC*dØE Normal video 

ESC*d1E Inverse video 

ESC*dQ Enable cursor 

ESC*dØQ Underline cursor 

ESC*d1Q Block cursor 

ESC*dR Invisible cursor 

ESC*s-<n>^ Terminal capabilities 

ESC*s^ Request terminal ID 

ESC*s1^ Request terminal ID 

ESC*s12345^ Request serial number 

ESC*s12347^ Request serial number 

ESC*s12348^ Request Unique Product Identifier (UPI) 

ESC*y^ Report DCS capability 

ESCØ Copy display memory to destination 

ESCA Cursor up one line 

ESCa Sense cursor, absolute 

ESCB Cursor down one line 

ESCb Unlock keyboard 

Escape Sequence Description 
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ESCC Cursor right one character 

ESCc Lock keyboard 

ESCD Cursor left one character 

ESCd Transmit block 

ESCE Hard reset 

ESCF Cursor home down 

ESCf Disconnect 

ESCG Cursor to left margin 

ESCg Soft reset 

ESCH Cursor home up 

ESCh Cursor home up 

ESCI Horizontal tab 

ESCi Backtab 

ESCJ Clear display 

ESCj Display user key screen 

ESCK Clear line 

ESCk Remove user key screen 

ESCL Insert line 

ESCl Memory lock on 

ESCM Delete line 

ESCm Memory lock off 

ESCN Insert with wraparound 

ESCO Delete with wraparound 

Escape Sequence Description 
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ESCP Delete character 

ESCp É default 

ESCQ Insert character mode on 

ESCq Ê default 

ESCR Insert character mode off 

ESCr Ë default 

ESCS Scroll up 

ESCs Ì default 

ESCT Scroll down 

ESCt  Í default 

ESCU Page down 

ESCu Î default 

ESCV Page up 

ESCv Ï default 

ESCW Format mode on 

ESCw Ð default 

ESCX Format mode off 

ESCY Display functions on 

ESCZ Display functions off 

ESCz Terminal self-test 

Escape Sequence Description 
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Reflection for HP with NS/VT  VT Control Sequences
These control sequences are recognized when you are using Reflection for HP with NS/VT to 
emulate a VT-series terminal. 

Sequence Description 

CSI >c Secondary DA request 
CSI >Øs Home up 
CSI >1;11;Øc Reflection secondary DA response
CSI >1s Home down 
CSI ?ØJ Erase unprotected characters, cursor through end of screen
CSI ?ØK Erase unprotected characters through end of line
CSI ?1Øn Printer status response: printer ready
CSI ?13n Printer status response: no printer 
CSI ?15n Printer status request 
CSI ?18h Form feed after p on 
CSI ?18l Form feed after p off 
CSI ?19h Printer extent, screen 
CSI ?19l Printer extent, scrolling region 
CSI ?1h Cursor keys set to application 
CSI ?1i Print cursor line 
CSI ?1J Erase unprotected characters, top of screen through cursor 
CSI ?1K Erase unprotected characters, start of line through cursor
CSI ?1l Cursor keys set to normal 
CSI ?25h Cursor visible 
CSI ?25l Cursor invisible 
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CSI ?2J Erase unprotected characters, entire screen
CSI ?2K Erase unprotected characters, complete line
CSI ?2l VT52 emulation 
CSI ?3h Set 132-column mode 
CSI ?3l Set 80-column mode 
CSI ?42h Use 7-bit national replacement 
CSI ?42l Use 7- and 8-bit characters 
CSI ?4i Log to printer off 
CSI ?5h Display enhancements inverse video 
CSI ?5i Pass through to printer 
CSI ?5l Display enhancements normal 
CSI ?6h Origin mode, first row 
CSI ?6l Origin mode, upper left corner 
CSI ?7h End-of-line wrap on 
CSI ?7l End-of-line wrap off 
CSI ?8h Autorepeat on 
CSI ?8l Autorepeat off 
CSI <n>@ Insert <n> characters 
CSI <n>A Cursor up 
CSI <n>B Cursor down 
CSI <n>C Cursor forward 
CSI <n>d Vertical position absolute 

Sequence Description 
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CSI <n>D Cursor backward 
CSI <n>e Vertical position relative 
CSI <n>F Previous line 
CSI <r>;<c>f Horizontal/vertical position
CSI <n>G or 

CSI <n>` Horizontal position absolute
CSI <r>;<c>H Cursor position
CSI <n>L Insert <n> lines 
CSI <n>M Delete <n> lines 
CSI <n>P Delete <n> characters 
CSI <t>;<b>r Top/bottom margin
CSI <row>;<col>R Cursor position response
CSI <n>S Scroll up <n> lines 
CSI <n>T Scroll down <n> lines 
CSI <n>U Page forward <n> pages 
CSI <n>V Page backward <n> pages 
CSI <n>X Erase character(s) 
CSI <n>Z Cursor backtab 
CSI Ø;1234c Serial number request 
CSI Ø;1235c UPI request 
CSI ØJ Erase from cursor to end of screen 
CSI Ø"q Select erasable characters through end of screen
CSI ØK Erase from cursor through end of line 

Sequence Description 
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CSI 1"q Select protected characters 
CSI 12h Local echo off 
CSI 12l Local echo on 
CSI 1J Erase from top of screen to cursor 
CSI 1K Erase from start of line through cursor
CSI 2"q Select erasable characters 
CSI 2Øh Auto linefeed on 
CSI 2Øl Auto linefeed off 
CSI 2h Keyboard locked 
CSI 2J Erase complete screen 
CSI 2K Erase entire line 
CSI 2l Keyboard unlocked 
CSI 3g Tab clear (all) 
CSI 3h Display controls on 
CSI 3l Display controls off 
CSI 4h Insert mode 
CSI 4i Passthrough mode off 
CSI 4l Replace mode 
CSI 5i Passthrough mode on 
CSI 61"p VT102 emulation 
CSI 62;Ø"p VT220 emulation, 8-bit
CSI 62;1"p VT220 emulation, 7-bit 

Sequence Description 
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CSI 62;2"p VT220 emulation, 8-bit 

CSI g Tab clear (at cursor) 

DCS1234;Ø{<cmd> ST Invoke Reflection command

DCS1234;1{<cmd> ST Reflection command with completion code

DCS1234;2{<cmd> ST Reflection command without completion code

ESC(<char>  Selects GØ 
ESC)<char> Selects G1 
ESC*<char> Selects G2 
ESC+<char> Selects G3 
ESC< ANSI mode 
ESC= Keypad mode application (VT52) 
ESC> Keypad mode normal (VT52) 
ESC] Print screen (VT52) 
ESĈ  Log to printer on (VT52) 
ESC_ Log to printer off (VT52) 
ESC} Map G2 into GR 
ESC~ Map G1 into GR 
ESC$@ JIS C 6226-1978
ESC$B JIS X 0208-1983
ESC&@Esc$B JIS X 0208-1990
ESC$(D JIS X 0212-1990
ESC(J JIS Roman (same as Esc(H)

Sequence Description 
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ESC(H JIS Roman (same as Esc(J)
ESC(B ASCII 
ESC(I Half width Katakana
ESC#3 Double-width, double-height line (top half) 
ESC#4 Double-width, double-height line (bottom half)
ESC#5 Single-width, single-height line 
ESC#6 Double-width, single-height line 
ESC&bR Connection reset 
ESC7 Save cursor state 
ESC8 Restore cursor state 
ESCA Cursor up (VT52) 
ESCB Cursor down (VT52) 
ESCc Hard reset 
ESCC Cursor right (VT52) 
ESCD Cursor left (VT52) 
ESCD Index 
ESCE or 

CSI <n>E Next line
ESCF Character set graphics (VT52) 
ESCG Character set ASCII (VT52) 
ESCH Home cursor (VT52) 
ESCH Tab set at current column 
ESCI Reverse linefeed (VT52) 

Sequence Description 
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ESCJ Erase to end of screen (VT52) 
ESCK Erase to end of line (VT52) 
ESCM Reverse index 
ESCn Lock shift G2 
ESCN Single shift G2 
ESCo Lock shift G3 
ESCO Single shift G3 
ESCV Print cursor line (VT52) 
ESCW Controller mode start (VT52) 
ESCX Controller mode stop (VT52) 
ESCY<r><c> Move cursor (VT52) 
ESCZ Identification request (VT52) 
ESC/Z Identification response (VT52) 
ESC&k<n>\ Terminal class

S
I Lock shift GØ 

S
O Lock shift G1 

Sequence Description 
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Reflection for UNIX and Digital and Reflection Graphics Control Functions
This section also includes control functions for emulating the Data General 215 terminal (see 
page 259), a Unisys A Series T27 terminal (see page 272), and the WYSE 50 or 60 terminals 
(see page 261).  

Control Function Mnemonic Description 

CSI !p DECSTR Reset terminal (soft reset) 

CSI &u DECRQUPSS Request UPSS 

CSI >Øc DA Request secondary device attributes 

CSI >24;11;Øc DA Response to secondary device attributes

CSI >c DA Request secondary device attributes 

CSI ?<n>$p DECRQM Request DEC private mode settings 

CSI ?<n>;…<n>l RM Reset DEC private mode 

CSI ?<n>;…<n>h SM Set DEC private mode 

CSI ?<n1>;<n2>$y DECRPM Report DEC private mode setting 

CSI ?<n>*{ — Macro space report; <n> is the number of 
bytes divided by 16

CSI <n>*z DECINVM Invoke macro 

CSI ?Øi MC Send graphics to printer 

CSI ?ØJ DECSED Erase unprotected characters from cursor 
to end of screen 

CSI ?ØK DECSEL Erase unprotected characters from cursor 
to end of line

CSI ?1Øn DSR Report printer ready 

CSI ?13n DSR Report no printer 

CSI ?15n DSR Request printer status 

CSI ?18h DECPFF Send form feed after printing 
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CSI ?18l DECPFF No form feed after printing 
CSI ?19h DECPEX Print full screen 
CSI ?19l DECPEX Print scrolling region 
CSI ?1h DECCKM Cursor keys application 
CSI ?1i MC Print line 
CSI ?1J DECSED Erase unprotected characters from top of 

screen to cursor
CSI ?1K DECSEL Erase unprotected characters from 

beginning of line to cursor
CSI ?1l DECCKM Cursor keys normal 
CSI ?2Øn DSR Report UDKs unlocked 
CSI ?21n DSR Report UDKs locked 
CSI ?2i MC Send graphics to host 
CSI ?25h DECTCEM Cursor visible 
CSI ?25l DECTCEM Cursor invisible 
CSI ?25n DSR Request UDK status (VT200) 
CSI ?26n DSR Request keyboard dialect 
CSI ?27;<n>n DSR Report keyboard dialect (<n> = 1 for 

North American keyboards)
CSI ?2J DECSED Erase unprotected characters from screen
CSI ?2K DECSEL Erase unprotected characters from line
CSI ?2l DECANM VT52 emulation 
CSI ?3h DECCOLM Columns 132 
CSI ?3l DECCOLM Columns 80 

Control Function Mnemonic Description 
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CSI ?42h DECNRCM Use national replacement: 7-bit 
CSI ?42l DECNRCM Use national replacement: 7-bit and 8-bit 
CSI ?43h DECGEPM Expanded print mode 
CSI ?43l DECGEPM Compressed print mode 
CSI ?44h DECGPCM Print color mode 
CSI ?44l DECGPCM Print monochrome mode 
CSI ?45h DECGPCS Print color syntax set to RGB 
CSI ?45l DECGPCS Print color syntax set to HLS 
CSI ?46h DECGPBM Print background 
CSI ?46l DECGPBM Do not print background 
CSI ?47h DECGRPM Print rotated mode 
CSI ?47l DECGRPM Print compressed mode 
CSI ?4h DECSCLM Smooth scroll 
CSI ?4l DECSCLM Jump scroll 
CSI ?4i MC Auto print off 
CSI ?5Øn DSR Report a locator device detected 
CSI ?53n DSR Report no locator device detected 
CSI ?55n DSR Request status of locator device 
CSI ?56n DSR Request type of locator device 
CSI ?57;Øn DSR Report no locator device connected 
CSI ?57;1n DSR Report locator device is a mouse 
CSI ?5h DECSCNM Inverse video 
CSI ?5l DECSCNM Normal video 

Control Function Mnemonic Description 
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CSI ?5i MC Auto print on 
CSI ?60h DECHCCM Couple the cursor to the display 

(horizontally)
CSI ?60l DECHCCM Uncouple the cursor from the display 

(horizontally)
CSI ?61h DECVCCM Couple the cursor to the display 

(vertically)
CSI ?61l DECVCCM Uncouple the cursor from the display 

(vertically)
CSI ?62n DECMSR Device status request for a macro space 

report (VT400 mode only)
CSI ?64h DECPCCM Couple the cursor to the display (page 

cursor coupling) 
CSI ?64l DECPCCM Uncouple the cursor from the display 

(page cursor coupling) 
CSI ?66h DECNKM Numeric keypad mode application 
CSI ?66l DECNKM Numeric keypad mode numeric 
CSI ?67h DECBKM Backarrow key set to BS  
CSI ?67l DECBKM Backarrow key set to DT  
CSI ?6h DECOM Origin mode set 
CSI ?6l DECOM Origin mode reset 
CSI ?7h DECAWM Autowrap on 
CSI ?7l DECAWM Autowrap off 
CSI ?8Øh DECSDM Disable sixel scrolling 
CSI ?8Øl DECSDM Enable sixel scrolling 
CSI ?8h DECARM Keyboard auto repeat on 

Control Function Mnemonic Description 
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CSI ?8l DECARM Keyboard auto repeat off 
CSI ?i MC Send graphics to printer 
CSI <n>$p DECRQM Request ANSI mode settings 
CSI <n1>;<n2>$y DECRPM Report ANSI mode settings 
CSI <n>@ ICH Insert <n> characters 
CSI <n>A CUU Cursor up 
CSI <n>B CUD Cursor down 
CSI <n>C CUF Cursor forward 
CSI <n>D CUB Cursor backward 
CSI <r>;<c>f HVP Move cursor to horizontal and vertical 

position
CSI <n>;…<n>h SM Set ANSI mode 
CSI <r>;<c>H CUP Cursor position 
CSI <n>;…<n>l RM Reset ANSI mode 
CSI <n>L IL Insert <n> lines 
CSI <n>D CUB Cursor backward 
CSI <n>;...<n>m SGR Select graphic rendition 
CSI <n>M DL Delete <n> lines from cursor 
CSI <n>P DCH Delete <n> characters from cursor 
CSI <t>;<b>r DECSTBM Set top and bottom scrolling region 

margins
CSI <row>;<column>R CPR Report cursor position 
CSI <n>X ECH Erase <n> characters on line 
CSI Ø"q DECSCA Select erasable character 

Control Function Mnemonic Description 
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CSI Ø$} DECSASD Top 24 lines = active display 
CSI Ø$~ DECSSDT Do not display status line 
CSI Ø;1234c WRQRQSN Serial number request 
CSI Ø;1235c WRQRQUPI UPI request 
CSI Øc DA Request primary device attributes 
CSI Øg TBC Tab clear 
CSI Øi MC Print screen 
CSI ØJ ED Erase from cursor to end of screen 
CSI ØK EL Erase from cursor to end of line 
CSI Øn DSR Report no device malfunction 
CSI Øx DA Request terminal parameters 
CSI 1"q DECSCA Select protected character 
CSI 1$} DECSASD Status line set to active display 
CSI 1$~ DECSSDT Status line set to indicator 
CSI 1$u DECRQTSR Request terminal state report 
CSI 1$w DECRQPSR Request cursor information report 
CSI 12h SRM Local echo off 
CSI 12l SRM Local echo on 
CSI 1J ED Erase from top of screen to cursor 
CSI 1$} DECSASD Status line set to active display 
CSI 1$~ DECSSDT Status line set to indicator 
CSI 1$u DECRQTSR Request terminal state report 
CSI 1$w DECRQPSR Request cursor information report 

Control Function Mnemonic Description 
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CSI 12h SRM Local echo off 
CSI 12l SRM Local echo on 
CSI 1J ED Erase from top of screen to cursor 
CSI 1K EL Erase from beginning of line to cursor
CSI 1x DA Request terminal parameters 
CSI 2"q DECSCA Select erasable character 
CSI 2$~ DECSSDT Status line: host writable 
CSI 2$u DECRQTSR Request color table report (VT340) 
CSI 2$w DECRQPSR Request tab stop report 

CSI 2;<n1>;<n2>;<receive baud>;<transmit baud>;1;Øx

 DA Response to 
CSI Øx 

CSI 2Øh LNM Auto linefeed on 
CSI 2Øl LNM Auto linefeed off 
CSI 2h KAM Keyboard lock 
CSI 2J ED Erase entire screen 
CSI 2K EL Erase entire line 
CSI 2l KAM Keyboard unlock 

CSI 3;<n1>;<n2>;<receive baud>;<transmit baud>;1;Øx

 DA Response to 
CSI 1x 

CSI 3g TBC Clear all tabs 
CSI 3h — Display controls on 
CSI 3l — Display controls off 
CSI 3n DSR Report device malfunction 

Control Function Mnemonic Description 
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CSI 4h IRM Insert mode 
CSI 4i MC Printer controller mode off 
CSI 5i MC Printer controller mode on 
CSI 4l IRM Replace mode 
CSI 5n DSR Request operating status 
CSI 24t DECSLPP With 24 lines per page, sets number of 

pages to 6
CSI 25t DECSLPP With 25 lines per page, sets number of 

pages to 5
CSI 36t DECSLPP With 36 lines per page, sets number of 

pages to 4
CSI 48t DECSLPP With 48 lines per page, sets number of 

pages to 3
CSI 61"p DECSCL VT102 emulation 
CSI 62"p DECSCL VT200 emulation 8-bit controls 
CSI 62;Ø"p DECSCL VT200 emulation 8-bit controls 
CSI 62;1"p DECSCL VT200 emulation 7-bit controls 
CSI 62;2"p DECSCL VT200 emulation 8-bit controls 
CSI 63"p DECSCL VT300 emulation 8-bit controls 
CSI 63;Ø"p DECSCL VT300 emulation 8-bit controls 
CSI 63;1"p DECSCL VT300 emulation 7-bit controls 
CSI 63;2"p DECSCL VT300 emulation 8-bit controls 
CSI 72t DECSLPP With 72 lines per page, sets number of 

pages to 2

Control Function Mnemonic Description 
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CSI 144t DECSLPP With 144 lines per page, sets number of 
pages to 1

CSI 6n CPR Request cursor position 
CSI c DA Request primary device attributes 
CSI g TBC Tab clear 
CSI i MC Print screen 
CSI 4;<n>;...;<n>y DECTST Terminal test (disconnect) 
CSI <n><SP>P PPA Page position absolute 
CSI <n><SP>Q PPR Page position relative 
CSI <n><SP>R PPB Page position backward 
CSI <n>S SU Pan down 
CSI <n>T SD Pan up 
CSI <n>U NP Next page 
CSI <n>V PP Previous page 

DCS$q... ST DECRQSS Request control function setting 

DCS<n1>;<n2>;  DECDMAC Define macro 

<n3>!zD...DSt                                          

DCS<n>;<n>;P3;qs...s ST  — Sixel data format 

DCS<C>$w<def1>;<def2>;...;<defn> ST

 DECLBD   Define locator device buttons (mouse)                       

DCS<C>;<L>|<def1>;<def2>;...;<defn> ST

 DECUDK         Load user-defined keys     

DCS<n>$r... ST DECRPSS Report control function setting 

Control Function Mnemonic Description 
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DCSØ!u%5ST DECAUPSS Assign UPSS as DEC Supplemental 
Graphic

DCSØp — Enter ReGIS at point command exited

DCS1!uA ST DECAUPSS Assign UPSS as ISO Latin-1 

DCS1$p.... ST DECRSTS Restore terminal state from DECTSR 

DCS1$s.... ST DECTSR Report terminal state 

DCS1$t.... ST DECRSPS Restore cursor from DECCIR 

DCS1$u.... ST DECCIR Report cursor information 

DCS1234;Ps{<cmd> ST WRQCMD Invoke Reflection command 

DCSØp         — Enter ReGIS at point command exited; 
ReGIS commands are not displayed 

DCS1p — Enter ReGIS and begin new command; 
ReGIS commands are not displayed

DCS2p — Enter ReGIS at point command exited; 
ReGIS commands are displayed 

DCS3p — Enter ReGIS and begin new command; 
ReGIS commands are displayed 

DCSp — Enter ReGIS at point command exited; 
ReGIS commands are not displayed 

DCS2$p<data> ST DECRSTS Restore color table (VT340) 

DCS2$s<data> ST DECCTR Report color table (VT340) 

DCS2$t.... ST DECRSPS Restore tab from DECTABSR 

DCS2$u.... ST DECTABSR Report tab stop 

DCSPfn;Pcn;Pe;PcmW;Pw;Pt;Pcmh;Pcss{Dscs UUUUUUUU/LLLLLLLL;... ST

         DECDLD Downline loadable character set 

Control Function Mnemonic Description 
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ESC(<chr>  SCS Selects GØ 

ESC)<chr>  SCS Selects G1, 94-character set 

ESC-<chr>  SCS Selects G1, 96-character set 

ESC*<chr>  SCS Selects G2 (VT200), 
94-character set

ESC+<chr>  SCS Selects G3 (VT200), 
94-character set

ESC%!0 — Enter Tektronix mode 

ESC%!1 — Enter VT400-7 mode from Tektronix 
mode

ESC%!2 — Enter VT100 mode from 
Tektronix mode

ESC%!3 — Enter VT52 mode from 
Tektronix mode 

ESC.<chr> SCS Selects G2 (VT200), 
96-character set

ESC/<chr> SCS Selects G3 (VT200), 
96-character set

ESC< — ANSI mode—exit VT52 
emulation mode

ESC= DECKPAM Keypad mode application 

ESC= DECKPAM Keypad mode application (VT52) 

ESC> DECKPNM Keypad mode normal 

ESC> DECKPNM Keypad mode normal (VT52) 

ESC\ — Exit ReGIS mode 

ESC] MC Print screen (VT52) 

Control Function Mnemonic Description 
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ESĈ  MC Auto print mode on (VT52) 

ESC_ MC Auto print mode off (VT52) 

ESC| LS3R Map G3 into GR 

ESC} LS2R Map G2 into GR 

ESC~ LS1R Map G1 into GR 

ESC#3 DECDHL Double-width- and height-line 
(top half)

ESC#4 DECDHL Double-width- and height-line (bottom 
half)

ESC#5 DECSWL Single-width- and height-line 

ESC#6 DECDWL Double-width- and single-height line 

ESC#8 DECALN Test pattern 

ESC<SP>F S7C1T VT200 emulation 7-bit controls 

ESC<SP>G S8C1T VT200 emulation 8-bit controls 

ESC7 DECSC Save cursor state 

ESC8 DECRC Restore cursor state 

ESCA — Cursor up (VT52) 

ESCB — Cursor down (VT52) 

ESCC — Cursor forward (VT52) 

ESCc RIS Reset to initial state (hard reset) 

ESCD — Cursor backward (VT52) 

ESCH — Home cursor (VT52) 

ESCH — Set tab 

ESCI — Reverse linefeed (VT52) 

Control Function Mnemonic Description 
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ESCJ — Erase from cursor to end of screen (VT52)

ESCK — Erase to end of line (VT52) 

ESCn LS2 Map G2 into GL 

ESCN SS2 Map G2 into GL for next character 

ESCo LS3 Map G3 into GL 

ESCO SS3 Map G3 into GL for next character 

ESCV — Print cursor line (VT52) 

ESCW — Printer controller mode on (VT52) 

ESCX — Printer controller mode off (VT52) 

ESCY<r><c>  — Cursor to <r>  row <c>  column VT52) 

ESCZ — Request primary device attributes (VT52); 
Reflection replies 

ESC/Z
I ND IND Index 

NEL NEL Next line 

R
I  RI Reverse linefeed 

SI LS0 Map GØ into GL 

SO LS1 Map G1 into GL 

Control Function Mnemonic Description 
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DG Control Sequences
This section details how to use Reflection for UNIX and Digital and Reflection for ReGIS 
Graphics to emulate the Data General 215 terminal.

Configuring Reflection for a DG Terminal
To configure Reflection for DG emulation:

1. On the Setup menu, click Terminal, then click the Terminal Type tab. 

2. Select the DG 215 terminal type.

3. Click OK. 

Control Sequences Description

ctrl A Print form, from start of cursor line to end of page

ctrl B Reverse attribute off

ctrl C Enable blink attribute

ctrl D Disable blink attribute

ctrl E Read window address

ctrl G Sound bell

ctrl H Window home

ctrl J New line

ctrl K Erase eol

ctrl L Erase window

ctrl M Carriage return

ctrl N Blink attribute on

ctrl O Blink attribute off

ctrl P <col><row> Write cursor address

ctrl Q Print window
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Control Sequences Description

ctrl R Roll enable

ctrl S Roll disable

ctrl T Underscore attribute on

ctrl U Rnderscore attribute off

ctrl V Reverse attribute on

ctrl W Cursor up

ctrl X Cursor right

ctrl Y Cursor left

ctrl Z Cursor down

ctrl \ Dim attribute on

ctrl ] Dim attribute off

Escape Sequences Description

ctrl ^ C Read model ID

ctrl ^ E Reverse video off

ctrl ^ D Reverse video on

ctrl ^ O Shift in, selects primary character set

ctrl ^ N Shift out, selects secondary character set

ctrl ^ F@ Select ANSI mode

ctrl ^ FU0 Select 7-bit transmission

ctrl ^ FU1 Select 8-bit transmission
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WYSE Escape Sequences
This chapter details how to use Reflection for UNIX and Digital and Reflection for ReGIS 
Graphics to emulate the WYSE 50 or 60 terminals.

Configuring Reflection for the WYSE Terminal
To configure Reflection for WYSE emulation:

1. On the Setup menu, click Terminal, then click the Terminal Type tab. 

2. Select a terminal type:

· WYSE 50+: Emulate the WYSE 50 terminal.

· WYSE 60: Emulate the WYSE 60 terminal.

3. Click OK. 

Escape Sequence Description Wyse Emulation Type

ctrl Q Enable transmission 60

ctrl+S Stop transmission 60

ctrl E Send Ack (Answerback) 50 60

esc e 6 Ack mode off 60

esc e 7 Ack mode on 60

esc C esc D F Full-duplex mode on 50 60

esc C esc D H Half-duplex mode on 50 60

esc B Block mode on 50 60

esc C Block mode off 50 60

esc e 8 Data/Printer = Modem/Aux 60

esc e 9 Data/Printer = Aux/Modem 60
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Escape Sequence Description Wyse Emulation Type

esc c 0 <bd><st><pr><wd> Set modem port parameters 60

esc c 1 <bd><st><pr><wd> Set aux port parameters 60

esc c 2 <handshake> Set modem port rcv handshake 60

esc c 3 <handshake> Set aux port rcv handshake 60

esc c 4 <handshake> Set modem port xmt handshake 60

esc c 5 <handshake> Set aux port xmt handshake 60

esc c 6 <max> Set maximum transmission 60

esc SPACE Send terminal ID 50 60

esc c ; <answer> ^Y Program answerback message 60

esc c < Send answerback message 60

esc c = Conceal answerback message 60

esc e SPACE Answerback mode off 60

esc e ! Answerback mode on 60

esc c 8 <hh><mm> Load time of day 60

esc e R Ignore received nulls 60

esc e S Accept received nulls 60

esc U Monitor mode on 50 60

esc u Monitor mode off 50 60

esc X Monitor mode off 50 60

esc k Local edit mode on 50 60

esc l Local edit mode off 50 60

ctrl G Sound bell 50 60

ctrl N Unlock keyboard 50 60
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Escape Sequence Description Wyse Emulation Type

esc " Unlock keyboard 50 60

ctrl O Lock keyboard 50 60

esc # Lock keyboard 50 60

esc e $ Keyclick off 60

esc e % Keyclick on 60

esc e & Caps lock on 60

esc e ' Caps lock off 60

esc e L Margin bell off 60

esc e M Margin bell on 60

esc ` J Set margin bell at cursor 60

esc e , Key repeat off 60

esc e - Key repeat on 60

esc e T Caps lock = on 60

esc e U Caps lock = off 60

esc c T Default all modes 60

esc c V Save modes to NVR 60

esc c W Save modes and tabs to NVR 60

esc c X Power-on reset 60

esc ~ / Wyseword mode on 60

esc ~ . Wyseword mode off 60

esc ~ 2 Application key mode on 60

esc ~ 3 Application key mode off 60

esc z <fkey><sequence> DEL Program function key 50 60
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Escape Sequence Description Wyse Emulation Type

esc z <fkey> DEL Clear function key 50 60

esc Z <dir><key><seq> DEL Program key direction and def 60

esc Z <dir><key> DEL Clear key definition 60

esc Z ~ <key> Read key direction and def 60

esc c U Clear all redefinable keys 60

esc c 7 <max> Set maximum fkey xmt speed 60

esc ` 8 Screen off 60

esc ` 9 Screen on 60

esc e P Screen saver off 60

esc e Q Screen saver on 60

esc ^ 1 Reverse screen 60

esc ^ 0 Normal screen 60

esc ` <scroll> Set scrolling speed/type 60

esc ` <cursor> Set cursor display features 60

esc ` 0 Cursor display off 60

esc ` 1 Cursor display on 60

esc ` a Editing status line on 60

esc ` b Standard status line on 60

esc ` c Status line off 60

esc F <message> CR Program/display message on status 50 60

esc F CR Clear message on status line 50 60

esc z ( <text> CR Program unshifted label line 50 60

esc z ) <text> CR Program shifted label line 50 60
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Escape Sequence Description Wyse Emulation Type

esc z ( CR Erase unshifted label line 50 60

esc z ) CR Erase shifted label line 50 60

esc z <field><label> CR Program function key label 50 60

esc z <field> CR Erase function key label 50 60

esc z DEL Shifted label line off 50 60

esc f Message to user line 60

esc ` : 80-column display 60

esc ` ; 132-column display 60

esc e F Economy 80-col mode off 60

esc e G Economy 80-col mode on 60

esc e . Width change clear off 60

esc e / Width change clear on 60

esc e ( 24 data lines 60

esc e ) 25 data lines 60

esc e * 42 data lines 60

esc e + 43 data lines 60

esc w <length> Divide memory into pages 60

esc w B Display previous page 60

esc J Display previous page 50 60

esc w C Display next page 60

esc K Display next page 50 60

esc w <page> Display specified page 60

esc x A <line> Split screen horz. (simple) 60
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Escape Sequence Description Wyse Emulation Type

esc x 1 <line> Split screen horz. clr (simple) 60

esc x C <line> Split screen horz. (adjust) 60

esc x 3 <line> Split screen horz. clr (Adjust) 60

esc ] Activate upper window 60

esc } Activate lower window 60

esc J Activate other window 60

esc K Activate other window 60

esc x P Lower horizontal split 60

esc x R Raise horizontal split 60

esc w E Roll window up in page 60

esc w F Roll window down in page 60

esc x @ Redefine screen as one window 60

esc x 0 Redefine screen one window clr 60

esc d ( Autodrag cursor off 60

esc d ) Autodrag cursor on 60

esc w D Reposition workspace 60

esc A <mf><attr> Set attribute to message 50 60

esc G <attr> Set character display attribute 50 60

esc e 0 Character attribute mode off 60

esc e 1 Character attribute mode on 60

esc e 2 Page attribute mode on 60

esc e 3 Line attribute mode on 60

esc ` <wpca> Assign write protect attribute 60
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Escape Sequence Description Wyse Emulation Type

esc ! <attr> Clear unprotected page to attribute 50

esc G <lattr> Assign line attribute 60

esc ( Write-protect mode off 50 60

esc ) Write-protect mode on 50 60

esc V Clr cursor col to write protect space 50 60

esc ' Protect mode off 50 60

esc & Protect mode on 50 60

esc H <ldraw> Display graphic character 50 60

esc H ctrl B Line draw graphics mode on 50 60

esc H ctrl C Line draw graphics mode off 50 60

ctrl H Cursor left (backspace) 50 60

ctrl L Cursor right 50 60

ctrl K Cursor up; no scroll 50 60

esc j Cursor up; scroll (revers lf) 60

ctrl V Cursor down; no scroll 50 60

ctrl J Cursor down; scroll 50 60

ctrl M Cursor to start of line 50 60

ctrl _ Cursor to start of next line 50 60

esc { Home cursor 60

ctrl ^ Home cursor 60

esc _ <col> Cursor to specific column 60

esc [ <line> Cursor to specific line 60

esc d . End-of-line wrap off 60
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Escape Sequence Description Wyse Emulation Type

esc d / End-of-line wrap On 60

esc e 4 Received CR = CR 60

esc e 5 Received CR = CRLF 60

esc d * Autopage mode off 60

esc d + Autopage mode on 60

esc O Autoscroll mode on 50 60

esc N Autoscroll mode off 50 60

esc ` H Line lock mode on 60

esc ` I Line lock mode off 60

esc = <line><col> Cursor address 80 column page 50 60

esc w @<pg><ln><col> Cursor add specific 80 column page 60

esc - <wnd/pg><ln><col> Address specific 80 column window/page 50 60

esc a <lll>R<ccc>C Address 80/120-column page 50 60

esc ? Read cursor address 80-column 60

esc w ` Read 80-column page and address 60

esc / Read 80-column window/page & address 60

esc b Read address 80/132-column page 50 60

esc 0 Clear all tab stops 50 60

esc 1 Set tab stop at cursor 50 60

esc 2 Clear tab stop at cursor 50 60

esc i Tab cursor 50 60

ctrl I Tab cursor 50 60

esc I Backtab 50 60
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Escape Sequence Description Wyse Emulation Type

esc q Insert mode on, replace off 50 60

esc r Replace mode on, insert off 50 60

esc e " Page edit mode off 60

esc e # Page edit mode on 60

esc Q Insert space character 50 60

esc E Insert line of spaces 50 60

esc c M Insert column of nulls 60

esc W Delete cursor character 50 60

esc R Delete cursor line 50 60

esc c J Delete cursor column 60

esc * Clear page to nulls 50 60

esc + Clear page to spaces 50 60

esc , Clear page to write-protest space 50 60

esc ; Clear unprot page to spaces 60

ctrl Z Clear unprot page to spaces 50 60

esc : Clear unprot page to nulls 50 60

esc . <char> Clear unprot page to character 50 60

esc Y Clear unprot pg to sp from cursor 50 60

esc y Clear unprot pg to nul from cursor 50 60

esc c P Clear unprot pg foreground to space 60

esc c Q Clear unprot pg foreground to nul 60

esc T Clear unprot ln to space from cursor 50 60

esc t Clear unprot ln to nul from cursor 50 60
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Escape Sequence Description Wyse Emulation Type

esc c O Clear unprot for cursor to eol space 60

esc c L Clear unprot for cursor to eol nul 60

esc c R Clear unprot line fore to space cursor 60

esc c S Clear unprot line fore to nul cursor 60

esc c I <char> Clear unprot column to character 60

esc c K Clear unprot column to nulls 60

esc c N <width><height> Draw box right of cursor 60

esc c G <line><col> Draw box 80-column page 60

esc c G <line>~<col> Draw box 132-column page 60

esc c F <line><col><char> Fill unprot with characters 80-column 60

esc c F <line>~<col><char> Fill unprot with characters 132-column 60

esc c H <line><col><char> Fill entire with characters 80-column 60

esc c H <line>~<col><char> Fill entire with characters 132-column 60

esc d ' Begin send/print at top of page 60

esc d & Begin send/print at top of screen 60

esc M Send cursor character 50 60

esc 6 Send cursor line 50 60

esc 4 Send unprotected cursor line 50 60

esc 7 Send page 50 60

esc 5 Send unprotected page 50 60

esc 8 Mark block beginning 50 60

esc 9 Mark block ending 50 60

esc s Send entire block 50 60
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Escape Sequence Description Wyse Emulation Type

esc S Send unprotected block 50 60

esc P Print formatted page to cursor 50 60

esc @ Print format unprot page to cursor 50 60

esc p Print unformatted page to cursor 50 60

esc L Print unformatted page to 50 60

ctrl T Aux/transparent print off 50 60

ctrl R Aux print mode on 50 60

ctrl X Transparent print mode on 50 60

esc d # Transparent print mode on 60

esc d SPACE Aux receive mode off 60

esc d ! Aux receive mode on 60

esc d $ Bidirectional mode off 60

esc d % Bidirectional mode on 60

esc c D Select primary character set 60

esc c E Select secondary character set 60

esc c B <bank> Define primary character set 60

esc c C <bank> Define secondary character set 60

esc c @ <bank><Set> Load font bank with character set 60

esc c ? <bank> Clear font bank 60

esc c A >bank><pp><b..b>^Y Define and load soft font 60

esc e N Auto font load off 60

esc e O Auto font load on 60
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Unisys T27 Escape Sequences
This section details how to use Reflection for UNIX and Digital and Reflection for ReGIS 
Graphics to emulate the Unisys A Series T27 terminals.

Configuring Reflection for the T27 Terminal
To configure Reflection for T27 emulation:

1. On the Setup menu, click Terminal, then click the Terminal Type tab. 

2. Select the UNISYS T27 terminal type.

3. Click OK. 

Escape Sequence Description

<ESC>W Set forms mode

<ESC>X Reset forms mode

<DC2> Toggle forms mode

<SOH> Exit forms mode

<ESC>E Set search mode

<ESC>-<x> Set search character (x < 0x80)

<ESC>-<ESC><SO><z><ESC><SI> Set search character (z >= 0x80)

<ESC>F Reset search mode

<LF> Move pointer down

<DC3> Move pointer up

<ESC>C Move pointer right

<DC2> Move pointer right

<BS> Move pointer left (backspace)

<ESC>& Align kbc to dcp

<HT> Tab right
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<ESC># Clear variable tabs

<VT> Vertical tab down

<DC4> Home

<ESC>$<n> Jump to page n

<ESC>^<hh><kk> Position pointer

<ESC>"<c><r> Position pointer

<CR> Carriage return

<LF> Carriage return

<ESC>6 Prevent align in cursor page

<ESC>! Insert character by line

<ESC>@ Insert character by page

<ESC>% Delete character by line

<ESC>M Line delete

<ESC>P Delete character by page

<ESC>L Line insert

<ESC>> Move line up

<ESC>< Move line down

<ESC>K Clear to end of line

<DC1> Clear to end of line

<ESC>J Clear to end of page

<SOH> Clear page

<ESC>S Roll page up

<ESC>T Roll page down

Escape Sequence Description
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<ESC>] Print all

<ESC>; Print all with form feed

<ESC>: Print unprotected data

<ESC>)1 Query printer status

<FF> Clear page

<ESC><FF> Clear page

<ETB> End highlight

<CAN> Start video blink

<EM> Start secure video

<SUB> Start bright video

<ESC>[<n>a Printer space compression

<ESC>3 Underline video highlight

<ESC>4 Reverse video highlight

<ESC>N Set reverse video

<ESC>O Set normal video

<ESC>Raaaaaccdd..dd Store ASCII codes as data

<ESC>RBmmmnnnnppp Configure data comm, screen and kpt 
buffers

<ESC>RC Reconfigure terminal

<ESC>RDhhpp..pp00iiqq..qq00nnzz..zz0000 Selective key programming

<ESC>Rhaaaacchhhh..hh Store data in hex codes

<ESC>RKppphhkk..kkApiiqq..qqA9nnzz..zzA9A9 Program function keys f1..f10

<ESC>RL Transmit error log

Escape Sequence Description
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<ESC>RP Copy temporary storage into nv ram

<ESC>RSccdd..dd Display message in environmental user 
status line

<ESC>Rtaaaacc Transmit memory contents to host

<ESC> Escape

<ESC><SO> Set shift out

<SO> Set shift out

<ESC><SI> Set shift in

<SI> Set shift in

<ESC>’x Character translation

<ESC>= Reset keystroke lockout

<ESC>. Toggle variable tabs

<VT> Toggle variable tabs

<ESC>D Set mobile home

<ESC>Y Lower case disable

<ESC>Z Lower case enable

<ESC><space>E Continuous confidence test

<ESC><space>F Printer interface test

<ESC><space>V Display firmware version

<ESC><space>C Display character set

<ESC><space>D Load contents of permanent storage 
and reconfigure

<ESC>_<x> Fill with x

<ESC>( Transmit terminal screen to host

Escape Sequence Description
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<ESC>? Toggle audible alarm

<BEL> Toggle audible alarm

<ETX> End of text processing

<EOT> End of transmission

Escape Sequence Description
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Character Sets and National Characters

Because Reflection is designed to be used as a terminal emulator, it uses the ASCII character 
set for most common characters (such as letters and numbers) and, the host character set for 
national and special characters. Microsoft Windows, on the other hand, uses the ANSI character 
set, which is a similar collection of characters. The character values in the range 32–126 are 
identical for both ASCII and ANSI. With the default host character set loaded, the differences 
occur in the upper range of values. 

Even when identical characters exist in both character sets, they are often represented by 
different numbers. When you use the a key method (explained on page 278) to enter national 
characters, and the ANSI value is different from that in the host character set, Reflection displays 
the equivalent of the ANSI character if it can be found in the host character set. If there is no 
equivalent (such as the ANSI decimal value 247), Reflection displays a blank. 

Since Reflection uses the host character set when transmitting and receiving characters, you will 
only be concerned with entering national characters when:  

· Entering special characters in a host application, explained on page 278. 

· Writing and reading ASCII disk files, explained in the online help. 

· Entering foreign characters in a file name when transferring files to a UNIX host. 

· Copying information from Reflection’s terminal window—the text is automatically 
converted from the terminal character set to the ANSI character set when placed on the 
Windows Clipboard. (When a character has no equivalent in one or the other character 
set, Windows displays a symbol such as |, +, –, or _.) 

This appendix describes how to enter national characters, then shows the character set charts 
supported by Reflection. 
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Entering National Characters
Entering national characters depends on three things: 

· The character you want to produce 

· What type of keyboard you have installed under Windows 

· Whether you are operating in 7-bit or 8-bit mode 

Some PCs have keyboards and keyboard drivers available for languages other than English. If the 
character you want to type is on your keyboard, simply press the key to produce the character. 
Reflection does nothing to alter your keyboard’s characters no matter what keyboard or language 
you have selected. 

Entering special characters from the Windows character set is explained next. 

Entering Characters Using the Alt Key Method
This section describes how to enter national characters using the a key. If you’re using either 
Reflection for UNIX and Digital or Reflection for ReGIS Graphics, see the Reflection Terminal 
Reference Manual for a description of how to enter characters using compose sequences (viewing 
and printing this manual is explained in the Reflection User Guide).

Using the a key method, you provide a decimal value from the ANSI character set to enter a 
character in the terminal window. To do this: 

1. Log in to the host. 

2. On the Setup menu, click Terminal, then click the Emulation tab.

3. Click the Advanced button. 

4. Verify that the National Replacement Set list is set to its default value of None. 

5. Click OK (twice) to close both dialog boxes. 

6. Find the ANSI decimal value for the character in the figure shown on page 283. 

7. Hold down a, type 0, then type the 3-digit decimal code on your numeric keypad. 

8. Release a. 

For example, if you hold down a and press 0, 1, 9, and 6 on the numeric keypad, an Ä 
appears when you release the a key. 



 

  Character Sets and National Characters 279
Using Reflection Basic’s Display Method
You can also enter characters in the terminal window using the Reflection Basic Display 

method. Doing so, you provide a decimal value from the host’s character set; therefore, you can 
produce characters unique to the host that do not also appear in the ANSI character set. To 
do this: 

1. Press a+L to open the Reflection command line. 

2. Find the decimal value for the character from the ASCII character set (page 282). Or, find 
the decimal value for the character from the Roman 8 character set in Reflection for HP with 
NS/VT (shown on page 286), or the current UPS Set; by default, DEC Supplemental is used 
in Reflection for UNIX and Digital and Reflection for ReGIS Graphics (page 290). 

3. Use the Reflection Basic Display method with this syntax: 

Application.Display Chr$(decimal value) 

For example, in Reflection for HP with NS/VT with the Roman 8 character set loaded, typing the 
following and pressing n displays the £ symbol in Reflection’s terminal window: 

Application.Display Chr$(187) 

If the character you want to display is in the host character set, use this syntax: 

Application.Display Chr$(187), rcNoTranslation 

Using the same example in Reflection for UNIX and Digital or Reflection for ReGIS Graphics, 
with the default DEC Supplemental graphic character set loaded, the following displays the £ 
symbol in Reflection’s terminal window: 

Application.Display Chr$(163) 

As another example, to display œ (an o e ligature character unique to DEC Supplemental) use 
the following command: 

Application.Display Chr$(247) 
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HP Terminal Character Sets
When Reflection is emulating an HP terminal, it has a base character set (Roman 8) and a 
secondary character set (HP Line Drawing). The secondary set can be used as an “alternate” 
character set. The active character set is selected from the base or the alternate set. The active set 
determines both what you see in Reflection’s terminal window when you type from the 
keyboard and the display of information received from the host. 

The Roman 8 character set is a combination of: 

· The U.S. ASCII character set (codes 0–127), shown on page 282. 

· The national characters in the Roman Extension character set (codes 161–254), shown on  
page 286. 

The Roman 8 character set becomes active when any one of the following occurs: 

· You start Reflection. 

· The cursor moves to a new line. 

· Reflection receives a SI  (shift in) control code, which was either transmitted by a host appli-
cation or sent directly from you (by pressing c+O). 

The alternate HP Line Drawing character set is loaded when: 

· Reflection receives the SO control code (or you sent it directly by pressing c+N), and 
remains in effect until either of the following occurs: 

– Reflection receives an SI  control code. 

– The cursor moves to a new line. 

– A display enhancement (underline, inverse video, and so on) is encountered. 

The figure on page 288 shows the HP line drawing characters. 
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VT Terminal Character Sets
When Reflection is emulating a VT, it has the following character sets: 

· DEC Supplemental Graphic; see page 290 

· ISO Latin-1 Supplemental Graphic; see page 291 

· National replacement sets; see the figures in the Reflection User Guide 

· DEC Special Graphic; see page 292 

· DEC Technical; see page 293 

· Code page 437 (PC English) and code page 850 (PC Multilingual) 

· Dynamically Redefinable Character Sets (DRCS) 

All of the above character sets—except the dynamically redefinable character set—are hard 
character sets; that is, those built in to Reflection. The DRCS characters are soft characters that 
can be downloaded. Downloading and mapping character sets using control sequences is 
explained in the  Reflection Terminal Reference manual (see the Reflection User Guide for more 
information on viewing and printing this manual).

The DEC Supplemental Graphic and ISO Latin-1 Supplemental Graphic character sets are 
composed of symbols and characters for the English language and many Western European 
languages. For example, the £ symbol and the Ä character are in the supplemental character sets. 

Together, the ASCII character set and the DEC Supplemental Graphic set comprise the DEC 
Multinational character set. The ASCII set and the ISO Latin-1 Supplemental Graphic character 
set comprise the ISO Latin Alphabet Number 1 character set. The two sets have only a few differ-
ences, as shown in the character charts in this appendix. 

National replacement character (NRC) sets contain most of the same characters as the ASCII set, 
plus characters from the supplemental graphic sets used by specific national languages. For 
example, the Ä character is contained in the Finnish, German, and Swedish NRC sets. NRC sets 
are used primarily in 7-bit operating environments that cannot access supplemental characters. 

The DEC Special Graphic and DEC Technical character sets contain characters, line-drawing 
elements, and mathematical symbols; see page 292 and 293 for charts of these two sets. 
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ASCII Character Set
The ASCII character set consists of characters with decimal values 0–127; this set is identical to 
the Windows character set (ANSI) codes 32–126. The characters 0–31 are control codes; they 
appear on your screen with the symbols shown on page 294 only when display functions are 
enabled (display functions are explained in the online help).
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ANSI Character Set
Reflection can send and receive ASCII characters, and characters from the supported host’s 
character set. Windows, however, uses the ANSI character set. This does not present a problem 
for the characters in the range 32–126 (since both ANSI and ASCII have the same values in this 
range), but characters above 126 must be converted to ANSI before they can be displayed by 
other Windows applications. This is explained in the steps on page 278. 

ANSI Character Set (128–255)
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IBM PC Extended Character Set
Windows applications can display only those characters from the IBM PC extended 
character set (ECS) that also appear in the ANSI character set (for example, the character 
¢). You can enter any common character, even if the ECS code is different from the ANSI 
code—Windows automatically performs the conversion for you. 

IBM PC Extended Character Set (Code Page 437)
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To enter a character in the terminal window from the IBM extended character set:

1. Log in to the host. 

2. Click Terminal on the Setup menu, and on the Emulation tab click Advanced. 

3. Verify that the National Replacement Set box is set to its default value of None. 

4. Click OK (twice) to close both dialog boxes. 

5. Find the ECS decimal value for the character in the figure shown on page 284. 

6. Hold down a and type the 3-digit decimal code on your numeric keypad (do not type 
a 0 before the code, as you would to enter a national character using the method on  
page 278). 

7. Release a. 

For example, if you are using code page 437 (United States), hold down a and press 1, 5, 
and 5 on the numeric keypad. Windows converts 155 to its ANSI equivalent 162 (as if you 
had used a+0+1+6+2), and a ¢ symbol appears. 
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Roman 8 Extension Character Set (HP Emulation)
The Roman 8 Extension character set includes special and multinational characters used in non-
U.S. ASCII national languages.

The Roman 8 Extension Character Set
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HP Line Drawing Character Set (HP Emulation)
Reflection generates all the characters in the HP line drawing character set, which is an alternate 
character set comprising simple line and graphic elements. Often, the line drawing set is used 
with format mode to create forms, tables, and other images. Each letter key generates only one 
line drawing character, whether s is used or not. Most of the numeric and punctuation keys 
can generate two line drawing characters; one when the key alone is pressed, and another when 
the key and s are pressed together. 

Press c+N to access the line drawing character set; press c+O to return to normal characters. 
Reflection reverts to the normal character set when the cursor moves to a new row. 

The following figure shows the line drawing characters used to create a sample form:

 
Sample Form Created with Line Drawing Characters

In the tables that follow, the character “cell” is a shaded rectangle in order to show each line 
drawing character’s position within the cell. 
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Line Drawing Characters
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Line Drawing Characters (continued)
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DEC Supplemental Graphic Character Set (VT Emulation)
The DEC Supplemental Graphic character set contains 94 graphic characters, including accented 
characters for many national languages. This set is the default character set loaded into the 
graphic right (GR) table when you start Reflection. 

DEC Supplemental Graphic Character Set
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ISO Latin-1 Supplemental Graphic Character Set (VT Emulation)
The ISO Latin-1 Supplemental Graphic character set contains 96 graphic characters, including 
many of the same characters as the DEC Supplemental Graphic set.* To select ISO Latin-1, click 
Terminal on the Setup menu and on the Emulation tab select this value from the Host character 
set list. 

ISO Latin-1 Supplemental Graphic Character Set

* The ISO Latin-1 character set is identical to the Windows character set (ANSI) codes 160–255. 
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DEC Special Graphic Character Set (VT Emulation)
The DEC Special Graphic character set contains 94 graphic characters, including letters, 
numbers, special symbols, and line-drawing characters. When mapped to the graphic left (GL) 
table, this set includes the CØ codes shown in the figure on page 298. 

DEC Special Graphic Character Set
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DEC Technical Character Set (VT Emulation)
The DEC Technical character set contains 94 graphic characters, including symbols and 
characters used in technical applications. When mapped to the graphic left (GL) table, it includes 
the CØ codes shown in the figure on page 298. 

DEC Technical Character Set
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Control Characters
Control characters govern cursor movement, data communications operations, and other 
terminal actions. They include CØ controls with decimal values 0–31, and C1 controls with 
decimal values 128–159. 

Normally, control characters do not display. However, if the Control characters option (on the 
Screen tab in the Display Setup dialog box) is set to Display, control characters appear as two-
letter mnemonics. 

Reflection recognizes only those codes below denoted by an asterisk (*). 

CØ Controls (Decimal Ø-32)

ASCII Decimal Keystroke Display Definition 

0 c+@ NU Null

1 c+A SH Start of header

2 c+B SX Start of text

3 c+C EX End of text

4 c+D ET End of transmission

5* c+E EQ Enquiry

6 c+F AK Acknowledge

7* c+G BL Bell

8* c+H BS Backspace

9* c+I HT Horizontal tab

10* c+J LF Linefeed

11* c+K VT Vertical tab

12* c+L FF Form feed

13* c+M CR Carriage return

14* c+N SO Shift out

15* c+O SI Shift in

16 c+P DL Data link escape
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17* c+Q D1 Device control 1 (XON)

18 c+R D2 Device control 2

19* c+S D3 Device control 3 (XOFF)

20 c+T D4 Device control 4

21 c+U NK Negative acknowledge

22 c+V SY Synchronous idle

23 c+W EB End of transmission block

24* c+X CN Cancel

25 c+Y EM End of medium

26 c+Z SB Substitute

27* c+[ EC Escape

28 c+\ FS Field separator

29 c+] GS Group separator

30 c+s+6 RS Record separator

31 c+s+_ US Unit separator

32 c+s+2 Space (blank)

C1 Controls (Decimal 128-159)

ASCII Decimal Display 7-bit Equiv Definition 

128 80 Ignored 

129 81 Ignored 

130 82 Ignored 

131 83 Ignored 

132* I N 
ESC D Index

133* 
NEL 

ESC E Next line

134 
SS Start selected area 

135 
ES End selected area 

CØ Controls (Decimal Ø-32)

ASCII Decimal Keystroke Display Definition 
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136* 
HS 

ESC H Horizontal tab set 

137 
HJ Horizontal tab set with justification

138 
VS Vertical tab set

139 
PD Partial line down

140 
PU Partial line up

141* 
RI ESC M Reverse index

142* 
S2 ESC N Single shift 2

143* 
S3 

ESC O Single shift 3

144* 
DC ESC P Device control string

145 
P1 Private use 1 

146 
P2 Private use 2 

147 
SE Ignored 

148 
CC Cancel character 

149 
MW Message waiting 

150 
SP Start protected area 

151 
EP End protected area 

152 
98 Ignored 

153 
99 Ignored 

154 
9A Ignored 

155* 
CS 

ESC [ Control sequence introducer

156* 
ST 

ESC \ String terminator

157 
OS Operating system command 

158 
PM Privacy message 

159 
AP Application program command 

C1 Controls (Decimal 128-159)

ASCII Decimal Display 7-bit Equiv Definition 
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Some functions still work when you display the control codes: 

· L
F, FF, and VT cause a carriage return and linefeed that move the cursor to a new line. 

Reflection displays the character before performing the new line function. 

·
DC1 (XON) and 

DC3 (XOFF) maintain flow control for serial connections, if pacing is 
enabled in the More Settings-Connection Setup dialog box. 

Display Control Character Set
The display control character set is a special character set used when the Control characters 
group box (on the Screen tab in the  Display Setup dialog box) is set to Display. CØ is loaded 
temporarily into the graphic left (GL) table, and C1 into graphic right (GR) to show how 
control characters appear on screen (see the Reflection Terminal Reference manual for more 
information on the in-use character set table). 

The ISO Latin-1 supplemental character set is used in GR to present displayable graphic 
characters (numbers, letters, and so on) with decimal values 160–255. 

In 8-bit environments, C1 controls can be sent directly. In a 7-bit environment, you can send an 
8-bit C1 control character by converting it to an equivalent 7-bit escape sequence. The 8-bit 
controls are single character codes (such as 

CSI ), whereas their 7-bit equivalents are two-
character sequences (such as 

ESC[ ). To form an equivalent 7-bit escape sequence from an 8-bit 
control character: 

1. Subtract the hexadecimal value 40 from the C1 control code’s value. 

2. Precede the result with the 
ESC character (^[ ). 

For example, the I ND character (decimal 132) has a hexadecimal value of 84. To convert I ND to 
a 7-bit equivalent, first subtract hexadecimal 40:  

84 hex - 40 hex = 44 hex 

Hexadecimal 44 is the letter D (as seen in the figure on page 298). Therefore, to represent the 
I ND character in a 7-bit environment, you would use 

ESCD (^[D ). 

Here’s another way to use these charts. To generate control codes 0–31, press c, then the 
character four columns to the right of the mnemonic. For example, to type the 

ESC character 
(decimal 27), press c+[ (the [ is four columns to the right of the 

ESC mnemonic). That is, add 
hex 40 to the control character to get the ASCII character to press along with the c key. 



298 Character Sets and National Characters
For control codes 128–159, press e, then press the ASCII character that’s four columns to the 
left of the mnemonic. That is, subtract hex 40 from the control character’s value to get the ASCII 
character to press with the e key. For example, the 7-bit equivalent for 

SS3 (decimal 143, hex 
8F) is e+O (the letter O is four columns left of the 

SS3, at hex 4F). 

Display Controls (Left Half) with C0 Codes
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Display Controls (Right Half) with C1 Codes
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